Oracle® Fusion Governance, Risk and Compliance
Intelligence

Implementation Guide

Release 2.0.1

Part No. E14616-01

April 2009

ORACLE



Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide, Release 2.0.1
Part No. E14616-01

Copyright © 2007, 2009, Oracle and/or its affiliates. All rights reserved.

Primary Author: Douglas J. Myers

Contributing Author:  Ashwin Sadanandan, B'far Reza, Chandramoham Subbiah, Denise Fairbanks
Simpson, Hal Kazi, Hernan Capdevila, Hugh Mason, Kim Wilmot, Louis Gonzales, Madhavi Gopaladasu,
Mohamed Hussain, Mumu Pande, Pamela Rietz, Pournima Patil, Prasanna Chimata, Sinha Siddharth,
Srinivasan Ganesan, Krishnaprasad Iyer

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks
of their respective owners.

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf
of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication,
disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the
applicable Government contract, and, to the extent applicable by the terms of the Government contract, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle
USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not
developed or intended for use in any inherently dangerous applications, including applications which may
create a risk of personal injury. If you use this software in dangerous applications, then you shall be
responsible to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of
this software. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software in dangerous applications.

This software and documentation may provide access to or information on content, products and services
from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all
warranties of any kind with respect to third party content, products and services. Oracle Corporation and its
affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third
party content, products or services.



Contents

Send Us Your Comments
Preface

1 About Oracle Fusion Governance, Risk and Compliance Intelligence

Product OVeIVIEW.........oi et e s e s me e snee e 1-1
ADBout This GUIdE........c.ooiiiiiiiie e e 1-3
Supported LANGUAGES. .........coouiiiiiiiiiii e e e 1-3
Oracle Help for the Web.............ccocooiiiiiiii e 1-3
Prerequisites...........cccociiiiiiiiiii 1-4
Recommendation........ ..o s 1-5

2 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for
GRCM 7.8

OVEIVIEW ... s b e sr e s b e sr e s nae e 2-1
Installing Oracle GRCM SCIipts..........cccoiiiiiiiiiiiii e 2-1
Setting Up the Environment...................oooiiiiii e 2-2
Creating the Target Physical Model................cccociiiiiiiiiii 2-18
Loading Target Tables............cccooiiiiiiii e s 2-18
Installing OBIEE RePOItS.........cccccooiiiiiiiiiiiiiii s 2-20
Multi-Language Setup for OBIEE................c..cccocoiiiiiiiiiccc e 2-21
Installing BI Publisher Reports...............cccociiiiiiiiiii 2-23
Security Integration with GRCM (Optional)............cccoooiiiiiiiiiiii e 2-27



3 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for
AACG 8.2

OVEIVIEW. ... s b e sr e s b e sr e s nae e 3-1
Installing Oracle AACG SCIPtS.......ccccoiiiiiiiiiiii i 3-1
Installing ODI Code............cccooiiiiiii e 3-3
Installing OBIEE RePOTILS..........ccccooiiiiiiiiiiiiiii i s 3-16
Security Integration with AACG (Optional)............cccoooiiiiiiiiiii e, 3-17

4 Installation and Upgrade Options for Oracle Fusion Governance, Risk and
Compliance Intelligence 2.0.1

(@ RT3 2 (= 28T 4-1

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for both GRCM 7.8
AN AACG 8.2, ittt h e e bt e e e b et e e e e h b et e e e e b et e e e e e ba e e e e e anreeeeeaan 4-1

Upgrading GRCI 1.0 t0 GRCI 2.0.T.........oooiiiiiiii s 4-2

A ETL Execution

Execution Sequence..............ccccooiiiiiiiiiiiii A-1
) I 1 I 5 Yot U (o) s T A-2
Execute @ PaCKage..........cocoiiiiiiiii e e A-3

B Architecture

Data FIOW DIagrami..........oooooiiiiiiii e B-1
Detailed Data Flow Diagram................cccoiiiiiiiiiiiiii e B-3

C Logical and Physical Models

GRCI - AACG 8.2 Logical Model..........cccooiiiiiiiiiii e e C-1
GRCI- AACG 8.2 Physical Model..............cccooiiiiiiiiii e C-4
GRCI - GRCM 7.8 Logical Model............cccooiiiiiiiiee e s C-18
GRCI - GRCM 7.8 Physical Model..............ccocooiiiiiiiiic e C-22

D Lineage for GRCM 7.8

Lineage Information for Tables and Scripts.............cccccoiiiiiiiiiiiiiii e, D-1
GRCI 2.0.1 - GRCM 7.8 Data Lineage CONSTANTS Table............ccocooiiiiiiiiiiiiiice D-1
GRCI 2.0.1 - GRCM 7.8 Data Lineage DIMENSIONS Table..............ccccocoiiiiniiiiiiiiinn, D-6
GRCI 2.0.1 - GRCM 7.8 Data Lineage FACTS Table...............cccoooiiiiiiiiii e D-12

E Lineage for AACG 8.2
GRCI 2.0.1 - AACG 8.2, Data Lineage DIMENSIONS Table..............cccoooiiiiiiiiiiiiice, E-1



GRCI 2.0.1 - AACG 8.2, Data Lineage FACTS Table...........c..ccccoooiiiiiiiiiiiccceeee e,

F Uploading dif files to the Database using Transx
Uploading dIf files to the Database using transX...............cccccoooiiiiiiiiiiiiiiii

Index






Send Us Your Comments

Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide, Release 2.0.1
Part No. E14616-01

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document.
Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

¢ Are the implementation steps correct and complete?

¢ Did you understand the context of the procedures?

¢ Did you find any errors in the information?

¢ Does the structure of the information help you with your tasks?

* Do you need different information or graphics? If so, where, and in what format?
* Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the
name of the company who has licensed our products, the title and part number of the documentation and
the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the
document and if any concerns are already addressed. To do this, access the new Applications Release
Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most
current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle
Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office
and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at
www.oracle.com.

vii






Preface

Intended Audience

Welcome to Release 2.0.1 of the Oracle Fusion Governance, Risk and Compliance Intelligence
Implementation Guide.

Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide
for Release 2.0.1 is intended for information technology personnel and privileged users
responsible for installing and configuring the GRC Intelligence application. It assumes
the reader is familiar with Oracle Content Server installation, configuration, and use.

See Related Information Sources on page x for more Oracle Applications product
information.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at

http://www .fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is
available at http://www.fcc.gov/cgb/dro/trsphonebk.html.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and
Oracle is actively engaged with other market-leading technology vendors to address
technical obstacles so that our documentation can be accessible to all of our customers.



For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

Structure

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

1 About Oracle Fusion Governance, Risk and Compliance Intelligence
2 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for GRCM 7.8
3 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for AACG 8.2

4 Installation and Upgrade Options for Oracle Fusion Governance, Risk and Compliance
Intelligence 2.0.1

A ETL Execution

B Architecture

C Logical and Physical Models

D Lineage for GRCM 7.8

E Lineage for AACG 8.2

F Uploading dif files to the Database using Transx

Related Information Sources

Oracle Fusion Governance, Risk and Compliance Intelligence User’s Guide for Release
2.0.1

This guide provides information on how to use the Governance, Risk and Compliance
Intelligence application with Oracle Content Server.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data unless
otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your



data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an
Oracle Applications form can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your tables
get out of synchronization with each other, you risk retrieving erroneous information
and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps track
of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.

Xi
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About Oracle Fusion Governance, Risk and
Compliance Intelligence

Product Overview

Oracle Fusion Governance, Risk and Compliance Intelligence (GRCI), Release 2.0.1, is
an intelligence reporting application that extracts data from Oracle Governance, Risk
and Compliance Manager (GRCM), Release 7.8 and Oracle Application Access Control
Governor (AACG) 8.2.

The Oracle Fusion Governance, Risk and Compliance Intelligence solution is designed
to enhance your visibility into the organization's compliance readiness and
responsiveness by providing certification, controls, issues, risks, and testing diagnostics
and out-of-the-box management reports. By using Oracle Fusion Governance, Risk and
Compliance Intelligence, you can drill from high-level to detailed information to
effectively plan, model, report, and analyze GRC activities. You can identify potential
issues early and take informed and timely corrective actions.

GRCI Sourced from AACG

¢ GRCI Analytics Integration Overview The source of GRCI Release 2.0.1 data store
is AACG (Application Access Control Governor) 8.2 and information such as
policies, entitlements, exclusions, conflicts etc., are loaded into GRCI staging tables
hosted in the GRCI (data store) schema. This data load is accomplished in a '‘push'’
fashion as opposed to the traditional 'extract' method and it is called Analytics
Integration. Two enhancements were made to the AACG application to integrate
with GRCI:

1. A new tab called 'Analytics Integration' which is available through the Application
Configuration screen. This captures the setup information related to the integration.

2. Conflict run in AACG 8.2 is enriched with 'AACG data services' to load data into
GRCI staging tables.
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The other source of GRCI is GRCM 7.8 and information such as Processes, Controls,
Risks, Issues etc., from GRCM 7.8 are loaded into GRCI data store tables for
analysis using SQL.

¢ Analytics Integration Schemas The analytics integration component of AACG
application uses two schemas to create necessary data for analysis by GRCI
application. One schema (referred to as ag_access) stores AACG specific data in
tables prefixed with LAA_ and TMP_ and another schema (referred to as gri)
contains the staging tables used by GRCI ETL process. This gri schema contains all
database objects used by the GRCI application.

e Staging Tables Load The gri schema contains the staging tables (prefixed with
GRI_S), which act as an interface between AACG and GRCI applications. These
tables are populated when the user executes the Conflict Run process in AACG
application.

Note: Check the AACG documentation for details on how to
configure the application to connect to GRCI staging schema and
load data into these staging tables.

The staging (GRI_S_) tables are loaded during every execution of Conflict Run and
data is updated in the staging tables in an update-else-insert fashion. Here are two
examples:

1. If the entitlement description or entitlement status changes in AACG, the AACG
data services component will pick up the changes during the next Conflict Run, and
update the staging tables GRI_S_ENTITLEMENT and GRI_S_ENTITLEMENT_TL
with the new values.

2. If the status of a Conflict Path changes from Approved to Rejected in AACG, the
AACG data services component will pick up the changes during the next Conflict
Run and update the staging table GRI_S_CONFLICT_PATH.

¢ GRCI Star Schema Tables Load Data in the GRCI staging schema is refreshed
during every execution of Conflict Run in AACG. So as a best practice it is
recommended that GRCI administrator execute the ODI based ETL packages
immediately after every successful execution of Conflict Run (for ex: Run-1) in
AACG. This would refresh the content of GRCI star schema tables and users can
visualize the latest values in OBIEE based dashboards and reports. If the ETL
packages are not executed before the next Conflict Run (for ex: Run-2) in AACG, the
data in GRCI staging tables will be overwritten before the previous Run's (Run-1)
changes being propagated to GRCI star schema tables.

GRCI Sourced from GRCM GRCM 7.8 is one of the sources of GRCI 2.0.1, and
information such as Processes, Controls, Significant Accounts, Risks and Issues are
extracted from GRCM and loaded into the GRCI data store. The creation of the GRCI
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Star Schema, Extraction, Transformation and Load of GRCM data into the GRCI star
schema is accomplished using PL/SQL scripts. For further details on implementing
GRCM based GRCI, please refer to Chapter 2.

About This Guide

This document explains how to install the Oracle Fusion Governance, Risk and
Compliance Intelligence application on a Oracle 10g server. The information contained
in this document is subject to change as the product technology evolves and as
hardware, operating systems, and third-party software are created and modified. This
document is intended for information technology personnel and authorized users
responsible for installing and configuring the Oracle Fusion Governance, Risk and
Compliance Intelligence, Release 2.0.1 application.

Supported Languages

Oracle Fusion Governance, Risk and Compliance Intelligence, Release 2.0.1 is available
in English only for AACG 8.2.

About Language Resource Files

GRCM 7.8 supports the following 10 languages aligned with the Oracle Identity
Management (OIM) product line:

¢ Chinese Traditional
e Chinese Standard

® Spanish

e French

e Japanese

e Portuguese

e Korean

e German

e [talian

e Danish

Oracle Help for the Web

This sections identifies the steps to follow to install the help files into the OBIEE file
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directory.
Installing Oracle GRC Intelligence Help

Prerequisites: In the Oracle Business Intelligence Enterprise Edition (OBIEE) installed
files location: {OracleBI}\ oc4j_bi\j2ee\home\applications\analytics\ analytics\, you
must have a folder named 'Missing_'. If the Missing_ folder does not exist in the
location, create this folder.

OHW Installation Steps: In the GRCI install files, take the GRCI_help.zip file.

1. In the Missing_ folder in the location
{OracleBI}\ oc4j_bi\j2ee\home\ applications\ analytics\ analytics\, create a folder
named GRCL

2. Unzip the GRCI_help.zip file to the newly created GRCI folder.

To view the Help icon at the Dashboard level: Copy the existing help.gif from this
location:

® (C:\OracleBI\oc4j_bi\j2ee\home)\ applications\ analytics\ analytics\res\s_oracle10
\views

Copy and paste the help.gif file to the following two locations:

e C:\OracleBI\ oc4j_bi\j2ee\home\applications\ analytics\ analytics\res\s_oracle10
\images folder

® (C:\OracleBI\web\app\res\s_oracle1l0\images

Prerequisites

Before you use Oracle Fusion Governance, Risk and Compliance Intelligence, Release
2.0.1, you must:

* Install Oracle Database 10gR2 with patch 10.2.0.4

¢ Install Oracle Business Intelligence Enterprise Edition 10.1.3.3.3

Install either one or both of the following applications:
® Oracle Governance, Risk and Compliance Manager, Release 7.8

¢ Install Oracle Application Access Control Governor 8.2

If you have installed Oracle Application Access Control Governor 8.2, then:
e Install Oracle Data Integrator 10.1.3.3.0

¢ AACG Interface tables (tables with name starting as GRI_S_...) should be deployed
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in the same schema as the tables for data warehouse ('GRI' Schema).

In the OBIEE server, copy the existing help.gif from the following location:
* C:\OracleBI\oc4j_bi\j2ee\home\applications\ analytics\ analytics\res\s_oracle10

\views

Then copy the file from the proceeding location to the following location:

OracleBI\ oc4j_bi\j2ee\home\ applications\ analytics\ analytics\res\s_oracle10\im
ages folder.

Recommendation

It is recommended that the AACG installation and the data warehouse database that
has 'GRI' schema (AACG DB and GRCI DB) be in the same network.
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2

Installing Oracle Fusion Governance, Risk
and Compliance Intelligence for GRCM 7.8

Overview

This chapter covers the installation procedures for GRCI 2.0.1 when the source
application is solely GRCM 7.8. However, if there is an existing GRCI 1.0 installation,
which needs to be upgraded to GRCI 2.0.1, please refer to Chapter 4, and follow the
upgrade instructions.

Installing Oracle Scripts contains the following subsections:

1. Setting Up the Environment
2. Creating the Target Physical Model

3. Loading Target Tables

Installing Oracle GRCM Scripts

The GRI_20_GRCM_ETL.zip contains the scripts for the creation of the GRCI 2.0.1
datastore based on GRCM 7.8. When the scripts are executed as per the steps mentioned
in this section, the GRCI star schema is created and loaded with the data from the
source. With this release GRCI datastore can only be hosted on Oracle, but GRCM
residing on SQLServer or Oracle database platforms can be used as the source.

The extracted zip file contains the following files:

* Model/Constants_Create_pkg.sql
* Model/Dims_Create_pkg.sql

* Model/Facts_Create_pkg.sql
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* Model/Stage_Create_pkg.sql

e Model/Execute_Create.sql

* Model/Execute_Index_View.sql

e ETL/Constants_Load_pkg.sql

e ETL/Dims_Load_pkg.sql

e ETL/Facts_Load_pkg.sql

e ETL/Execute_Load.sql

e GRCD_TIME_TRANSLATION_zh_tw.dlf
e  GRCD_TIME_TRANSLATION_zh.dIf

e  GRCD_TIME_TRANSLATION_pt_br.dlf
e GRCD_TIME_TRANSLATION_ko.dIf

e GRCD_TIME_TRANSLATION_ja.dlf

e  GRCD_TIME_TRANSLATION_it.dIf

e  GRCD_TIME_TRANSLATION_fr.dlf

e GRCD_TIME_TRANSLATION_es.dlf

e GRCD_TIME_TRANSLATION_de.dlf

e GRCD_TIME_TRANSLATION_da.dlf

Important: If you are installing GRC Intelligence Release 2.0.1 for GRC
Manager and AACG, then AACG Scripts Installation should be
completed first, followed by the GRC Manager Scripts Installation.

Setting Up the Environment

1. Identify the source application database details - host name, port number, user
name, and password.

2. Connect to source database depending upon the type of source: If the source is
ORACLE: Connect to target oracle database using any oracle db connectivity client
(e.g. SQL Developer). Create a database link - GRCM771_APPS_DBLINK pointing
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to source database as follows. Replace the contents in <> brackets with the
information in Step1 for creating the db link.

3. CREATE DATABASE LINK GRCM771_APPS_DBLINK CONNECT TO "<user
name>" IDENTIFIED BY "<password>" USING
DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST= <host
name> or IP Address>)(PORT=<port name>)))(CONNECT_DATA
(SERVICE_NAME=<service name>)))

Verity if the database link is working by querying a source table. Refer below for an
example.
SELECT COUNT (*) FROM GRC_FISCAL_PERIODS@ GRCM771_APPS_DBLINK;

If the source is SQL server: For connecting to the SQL server, the Oracle Database
Gateways 11g Release 1 (11.1.0.6.0), should be installed in the oracle home directory of
the database. All versions of gateway before this have been de-supported by Oracle and
cannot be used.

For the Oracle database, a patch should be applied to upgrade it to 10.2.0.4, as the older
versions of Oracle do not support the Unicode data transfer.

Follow this procedure to install the gateways in a windows Oracle database:

* Run the setup.exe from the install files.

# Oracle Universal Installer: Welcoms

ORACLE 442

DATABASE
Welcome

The Oracle Universal Instaser guides you thwough the installation and configuraton of your
COracle products

Chck “installed Products . * bo see all instalied products

Deinstall Praducls |

Ao Qracls Uniersat imstaller. |

Help | instailed Braducts... |

i

= Cancal

® Select the Oracle Database Gateways 11.1.0.6.0.
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che Universal Installer; Select a Product to Install

S 10

* Select the Oracle Home directory, for the Database on which the Gateway is to be
installed.
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Oracke Uiniversal Installer: 5pecify Home Details

Srnce 418

DATABASE

Doracleproduct 0.2.0b_1

e Select the Oracle Database gateway for Microsoft SQL Server 11.1.0.6.0.
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“# Dracle Universal Installer: Available Product Components r-n-_ | ﬁl

ORACLE’ 1 g
DATABASE

Available Product Components
Oracle Database Gateways

The following are componenis thal vou can install s par of Oracle Dalabase Gateways Vihich of these
components do you want {o install?

Components It Stz |
B8 Oracle Dstabase Gabayways 11 1080 Pt iryestal | I
[ Cracde Databecs Gateway for informz 11.1.060 ot Irstailand |
O Cracke Database Galeway lor Sybase 11,1 060 Mrﬂﬂ
[ Orace Database Gatesvay for Teradsta 111060 It iretatiedd
[ Oracts Datshase Gatewsy for APPC 11 4060 Pl Iretsil=d
N B O Oracie Databeee Gatewny for DROA 111 060 Tot Installed
_,rn'..-.f '_:l:. d il :_:_.._. it 114 n Rl i Mm | Re!
Expand All ) Collapsa Al ) Beloci Al _jl ReselectAll |
™ Show all campanents, including required uné ependencies.
Healp _j' Installad Products . J i Back I [ed J [rigtat! Cangel |

¢ Enter the SQL server connection details as required.
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@ (racle Universal Installer: Oracle Database Gateway for Microsoft 500 Server

ORACLE’
DATABASE

ft SQL Server

& (1014845242 i
BalesDernol

e (Click Next.

® (lick Install and the Gateway will start installation.
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@ Oracle Univerzal Installer: Summary

-- &
SRt ff

Summary
Oracle Database Gateways 11.1.0.6.0

S-Global Settings

| Source: DASMAthySomaarewin3z_11gR1_gateways\gatewaysistagerpraducts xmi
—orache Home: Dioraclelproduchd 0,2 Didb_1 (OraDb1 0g_homel)
~Installabon Type: Custom

CHProduct Languages
—English

| C-Space Requinements

| = Reguired 2TME Oncludes I6ME temporanyd | Available 881 GE

|1 —D\ Reguired SEGME - Available 2 93G8

B lreacy nstalled (55 productsh

N 1 '. : e
Help | . Imetalied Products... j"ﬂi Back |_ me | [ jnetan } cancel |

Tip: This may take a few minutes.
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w Oracle Universal Installer: Install

ORACLE 1 1g

DATABASE

Install

Installing Ovache Dalabase Gateways 11.1.06.0

¥ Inatallation in progress
et Ideal Platform for

Setup pending, . Grid Computing

Condiguration pendng. ..

Low cost sarvars

and slorage
Extracting fles 1o 'Clproducti 1.1 0tg_6'.
. ' 200 Highest availability

Bast scalability

“ou can find the log of fhis instal session et
cﬁwmmﬁmnmwmmmum_tw-m

Help | Inetalled Prodiets 15tk [ Et [netzl| Crennel

Once the installation is complete the Oracle Net Configuration Assistant pops up
for setting up the Listener for the Gateway.

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for GRCM 7.8 2-9



i Univaisdl lnstallaf: Conlmuialion Aisislails

(racle Het Configuration Assistant; Welcome
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Oracle Het Confipuration Assistant: Listener Configuration, Select Protocols

You can configure the listener to accept connections aver one or
maore protocols. Selectwhich prolocols you want 10 configure for this
listener, Keep your configuration as simple as possible by
configuring only the protocols you need.

Available Protocols Selected Profocols

TCPE I TCP =

P = g

LTI - I :_E I

® Assign the Listener an appropriate name.

(Oracle Met Configuration Assistant: Listener Configuration, Listener Name

Forremaote conneclions to ke made 1o yvour Oracle
database you must have atleast one Oracle Net
listenar. Entar the name of fhe listaner you want to
create;

Listener name: |LISTENERS@L_FCO)|

% Back Meet 3
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Oracle Met Confipuration Assistant: Listener Confipuration, TCP/IP Protocol

Y¥hich TCPAP por number should the listener use? The port
number selected should not be used by any other software on
this computar.

® |ge the standard port number of 1521

" Use another port number: f1521

Cancel | Help |

Oracle Net Configuration Assistant: Listener Configuration, More Listeners?

Wiould you like to configure another listener?

® g

" Yes

Cancel | Help |
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Oracle Net Configuration Assistant: Listener Configuration Done

Listener configuration completa!

Cancel | Help | 4 Back

®  Once the Listener configuration is complete, keep clicking the "Next" button until
the configuration is successfully completed.
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Oracle Met Configuration Assistant: Maming Methods Configuration

When connecting to a database or other senvice, you specify a
cannect identifier, such as a net sevice name. The connect
Identifiar is resoklved into & connect descriplor by one or more
naming methods. By default, the local naming method (nsnames.
ora file} is configured for enabling the semver to connect back to
itself.

Ifyvou need this server to connect to other semvers, oryvou want to
use this Cracle Home as & client, then you might need to
configure additional naming methods.

Do you want to configure additional naming methods?
® Mo, | do not want fo configure additional n&ming methods.

" *as, | dowantio configure additional naming methods,

Oracle Met Configuration Complete,

Cancel ) Help )
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® Oracle Universal Installer: End of Installation
DATABASE

End of Installation

®  Once the Gateway has been successfully installed, you can find the folder for the
Database Gateway in the Oracle home directory.
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The initdg4msql.ora file is also present in dgdmsql\admin. The initdg4msgql.ora file
contains the connection details that you defined earlier:

B initdgdmsglora - Motepad

Fle Edt Fomab Wew Help

Ld
# HE init parameters
W+

HE_FDE_TRACE_LEVEL=OFF
HE_FDE_RECOVERY _ACCOUNT =RECOVER
HE_FDE_RECOVERY_PwWD=RECOVER

HE_FOE_COMMECT _INFO=10. 148 45 242/ /53l esbemo

# This 1z a customized agent ipdt Tile that contains the HS parameters
# That are needed Tor The Database Gateway for microsoft sqL server

Modify the Oracle Home \NETWORK\ ADMIN listener.ora as shown below for the
Listener added. Restart the Listener.
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B listener.ora Malepad

Fle Edt Format  View Help

| Py |

SID_LIST_LISTEMERSQL_FCD =
(SID_LIST =
(SIC_DESC =
SID_MAME=dodmsgl) :
CRAZLE_HOME=D 1 MoracTehproducts 10, 2. 0hdb 1]
PROGRAM=dgdmag 1)

]

LISTENERSM _FCD =
(DESCRIPTION_LIST =
{DESCAIFTION =
CADGRESS_LIST =
(ADDRESS = [PROTOCOL = TCRI(HOST = Tocalhost) (PORT = 15183)

Modify the tnsnames.ora in Oracle Home\NETWORK\ ADMIN to add the
dg4msq]l details.

P tnsnames.ora - Motepad '._|rﬁ|[§|

Fie Edt Format View Help

(COMNECT_DATA = A
{SERVER = DEDICATED)
CEERVICE_PIAME = BIOTVOT)

J
b
ExXTPROC_CONMECT IOMN_DATA =
(DESCRIPTION =

CLDDRESS_LIST =
(ADDRESS = (PROTOCOL = IPCI{KEY = EXTPROCL))

J

(CONNECT_DATA =
(210 = PLEExXTRroc)
{PRESENTATION = RO)

dgdmsgl =
(DESCRIFTION =
CADDRESS = (PROTOCOL = TCPI(HOST = localhost}(PORT = 1518))
CCONMECT_DATA =(SID = dgdmsql))
. (HE = OK)

Create database link in the oracle database:
Create database link <Database link name>
Connect to <"Login"> identified by <"Password">

Using 'dg4msql'
Database Link name to be used (for running the scripts): GRCM771_APPS_DBLINK

Connect to the SQL database using this database link to load the data.

Using SQL Developer to view the data in SQL server directly from Oracle will result in
errors if the source table contains nvarchar type columns. You can validate the link by
using SQL plus to connect using the database link to the SQL server. Once the data is
loaded in the tables, you can view it using SQL developer.
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Creating the Target Physical Model

Open and compile each of the following package files in the Oracle Client:

Note: Since some of the scripts contain Unicode characters, they might
show errors when opened in Oracle clients like SQL developer. To
avoid this, open the scripts in textpad or notepad, then copy and paste
the scripts into the Oracle client to compile them.

¢ Constants_Create_pkg.sql
e Dims_Create_pkg.sql
® Facts_Create_pkg.sql
* Stage_Create_Pkg.sql

This step will create all the physical tables in the target schema. The caller has the
option of forcing the table to be dropped and created based on value set for
v_ForceCreate variable.

Execute_Create.sql

Note: If you are upgrading from an older version of GRCI, please force
create the GRCD_USERS table by setting the value of v_ForceCreate to
"1" while running the Execute_Create.sql (CreateUsers procedure). If
the tables already exist (with the structure of Rel 2), DO NOT set
v_ForceCreate to "1" i.e. force create the table again as it will lose the
existing data. Recreating the GRCD_TIME_D and GRCD_TIME _TL is
not required if these tables are also present in the database. If you are
recreating them, please make sure that the same values of the start and
end year are given.

Run the following script to create the indexes and views in the target schema.

Execute_Index_View.sql

Loading Target Tables

Before loading staging, dimension and facts, the translation data for the table
GRCD_TIME_TRANSLATION must be loaded.

The process for loading the dIf files using transx utility is detailed in this document as:
Appendix F - Uploading dlif files to the Database using transx.

Use the method described above to load all of the files that are a listed below:
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e GRCD_TIME_TRANSLATION_zh_tw.dlf
e GRCD_TIME_TRANSLATION_zh.dlf

e  GRCD_TIME_TRANSLATION_pt_br.dlf
e GRCD_TIME_TRANSLATION_ko.dIf

e  GRCD_TIME_TRANSLATION_ja.dlf

e GRCD_TIME_TRANSLATION_it.dlf

e GRCD_TIME_TRANSLATION_fr.dlf

e GRCD_TIME_TRANSLATION_es.dlf

e GRCD_TIME_TRANSLATION_de.dlf

e GRCD_TIME_TRANSLATION_da.dlf

Open and compile each of the following package files in the Oracle Client.

* Constants_Load_pkg.sql
e Dims_Load_pkg.sql
* Facts_Load_pkg.sql

Note: If the GRC Manager web application is not installed on your
machine, you will need to set the v_GRCApplication variable (found in
Constants_Load_pkg) to reference the correct machine/ip address that
is hosting the GRC Manager application.

Note: If the OBIEE installation is not installed on this machine you will
need to set the v_OBIEEApplication variable (found in
Constants_Load_pkg) to reference the correct machine/ip address that
is hosting the OBIEE application.

Note: Before compiling Dims_Load_pkg.sql, you need to reset
comment to: reset_sequence(GRCD_USERS_S) if GRC Manager alone is
installed.

Run the following script. This step loads all of the tables in target schema.

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for GRCM 7.8 2-19



Note: While running the scripts, to insert data into the stage area, the
variable v_SourceName is to be given as per the source type
(SQLSERVER/ORACLE). If it is an SQL Sever source it should be given
as "SQLSERVER" and for Oracle it should be given as "ORACLE".

Execute_Load.sql

You can repeat this step for several consecutive loads.

Installing OBIEE Reports

The GRI_20_OBIEE.zip contains two zip files:

GRCDiagnostic.zip

GRCDWebcat.zip

These files contain the repository and web-catalog, and are used in the steps below to
install the repository and reports-dashboards respectively.

1.

10.

After you successfully install OBIEE (OBIEE version 10.1.3.3.3), extract the
delivered zip file GRCDiagnostic.zip. Place the GRCDiagnostic.rpd file in the
C:\OracleBI\ server\ Repository folder.

In the C:\OracleBI\server\ Config folder, edit the NQSConfig.INI file. Enter the
name of the RPD file after "Star =" in the [ REPOSITORY ] section.

Place the GRCDWebcat.zip file in the C:\ OracleBIData\ web\ catalog folder and
unzip the file. The GRCDWebcat folder now appears in the Catalog folder.

In the C:\OracleBIData\web\ config folder, edit the instanceconfig.xml file. Enter
the path of the GRCDWebcat folder in between the <CatalogPath> tags.

Create the TNS entry to point to your GRCI schema in Oracle home directory.

Open the GRCDiagnostic.rpd in the Oracle BI Administration Tool and go to the
Variable Manager under the Manage > Variables menu.

Update the GRI_DSN variable with the name of the TNS entry name.
Update the GRI_USER_ID with the database user ID.

Open the properties window for 'GRC Diagnostics > GRCI Connection Pool' in the
Physical layer and provide the password for GRCI schema.

Save the changes in the Oracle BI Administration Tool.
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11. Restart the Oracle BI Services.

12. Log into the OBIEE using this URL: http://<localhost>:<TCPport>/analytics, where
<localhost> is the name of the machine or the IP address where OBIEE is installed,
and <TCPport> is the Web Site TCP Port number.

13. The OBIEE login page loads.

14. The installation is now complete.

Multi-Language Setup for OBIEE

The source language files required to support multiple languages in OBIEE are located
in the GRI_20_GRCM_OBIEE_LANG.zip file.

They are present in the captions.zip file.
Currently there are 10 supported languages:
1. Danish (da)

2. German (de)

3. Spanish (es)

4. French (fr)

5. Italian (it)

6. Japanese (ja)

7. Korean (ko)

8. Portuguese Brazilian (pt-br)

9. Chinese Standard (zh)

10. Chinese Traditional (zh_tw)

Follow the procedure mentioned below to include the language files in the OBIEE

server. This procedure must be followed after installing OBIEE and before starting the
OBIEE server.

Note: If the "res" folder is not already present then create this folder in
the "web" folder.

1. Loading the webcat language resource files
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Unzip the captions.zip file present in the GRCI_20_GRCM_OBIEE.zip file into "
OracleBIData\web\". Check if the folder structure matches the figure, as illustrated
below:

o aeleBiCista
) g
L) cacke

S )

3 s ol el
¥ ) scheduler
L) kg
= 0 vl

& ) catalog

I oonfig
) Bl

1) kewy
) e
Ce]

|_de

) Captiens

Executing the GRCDDiagnostic.sql

Run the GRCDiagnostic.sql file in the Oracle Client. This script will create the table
GRCDiagnostic in the database.

Loading the GRCDiagnostic table with translations available in dIf files

The process for loading the dlf files using transx utility is detailed in this document
as:Appendix F - Uploading dlf files to Database using transx.

Please refer to Appendix F for directions on how to upload the dlf files that are a listed
below:

GRCM_GRCDiagnostic_da.dlf
GRCM_GRCDiagnostic_de.dlf
GRCM_GRCDiagnostic_es.dlf
GRCM_GRCDiagnostic_fr.dIf
GRCM_GRCDiagnostic_it.dlf
GRCM_GRCDiagnostic_ja.dlf
GRCM_GRCDiagnostic_ko.dlf
GRCM_GRCDiagnostic_pt_br.dlf
GRCM_GRCDiagnostic_zh.dlf

GRCM_GRCDiagnostic_zh_tw.dIf
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After the connection is established using the connection pool, use the Language drop
down list to select the required language before logging into the OBIEE Presentation

Service.
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This will display the application in the selected language.

Installing Bl Publisher Reports
BI Publisher Installation

Install Oracle BI Publisher (10.1.3.3.3). Use the Basic installation option that provides
OC4J, Sun JDK, with BI Publisher. Refer the 'Oracle Business Intelligence Publisher
Installation Guide' for environment requirements and other details.

Data Source Configuration

Connect to BI Publisher server. Go to 'Admin > JDBC' tab. Click 'Add Data Source' link.
The following window appears.
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) Oracle BI Publisher - Microsoft Internet Explorer

| Fie Edit Wiew Favorites Tools Help
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ORACLE Bl Publisher Enterprise

Welcome,
administrator Prefe

Reports | Schedules

Admin > JOBC > Add Data Source

Add Data Source

General

* Data Source Name |

* Conrection String ‘:_I
= =
" Lksrname

|
Password |
|

* Datsbage Driver Class
(Enarrgle; oracle jdbe.deiver O acleliriver )
™ U= Prosy Authentication

Test Connection
|&] pone [ [ % wocalintranet

| EX

Enter the following information as given below. Use the appropriate connection
information for the content in the <> brackets.

Data Source Name: GRCD

Connection String

Reporting DB Platform Connection String

Oracle jdbc:oracle:thin:@<host name>:<port
num>:<service name>

Driver Name

Reporting DB Platform Driver Name

Oracle oracle.jdbc.driver.OracleDriver

Click the 'Test Connection' button to establish a successful connection. Then click the
'Apply’ button to save the data source connection information.
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Report Configuration

e Stop the BIP Service.

e Extract the delivered zip file GRCI_20_GRCM_BIP.zip.

¢ Extract the BIP_Reports_base.zip and BIP_Reports_lang.zip into the same "Reports
folder. Copy the folders under "Reports" folder to the report metadata to the
directory <Oracle BI Publisher Home>\ xmlp\ XMLP\Reports\.
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e Restart the service.

¢ Connect to BI Publisher Server. Go to 'Reports' tab and check if the following report
folders are available as shown in the next illustrated window.

* Assessment Reports

* Audit & Process Test Reports

¢ Certification Reports
e Control Reports

* Issue Reports

e Risk Maps

* Risk Reports
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Security Integration with GRCM (Optional)

This section provides details on integrating the security component of two applications:
GRCM and GRCI to satisfy the following requirements:

1.  All GRCM users are available in GRCI, without the need to recreate them.

2. Ability to launch a GRCI dashboard from GRCM application without having to
sign-on.

3. Ability to launch a GRCI answer from GRCM application without having to
sign-on.

The ideal solution to satisfy the above requirements would be to integrate GRCM and
GRCI using the combination of LDAP (Light weight directory access protocol) and SSO
(Single sign-on) servers. This solution provides a quick fix to integrate the security
component of the two applications using the 'External Table Authentication' feature of
OBIEE (Oracle Business Intelligence Enterprise Edition) and it can be used in
implementation sites, which do not have LDAP and SSO.

1. Create and load table to store GRCI users.

The procedure to load the table GRCD_Users is executed as part of the GRCD data load
and it reads data from the GRCM tables Users and UserSecurity Attributes. After the
load is complete, all the GRCM users and roles are available in the table GRCD_Users,
which then acts as an identity store for GRCI. As rows (which represent users and roles)
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are created in the table a proxy password of Password' is used.

e All users are assigned a default password of Password', which is stored in
clear-text form in the table GRCD_Users. During implementation, OBIEE
administrator can change the password as desired but it can be stored only in
clear-text form and all users must have the same password.

e Since the table GRCD_Users also stores user information related to AACG users, it
contains users from both GRCM and AACG, identified by the SRC_SYS_ID column.

The procedures CreateUsers and LoadUsers load data into table GRCD_USERS if
GRCM and GRCI are implemented in Oracle environment.

2. Modify the GRC repository data file(e.g. ".rpd file") to create Initialization block
and session variables.

This section begins with modifications to the configuration file and proceeds to create
the initialization block script and session variables in the repository (rpd) file. OBIEE
uses this script to set the session variables when user launches the GRCI
answer/dashboard from GRCM.

1. Shutdown Oracle BI Server and Oracle BI Presentation Server services.

2. Launch Oracle BI Administration tool. Open the rpd file (indicated in
NQSConfig.ini ->[Repository] section -> Star entry) in offline mode.

3. From the Manage menu, click on Variables to launch the Variable Manager.

4. From the menu click on Action, Select New and choose Session->Initialization Block
to create an initialization block. Name the block as GRCD Security.

5. In the Data Source section, click on Edit Data Source. From the Data Source Type
drop-down box choose Database. In the 'Default Initialization String' window type
the following SQL.:

SELECT USERNAME, GROUPNAME, DISPLAYNAME, LOGLEVEL
FROM GRCD_Users
WHERE USERNAME="USER'
AND PASSWORD="PASSWORD'
6. The Connection Pool should display 'not assigned'. Click on Browse to launch the

Select Connection Pool window. Click on the appropriate Connection Pool and click
Select, then click OK.

7. In the Variable Target section, click on Edit Data Target. Click New to launch the

Session Variable window. In the name box enter USER. Click OK. Accept the
'special purpose’ prompt by clicking on Yes.
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10.

Similarly add variables GROUP, DISPLAYNAME, LOGLEVEL, assigning the
GRCD Security as initialization block to all of them. Add a default initialization
value of 2 for LOGLEVEL variable.

Enable the 'Required for Authentication' check box.

Save the initialization block GRCD Security.

3. Create repository groups corresponding to GRCM roles and secure presentation
layer catalogues.

The GRCM roles are loaded by the sql script into the GRCD_Users table
(GROUPNAME column). Use these roles to create repository groups in the rpd files and
associate only the presentation catalogues that need to be accessed by these roles. So,

when you connect to the dashboard, only the presentation catalogues that are attached

to the user's role are available as 'Subject Areas' for creating answers.

Note: The GRCM role SOAExternalAudit and the presentation catalog
GRC Diagnostics Detail are used as examples in the next section.

Open the GRCM rpd in OBIEE Administration tool and logon with admin
privileges.

Click on Manage->Security from the menu.

On the Security Manager window, select Groups in the left pane and click on
Action->New->Group.

From the GROUPNAME column of the GRCD_Users table, select a group (for
example, SOAExternal Audit) and enter that as name of the group. Click OK. The
group is created in the repository.

To secure a catalog in presentation layer by the group, right click on the catalog
(GRC Diagnostics Detail), click Properties and click on Permissions tab.

In the Permissions window, make sure that 'Show all users/groups' check box is
selected. Locate the group that was added in Step 3 and below the Read' column
click on the check box until it becomes a tick mark, granting access to the
(SOAExternal Audit) group.

Right click on another catalog (GRC Diagnostics Overview), click Properties and
click Permissions tab.

In the Permissions window, make sure that 'Show all users/groups' check box is
selected. Locate the group that was added in Step 3 and below the Read' column
click on the check box until it becomes a red x mark, preventing access to the
(SOAExternal Audit) group.
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Upon completion of steps 6 and 8, the group SOAExternal Audit has access to GRC
Diagnostics Detail subject area but not to GRC Diagnostics Overview subject area.
(The names of groups and presentation catalogues/subject areas are used as
examples here).

10. Click OK. Save the rpd.

4. Create presentation catalog group and secure dashboards, folders and answers

The GRCM roles are loaded by the sql script into the GRCD_Users table
(GROUPNAME column). Use these roles to create presentation catalog groups and
associate dashboards to each group. So, when the user launches a GRCI
report/dashboard from GRCM, only the dashboards associated with the user's role will
be displayed. No other dashboards can be accessed by the user.

1.

Connect to OBIEE Presentation server and log on as Administrator.

Click on Settings->Administration and select 'Manage Presentation Catalog Groups
and Users' and click on 'Create new catalog group'.

Enter the group name from GRCD_Users. GROUPNAME column, in the Group
Name, Dashboard Name and Dashboard Builder columns of the Create Catalog
Group screen. (For instance, use SOAExternal Audit).

OBIEE creates a folder under 'Shared Folders' and an empty dashboard with the
name specified in Step 3.

Repeat Step 3 until dashboards and presentation service groups are created for all
GRCM roles.

Click Finished and return to Oracle BI Presentation Services Administration screen.
Click on 'Manage Interactive Dashboards' to verify the list of all the dashboards.
Click Finished. Similarly click on 'Manage Presentation Catalog' to verify that the
new presentation service groups appear as folders below Shared Folders. Click
Finished. Click Close Window.

In the 'Answers' screen create desired reports (or move the existing reports) and
store them below the folders created in Step 3.

Edit the dashboards created in Step 5 and add desired reports created in Step 6 to
the dashboard sections.

To prevent/grant access to other dashboards, click on Settings->Administration and
select 'Manage Interactive Dashboards'. The Manage Dashboards screen launches
with a list of dashboards. Choose the dashboard that needs to be secured from the
role (SOAExternal Audit). Click on the Permissions icon in that dashboard and
remove the public role 'Authenticated Users' from the list of users and groups that
have explicit access to this item. Repeat this step for all dashboards that need to be
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10.

11.

12,

secured from the catalog group (SOAExternal Audit). Similarly to grant access to a
dashboard (for the GRCM role), choose the dashboard, click on Permissions icon in
that dashboard and add the presentation service group to the list of users and
groups that have explicit access to this item. At the end of this particular step the
list of dashboards that can/cannot be accessed by the presentation service group is
fixed.

To secure Folders and Answers, click on Settings->Administration and select
'Manage Presentation catalog'. The Manage Catalog screen launches with folders.
Switch to Shared Folders. To secure a folder, click on the Permissions icon of the
folder. Remove 'Everyone' from the list of users and groups that have explicit access
to this item. Add only the presentation service group that should have access to the
list of users and groups that have explicit access to this item. Click Finished when
necessary folders have been secured. Similarly to secure a particular answer, click
on the folder name that contains the answer. To secure an answer, click on
Permissions icon of the answer. Remove 'Everyone' from the list of users and
groups that have explicit access to this item. Add only the presentation service
group that should have access to the list of users and groups that have explicit
access to this item. Click Finished when necessary answers have been secured.

Logoff and restart OBIEE services.

Log on as a GRCM user (associated with SOAExternal Audit role for instance) into
GRCD. Only the dashboards that are accessible to the presentation services group
associated with the GRCM user should be displayed and the user shouldn't have
access to any other dashboard. Click on Answers. Only the folders and answers that
are accessible to the presentation services group associated with the GRCM user
should be displayed and the user shouldn't have access to any other folder or
answer.

5. Modify menu.aspx file to launch GRCD from GRCM menu

This section describes the modifications to be made to menu.aspx, which can be located
in the \ Inetpub\wwwroot\ OracleGRCManager\ Nav directory. These modifications
enable the OBIEE based GRCI dashboard to be launched within the GRCM (FCD)
application.

Add the following functions to the JavaScript section of the menu.aspx file:
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function CBIEE redirect{)

{

parent.frames["main'].location.href="<(=mConfig.Constant ("ADVEEPORTINGEASEURL") %
>/8aw.dll?DashboardeNQIV]1=24523452345235cNQ0VE=24523452345235sNUser=<¥=n5tate.Loginlds
:-&NgPasswcr\d:Passtr\d" 5

aelf._status = "";

b

function click()

{

if (event.button = 2){

return false;

i

I

and just before the end of the JavaScript block add these two lines of code:

document.onmousedown = click;
document ..oncontextmenu = new Function("return false®™);

Locate the section:

<tr id="mnuAdvEeporting™ runat="server">

<td class="t-vspacer”></td>

<td class="VNLevel2"><img arc="../images/bullec.gif" alt="bullet™/>inbap;
<a href="<%=mConfig.Constant ("ADVEEPCRTINGBASEURL")%>/saw.dll?Dashboard

</td>
<td class="t-vapacer”></td>
</Lr>

and modify the section as:

<tr id="mnubkdvReporting™ runat="server">

<td clasa="t-vapacer" >/ td>

<td class="VNLevel2"><img src="../images/bullet.gif" alt="bullet"/>&nbsp;
<A href="javascript:0BIEE redirect({);"/>

<ftd>
<td class="t-wvspacer"></td>
</tr>

As seen above, the function of OBIEE_redirect() contains a proxy password of
'Password’, the same as referred to in 'Create and load table to store GRCD users'
section of this document. If you change the password in GRCD_Users table, it should
also be modified in the function OBIEE_redirect().

Save the menu.aspx file.

6. Modify the GRCI views to include a JavaScript call to GRCM pages so that drill
from GRCI to GRCM happens seamlessly

The drill across from GRCI to GRCM (drill back to source) is available out of the box
and this section helps by making that experience seamless.
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Note: This section is only applicable in situations where the GRCI
dashboard is launched from GRCM. If the GRCI dashboard will only be
launched external to GRCM (for instance, by launching the GRCI
dashboard URL directly) this modification to the procedures is NOT
required.

GRCI dashboards like Certifications have links to GRCM which provide insight on the
source data. For instance, the answer 'Open Assessments by Due Date' which is
available in the Certifications dashboard contains a column called Process Title which
acts as a link to the process information in GRCM. When this column is clicked, the
process page in GRCM is launched with details of the process, within the same frame
(without the need to switch to another GRCM window), thus providing better user
experience. When the browser's back button is clicked the context switches back to the
GRCI dashboard. This section describes the steps involved in updating a URL column
in a GRCI view with a JavaScript call, which provides this functionality.

Note: The steps below explain how to add the JavaScript call to the
view GRCD_PROCESS_V only and it uses the document type
SOA_BPC. Repeat the steps for the views GRCD_ASSESSMENT_V,
GRCD_CONTROL_V, GRCD_ISSUE_V, GRCD_CONTROL_TEST_V
and GRCD_RISK_V using the appropriate document type.

e Edit the view GRCD_PROCESS_V in query editor or open the file that contains the
procedure in a query editor.

e If the environment is MSSQLServer, locate the column:

"<a href=""+b.URL+' /Hav/Redirect.aspx?doctype=50A BPCsid="+a.dDocName+'™>"+a.Title+"</a>" URL, |

and modify it to:

‘<a href="javascript:window.top.location="""+b.URL+'/Nav/Redirect.aspx?
doctype=50A BPCiid="+a.dDoclame+'"";">"+a.Title+"</a>' URL,

e [f the environment is Oracle, locate the column:

*<a href="'+b.URL+'/Nav/Redirect.aspx?doctype=50A_BPCsid="+a.dDocName+'™>"+a.Title+'</a>" URL, \

and modify it to:

'¢a href="javascript:window.top.location="'"||b.URL||"/Nav/Redirect.aspx?
doctype=50A BPCsid="||a.dDocName||""';">"|la.Titlel | "</a>" TURL,

and remember to use SET DEFINE OFF to suppress the substitution variable, if you are
using an editor like SQL*Plus.
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1. Drop and recreate the view. Save the file.

7. Launch GRCM, switch to GRCI, drill back to GRCM

1. Login to GRCM application and locate the Dashboard link beneath Advanced
Reporting menu item in the left pane and click on it to launch the GRCI dashboard
in the right side frame.

2. The GRCI dashboard will launch with an empty home page, list of dashboards the
role(s) associated with the user id can access ( this was setup in previous sections)
will be available in the top of the frame.

3. Click on a dashboard which has links to GRCM (for instance, Certifications) and
click on a report column which appears as a hyperlink (for instance, the column

Process Title in answer Open Assessments by Due Date) to drill to details of that
column in GRCM. Click the browser back button to switch back to GRCIL.
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3

Installing Oracle Fusion Governance, Risk
and Compliance Intelligence for AACG 8.2

Overview

This chapter describes the steps necessary to install, configure and populate a GRCI
2.0.1 datastore sourced from AACG 8.2. The following section lists some scripts that
need to be executed to create setup tables and load configuration data into the GRCI
2.0.1 datastore. The subsequent sections cover the installation of ODI projects, OBIEE
reports, and an optional OAM based security integration.

Installing Oracle AACG Scripts

This section lists some scripts that need to be executed in order to create setup tables
and load configuration data. The subsequent sections cover installation of ODI projects,
OBIEE reports, and an optional OAM based security integration.

Steps to run the scripts for creation of the target and config tables. If you are installing
GRC Intelligence Release 2.0.1 for GRC Manager and AACG, then AACG Scripts
Installation should be completed first, followed by the GRC Manager Scripts
Installation.

Execute the scripts provided in the following order:

Note: Since some of the scripts contain Unicode characters, they might
show errors when opened in oracle clients like SQL developer. To
avoid this, open the scripts in textpad or notepad, then copy and paste
the scripts into Oracle client to compile them.

1. CreateTable.sql:

Drops and recreates the target tables, along with the sequences and index.
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2. CreateConfigTables.sql:

Drops and recreates the configuration tables.

3. CreateViews.sql:

Creates the views for the tables.

4. Load the seed/localization data:

The process for loading the dlf files using transx utility is detailed in the Appendix
F: Uploading dlf files to the Database using Transx.

Use the above method to load all of the files that are a listed below:
e GRI_A_LOOKUP_TL_us.dIf

e GRI_A_NA_NF_TL_us.dlf

e GRCD_TIME_TRANSLATION_zh_tw.dlf
e GRCD_TIME_TRANSLATION_zh.dlf

e  GRCD_TIME_TRANSLATION_pt_br.dlf
e GRCD_TIME_TRANSLATION_ko.dIf

e GRCD_TIME_TRANSLATION_ja.dlf

e GRCD_TIME_TRANSLATION_it.dlf

e GRCD_TIME_TRANSLATION_fr.dlf

e GRCD_TIME_TRANSLATION_es.dlf

e GRCD_TIME_TRANSLATION_de.dlf

e GRCD_TIME_TRANSLATION_da.dlf

5. InsertData.sql:

Inserts (-1/-2) rows into dimension tables and also loads the seed data into the
config tables (GRI_A_LOOKUP, GRI_A_LOOKUP_TL, GRI_A_DW_CONFIG_TBL
and GRI_A_SRC_SYSTEM_INFO)

Note: When GRCI-AACG security integration implementation is
required, update AACG host and port information in
SOURCE_URL column of GRI_A_SRC_SYSTEM_INFO table. Use
SET DEFINE OFF to suppress substitution value.
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6. InsertTIME.sql:

This sql file creates the TIME_Load_pkg package containing the procedures
Load_GRCD_TIME_D and LOAD_GRCD_TIME_TL, used to load the Time
dimension tables namely GRCD_TIME_D and GRCD_TIME_TL.

7.  ExecuteTIME.sql:

Execute the CreateTIME and InsertTime package to insert data into the
GRCD_TIME_D and GRCD_TIME_TL tables.

Installing ODI Code

The following steps describe the process used by ODI to extract the data from the
staging tables populated by AACG data services, and then transforming and loading
the data into GRCI datastore.

1. Create a Master Repository and Work Repository.

2. Create a Physical Connection:

Step 1: Login to the Topology Manager, switch to the Physical Architecture tab:
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- [ Sunapsis Engine
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Step 2: Expand "Oracle" Physical Technologies and Insert a "New Data Server".
Specify the details of the database where "GRI" schema is hosted. (In the JDBC tab
provide the necessary information). Specify the login whose privileges will be used
by the ETL processes.
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Step 3: Once the data server information is saved, specify the "Insert Physical
Schema" in the newly created data server, as shown (specify the "GRI" schema
where GRI_% tables are stored as the physical schema in both Schema and Work
Schema).
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Step 4: Once you have saved the Physical Schema information, you will receive a
Popup message asking for the "Context" for the physical schema, as shown.

Information

o

3. Create a Context:

In "Topology Manager", switch to the Context tab, and insert the new context (right
click and insert context), as shown.
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Create a Logical Schema:

In Topology Manager, switch to the "Logical Architecture” tab, under "Oracle
Technologies" select "Insert Logical Schema", specify the name as "GRI" and choose
the appropriate physical schema (created in Step 1) for the Context created (created
in Step 2), as shown.
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5. Import Model:

Login to Designer, right click on the Models tab. Select Import Model and import
the .xml file supplied, as shown.
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Import Model... (XML File)

Import Type

[ Synonym Mode INSERT -
File irpoart directory

b:l [3
Zelect the file(s) 1o impart

=Rl

[ (], ] [ Cancel ]

6. Import Project (without child components):

Import the Project file provided with the "INSERT" mode. The project file does not
import any child components into the project.

(XML File) X
Import Type
[ SynomymMade NSERT w]

File irmport directory

proDi_Expart [:]

Select the fil=(s) to import

[ Ol ] [ Cancel ]

7. Import Project Variables:
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Import the variables into the project with the "INSERT" option.

Import ¥ariable... (XML File)

Impart Type

[ Synonym Mode INSERT v
File itmport directory

b:'l.ODI_Expu:urt'lExpu:ur‘t to ARUNGRI_20_ODNGRI_20_Cormmon [:]

[ (], ] [ Cancel ]

8. Import User Functions:

Import User Functions in the "INSERT" mode.

Import User Function... (XML File)

Irmgart Type
[ éynnnym hode INZERT

>
File irmport directory
Pri0DI_Export L)

Zelect the file(=) 1o impoaort

J4TE_DFLT_FUMC
ATE_FUNC

9. Importing Folders:
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Import the Folders provided (SOD Mart and Global Dimensions) without the child

component using "INSERT" mode.

Import Folder... (XML File) X
Iimport Type
[ Synormym Maode INSERT v
File irnport directory
b:'I.ODI Export DechCommon [3

Zelect the file(=) to import
Global Dirmenzions with child

Global Dirmenzions without child

SO0 Mart withiout child

[ Ok ] [ Cancel ]

10. Import Knowledge Modules:

Right click the imported SOD Mart folder, and select "Import Procedure".

Projects S R x|
G W
= A5 GRI
E "T_Q Cpen in Mew Window
- B
F-F Exdit I =& Few Window ..
-4 View
| Insert
Duplicate
Delete
rport Package ...
Expor. . Import Sub Folder .

Export All Scenarios..,

Prirt

Werslon [ 3
Generste All Scenarios.,,

|l Insert Folder

Frport Procadurs....
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Import Procedure... (XML File)

Imgort Type

| Synodiym Made INSERT -]
File import directory

|p-o0i_Esport @

Select the fila(z) to impart

o) Comea)

Import the "IKM Oracle Merge Dimension Incremental Load" and "IKM Oracle Fact
Incremental Load" supplied, as shown above.
11. Import Folders (with child components):

Import the folder (Global Dimensions) with child components with the "
INSERT_UPDATE" option.

Import Folder... (XML File) X
Irpart Type
[ Synonym Mode INSERT_LPDATE v
File irnport directory
b:'I.CIDI Export DechZommon [3

Select the file(s) to import

Clokal Ditnensions without child
=00 Mart without child

[ Ok ] [ Cancel ]
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12. Once the folder Global Dimensions has been imported, import the sub-folders for
the SOD Mart folder (Dimensions and Facts) without their child components from
the SOD Mart folder that is provided.

}:npurt Sub Folder... (XML File)

Irripoet Type

[__synonym Mode INSERT .
File mmport directory

[ \00! Export Dec\SOD Mart @

Select the file(s) to import
Drirreari out chad

Facts without child

13. Import Interfaces for the sub-folder Dimensions:

Import Interface... (XML File)

[Fripport Type

[ Synorym Mode INSERT - |
File irmpart directary

bDI Export DeciS0D MartDimensions Interfaces and Packages [:]

fremr——  ———

14. Import Packages for the sub-folder Dimensions:
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- Import Package. .. (XML File) %]

Impart Type

[ Synonym Mode INSERT (v
File itmport directory

IZ)DI Export DectS00 Mart'Dimensions Interfaces and Packages [:]

Zelect the file(s) to import

LARI_L_MULE_Fhis

[ (], ] [ Cancel ]

15. Import Interfaces for the sub-folder Facts:

Import Type
[ Synomym Mode INSERT

File irmport directory
b:'LDDI Export Deci=0D MartFacts Packages and Interfaces

Select the file(=) to import

) W

[ Ok ] [ Cancel ]

16. Import Packages for the sub-folder Facts:

3-14 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



Import Package... (XML File) (%]

lmport Type
[ Synomym Mode INSERT - |
File irmpart directory

b:'I.ODI Export Deci=0D MartFacts Packages and Interfaces [:]
Zelect the file(s) 1o impart

OMFLICT_PATH_T_PHG
MFLICT_PATH_T |

17. Importing the Master Package:

Import Package... (XML File)

Import Type
[ Synonym Made INSERT
Filg import directory

)
PAor Export DeciS0D Mart [:]

Zelect the file(s) 1o impart

[ (], ] [ Cancel ]

Execute any interface/package to test that the import has worked properly.
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Installing OBIEE Reports

The GRI_20_OBIEE.zip contains two zip files:

GRCDiagnostic.zip

GRCDWebcat.zip

These files contain the repository and web-catalog and are used in the following steps
to install the repository and the reports-dashboards respectively.

1.

10.

11.

12,

13.

14.

After you successfully install OBIEE (OBIEE version 10.1.3.3.3), extract the
delivered zip file GRCDiagnostic.zip. Place the GRCDiagnostic.rpd file in the
C:\OracleBI\ server\Repository folder.

In the C:\OracleBI\server\ Config folder, edit the NQSConfig.INI file. Enter the
name of the RPD file after "Star =" in the [REPOSITORY] section.

Place the GRCDWebcat.zip file in the C:\OracleBIData\ web\ catalog folder and
unzip the file. The GRCDWebcat folder now appears in the Catalog folder.

In the C:\OracleBIData\ web\ config folder, edit the instanceconfig.xml file. Enter
the path of the GRCDWebcat folder in between the <CatalogPath> tags.

Create the TNS entry to point to your GRCI schema in Oracle home directory.

Open the GRCDiagnostic.rpd in the Oracle BI Administration Tool and go to the
Variable Manager under the Manage > Variables menu.

Update the GRI_DSN variable with the name of the TNS entry name.
Update the GRI_USER_ID with the database user ID.

Open the properties window for 'GRC Diagnostics > GRCI Connection Pool' in the
Physical layer and provide the password for GRCI schema.

Save the changes in the Oracle BI Administration Tool.

Restart the Oracle BI Services.

Log into the OBIEE using this URL: http://<localhost>:<TCPport>/analytics, where
<localhost> is the name of the machine or the IP address where OBIEE is installed,
and <TCPport> is the Web Site TCP Port number.

The OBIEE login page loads.

The installation is now complete.
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Security Integration with AACG (Optional)

This section describes the security integration between GRCI 2.0.1 and AACG 8.2.

This section describes how a user logs into GRCI, and can drill-across to AACG to see
more details without having to sign on.

Prerequisites

Installation of AACG version 8.2 and GRCI Release 2.0.1 is required.

Installed Software

¢ OBIEE (Oracle Business Intelligence Enterprise Edition) version 10.1.3.3.3 (with
OC4))

® Oracle HTTP Server (Apache 2.0)

* Web server and directory server. (Used here are SUN ONE Web server 6.1 and
iplanet directory server 5.1)

*  OAM (Oracle Access Manager)10.1.4.0.1
e  WebGate (OAM Web component) 10.1.4.0.1

For installing and setting up software, please refer to the installation and user guides.
Web server and directory server must be installed prior to OAM installation, as it is a
prerequisite for OAM installation. OAM is installed on some servers, and OBIEE, OHS
(Oracle HTTP Server) and WebGate are installed on the client side.

Steps for Integration
Step 1. Configuring the Access System, Policy and Users in OAM

At least one Access Server must be installed and configured. A policy and AccessGate
should be created for the resource you want to protect. At least one WebGate must be
installed on the client side, and configured to communicate with the Access Server
AccessGate function, and performance can also be configured to respond to their
unique needs.

* In the access system configuration, set up the access server, host identifier, and the
access gate.

* Login into Oracle Access Manager. Go to Access System Configuration -> Access
Server Configuration -> Add In the access server, provide a name, host, port of the
machine where OAM is installed, and the search parameters.

* Login into Oracle Access Manager. Go to Access System Configuration, on the side

navigation pane, click Host Identifiers -> Add ->Specify a name, description and all
possible identifiers for this host. As a host can be known by multiple names, the
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Host Identifiers feature is used to enter the official name for the host, and every
other name by which the host can be addressed by users.

Create Access Gate. On the Access System Configuration page select Add New
AccessGate. Provide a name, host, and port of the machine where OBIEE for GRCI
is installed and other search parameters.

* Login into Oracle Access Manager. Go to Policy Manager -> Create Policy Domain
-> Create a policy for the URL of the resource.

For each policy you create, you can assign a specific authentication scheme (Basic
Over LDAP), an authentication rule, an authorization expression, and an auditing
rule.

* Login into Oracle Access Manager. Go to Identity System Console -> User Manager
Tab -> Create User Identity tab, and create a new user.

When the credentials are asked for to login into GRCI, a username and password
should be entered. This will allow the user to drill down to AACG without having
to log on.

* Below are the steps that describe the flow of the OAM component:

a) User attempts to access web resource (http) on OHS which is protected by Oracle
Access Manager, a request is received by WebGate

b) WebGate requests the policy from the Access Server to see if the resource (URL)
is protected or not

c) If the resource/URL is not protected, the user is returned to the previous page. If
resource/URL is protected, WebGate will ask the user to authenticate

d) Credentials entered by the user, and are validated against the LDAP directory
via the access system

e) After successful authentication, a Oracle Access Manager Single Sign-On cookie
is sent to the user's browser

Note: Refer to Oracle® Access Manager Access Administration Guide
(10.1.4.2.0) for more details.

Step 2. Configuring mod_oc4j for Accessing an Application deployed in OC4J

¢ The directive Oc4jMount is used to make an Application deployed to OC4]J
accessible through OHS via mod_oc4j. This directive can be included in the file
mod_oc4j.conf.

Update mod_oc4j.conf located in C:\OraHome\ ohs\ conf directory
Add the following lines:
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# OHS and ocdj configuration
ocdjmount Sanalytics/* ajpl3://localhost:9704

4 mod_oc4j.conf - Notepad (=JoJgs
File Edt Format  Wiew Hedp

L st f o & o e
# oracle 1As mod_oc4] configuration file: mod_oc4q.conf
Ff A A S A Y S A R A AR A SRR R SR R R R A e S

Loadmodule onsint_module modules/mod_onsint.so
LoadModule oc4j_module modules/mod_ocd4]j.so

# oHsS and ocd4] configuration

ocdjmount Janalytics/* ajpl3://localhost:9704
ocdmount Sxmlpserver/* ajpl3://localhost:5704

<IfModule mod_oc4j.cx

</Ifmodul >

Restart the OPMN process by running ons.exe from C:\OraHome_3\ opmn\bin.

Communication between OHS and OC4] uses Apache JServ protocol AJP13

Update protocol="ajp13" in
C:\OracleBI\ oc4j_bi\j2ee\home\ config\ default-web-site.xml

vl gl vt vien Wi Fwrvenr e org 4 S0 S XML SChama- instapon®
! mETInTEthp S smalns acacls comf orackeas S schm s fweb- site:
poct ™04 doplay - name = 0CAY 10q { 1 1_3) Delault Wels Site”

terTsyRLEm” fa
pehcaten="system” r

Croote” fubesocdl s
a'ilmal” fonls"f dims’

wet-app appliicston ="defoult’ neme =" jmarouter_web® bad-on-starfup="trua®

roats® { jmsrouter” o
ohr apg apphcaton =" Javossa’ e = favasso: wob® rocts"ffaso®
iy =" ascontrol” nesss"asconirel” lnad-an-atartup="trua” roat="fam® ohe
Le" fanndytics”
fhinMioe®

aacoass-log pathe", flogfdalault-web-access.log” spbt="day” / »

Step 3. OBIEE - LDAP Authentication

Create a new LDAP Server entry in the repository (rpd) for iplanet Directory where
OAM users get stored using the following procedure.

a) To Modify the Repository for User Authentication in iplanet Directory

Open the rpd in the BI Administration Tool and select Manage > Security from the
application menu.

From the Security Manager menu, choose Action > New > LDAP Server.
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® In the General tab, enter values for fields as shown in the following example:
Hostname = < iplanet Directory hostname>
Port number = < iplanet Directory port>
LDAP version = LDAP 3
Base DN = < Base distinguished name (DN)>
Bind DN = < Distinguished name required to bind to iplanet Directory >
Bind password = < Password of bind DN>
where the Base DN field identifies the starting point of the authentication search.

If the Bind DN and Bind password entries are blank, anonymous binding is
assumed.
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£ g Securiy Mamne | Description

i Users & 0iM_LDAP

€7 Groups

[% LDAP Servers mrwore—— —

0 Custom Authenticators LDAP Server - OAM_LDAP @
-if Hierarchy

General | Advanced ]

Name: |DAM_LDAP

Hast name: ]infra.vm.oracle.com

i LDAF wersion
Port number: |1 389 i o3
Baze DM: 1dc=\rm,dc=oracle,dc=com
Bind DM: |cn=D irectony Manager

Bind pazsword: ]

Canfirn password: I

Descriptior: Test connection

LOAP Server entry for D&M |

oK | Cancel Help

"OANM_LDAP" TNk

Return to the General tab and click on the Test Connection button to ensure the
connection to iplanet Directory server is successful.

b) Configuring the Initialization Block Used for User Authentication

One initialization block is required for user authentication and to configure it to use
LDAP authentication. It will set the value of USER system session variable.

Create new init block

In the Session Variable Initialization Block window, click on the "Edit Data Source"
button. Select LDAP as the Data Source Type from the drop-down and select the
LDAP Server that was created in above step.

Select the Edit Data Target button. In the System Session Variable window, enter
"USER" in the Name field. Click OK. Click OK when asked to confirm if you want
to use this name.

Test the authentication by clicking on the Test button in the Session Variable
Initialization Block window.
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¢) Configuring the Initialization Block Used to set the GROUP for the User

Note: OBIEE will be not able to recognize nor use any LDAP defined
user-to-group relationships until 11g (or later).

Users are typically assigned to groups via an OBIEE repository session init block using
an external source (E.g. a database table) that contains the user-to-group association.
This init block sets the GROUP session variable.

e Shutdown Oracle BI Server and Oracle BI Presentation Server services
® Launch Oracle BI Administration tool. Open the rpd file in offline mode
* From the Manage menu, click on Variables to launch the Variable Manager

e  From the menu click on Action, Select New and choose Session->Initialization Block
to create an initialization block

® In the Data Source section, click on Edit Data Source. From the Data Source Type
drop-down box and choose Database. In the 'Default Initialization String' window
type the following SQL:

SELECT ROLE_NAME

FROM GRCD_USERS A, GRI_D_ROLE_USER_BG B, GRI_D_ROLE_TL C
WHERE A.USERNAME="USER' AND

A.SRC_SYS_ID="AGS8(

AND A.GRCD_USER_SID = B.GRCD_USER_SID

AND A.SRC_SYS_ID =B.SRC_SYS_ID

AND B.ROLE_SID = C.ROLE_SID

AND B.SRC_SYS_ID = C.SRC_SYS_ID

AND C.LANGUAGE ="'VALUEOF(NQ_SESSION.LANGUAGE_CODE)'

e The Connection Click on Browse to launch the Select Connection Pool window.
Click on the appropriate Connection Pool and click Select, then click OK.

¢ In the Variable Target section, click on Edit Data Target. Click New to launch the
Session Variable window. In the name box enter GROUP. Click OK. Accept the
'special purpose’ prompt by clicking on Yes.

* Enable the Required for Authentication' check box.

e Save the initialization block.

d) Creation of Repository Group and Presentation Catalog Group
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Create a repository group and a presentation catalog group (the same as group that was
assigned in the prior step). For example, if the GROUP has a variable set to Apps
Administrator, then the user creates a repository group, and a presentation catalog
group as "Apps Administrator". This step is needed in order to see the group in the rpd
and the webcat to further secure presentation layer catalogs, dashboards, folders and
answers. A dynamic assignment is done in the prior steps only.

Note: Creation of a group should be done by logging in as an
Administrator to rpd and webcat. This should be done on a different
machine that does not have OAM integration on it. With OAM
integration only, OAM users can log into presentation services even if
they don't have Administrator user privileges.

* Creation of Repository Group

Open the GRCM rpd in the OBIEE Administration tool and logon with admin
privileges

Click on Manage->Security from the menu

On the Security Manager window, select Groups in the left pane and click on
Action->New->Group. Enter a group name that gets assigned to the GROUP session
variable in the prior step.

¢ Creation of a Presentation Catalog Group

Connect to OBIEE Presentation server and log on as Administrator

Click on Settings->Administration, select 'Manage Presentation Catalog Groups and
Users', and click on 'Create new catalog group'

Enter the group name that gets assigned to the GROUP session variable in the prior
step, Dashboard Name and Dashboard Builder columns of the Create Catalog
Group screen

Note: Check Oracle® Business Intelligence Enterprise Edition User
Guide for securing presentation layer catalogs, dashboards, folders and
answers.

Step 4. Configuring BI Presentation Services to Use the Impersonator User
The steps to configure BI Presentation Services are:
a) Creating the Oracle BI Server Impersonator User

¢ Open the BI Server repository file (.rpd) using BI Administration Tool.
¢ Select Manage > Security to display the Security Manager.

¢ Select Action > New > User to open the User dialog box.
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Enter a name and password for this user.

For example, Name = Impersonator and Password = secret.

e (lick OK to create the user.

Make this user a member of the group Administrators.
e Double-click on the icon for the user that was created.

® In the Group Membership portion of the dialog box, check the Administrators
group.

b) Creating Adding Impersonator User Credentials to Oracle BI Presentation Services
Credential Store

1. Open a command prompt window or command shell on the machine where BI
Presentation Services has been installed.

2. Navigate to the directory OracleBI/web/bin.

3. Execute the CryptoTools utility to add the impersonator user credentials to the BI
Presentation Services Credential Store:

cryptotools credstore -add -infile OracleBIData/web/config/credentialstore.xml

4. Supply values for the prompted parameters, as shown:

C:\OracleBI\web\bin>cryptotools credstore -add -infile C:/OracleBIData/web/config/credentialstore.xml
>Credential Alias: impersonation

>Credential "impersonation™ already exists. Do you want to overwrite it? yv/n (v) : v

>Username: Impersonator

>Password: password

>Do you want to encrypt the password? v/n (y): ¥

>Passphrase for encryption:passwordl23

>Do you want to write the passphrase to the xml? y/n (n): n

»File "C:/OracleBIData/web/config/credentialstore.xml™ exists. Do you want to overwrite it? yv/m (y): ¥

¢) Configuring Oracle BI Presentation Services to Identify Credential Store and
Decryption Passphrase

Step 1. Locate the node within the instanceconfig.xml file.
Step 2. Specify the attribute values as shown in the following example.

If the node does not exist, create this element with sub-elements and attributes with
attribute values given in the following example.

3-24 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



<WebConfig>

<ServerInstancel

<!— pther sectings ... —>

<CredentialStore>

<CredentialStorage type="file"™ path="<path to credentiaslstore.mml>" passphrase="<passphrase>"/>
«!'— pther settings ... —>

</CredentialStore>

<!— pther sectings ... —>

</JerverInstance:

</WebConfig>

After modification, CredentialStore node in instanceconfig.xml file looks as below:

<?xml version="1.0"2>
<WebConfig>
<ServerInstance>

«!— pther settings ... —>
<CredentialStore>
<CredentialStorage type="file™ path="C:/OracleBIData/web/config/ credentialstore.xml™ passphrase="passwordl23"/>
«!— pther settings ... —>
</CredentialStore>

<!=- ogther settings ... =-->
</ServerInstance>
</WebConfig>

d) Configuring BI Presentation Services to Operate in the OAM Environment

1. Open instanceconfig.xml for editing. Locate the <Auth>element. If this does not
exist, create this element, sub-elements and parameters as shown in the following
example:

<!— other settings ... —>

<huth>

<550 enabled="true">

<Paramlist>

<!—— IMPERSONATE param is used to get the authenticated user's username and is
regquired

—

<Param name="IMFERSONATE™ source="httpHeader™ nameInSource="550 UID"™ />
</Paramlist>

</5350>

<fButh>

2. Secure the machines that are permitted to communicate with BI Presentation
Services directly.

This can be done by setting the Listener\ Firewall node in instanceconfig.xml with
the list of HTTP Server or servlet container IP addresses. For example:
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<Listener>

<Firewall>

<Allow address="127.0.0.1"/>
<hllow address="10.111.111.111"/>
</Firewall>

#!—— other settings ... —>
</Listener>

Step 5. Drilldown to source system from OBIEE

e GRI_S SRC_SYSTEM_INFO table is used to store the source instance URL and
component path. SOURCE_URL column stores URL and policy, confilctpath id
store component path for policy and conflict path respectively. Refer to AACG
documentation for populating data for these three columns.

® Create an Initialization Block and Dynamic Repository Variable, which are used to
create the URL for the source system. For every drill to page, a separate Init Block
creation is required.

1. In OBIEE Admin tool open the rpd. Go to Manage->Variables-
>Action->New->Repository Initialization Block.

2. In the Repository Variable Init Block window put init block name.

3. Click on edit data source write a query to get URL and component from
GRI_A_SRC_SYSTEM_INFO table. For conflictpathld drill down the query would
look like the following:

SELECT SOURCE_URL || CONFLICT_COMPONENT
FROM GRI_A_SRC_SYSTEM_INFO
WHERE SRC_SYS_ID = 'AGEQ'

-

¢ Assign a connection pool for this init block. Test the authentication by clicking on
the Test button in the Repository Variable Initialization Block window.

® Select Edit Data Target button. Select New in Repository Variable Init Block
Variable Window. Create a Dynamic Repository variable. Similarly, an Init block
for policy Id should be created.

Similarly, Init block for policyID should be created.

* Create a logical column in the business layer of the OBIEE admin tool and select the
check box for Use existing logical columns as source. Specify the expression from
which the logical column should be derived. Replace the :1 with the dynamic field
value, for multiple parameters use nested REPLACE functions. For example, the
expression for logical column for conflictpathld drill would look like the following:
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Logical Column - Conflict Path ID Link =%

Getieral ] Data Type | o0 ] Levels1

Mame: |Eonflict Path 1D Lirk]

Belongs to Table 1"I3FHI: Diagnostice'""Fact - Conflict Path"

Sort arder colure

!Nl:une Gl Cle ‘

v Llze esizting logical calumng as the source

¢a href=" || REPLACE( ]
WALLEOF"AACG_COMFLICTRATH_FG', 1", RTRIM[ CAST

["GRC Diagnostics'’' 'Fact - Conflict Path'. 'Conflict Path 14" A5
CHARACTER (100" TARGET =rmywir:' | RTRIM[ CAST

["ZRLC Diagnostics' " 'Fact - Conflict Path"Conflict Path [d" AS
CHARACTER (100 I ' A&

D ezcription:

The conflict cath 10 link can be used to dill down to sowrce system for
wigwing conflict path,

k. I Cancel Help

® Create an answer with the logical column as created above and change the data
format as HTML) and run the report.

* '"Save system-wide column formats" and "Save Content with HTML Markup"
privilege should be given to Everyone, which is by default given to Presentation

Server Administrators
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4

Installation and Upgrade Options for Oracle
Fusion Governance, Risk and Compliance
Intelligence 2.0.1

Overview

This chapter refers the user to the previous sections of the GRCI 2.0.1 installation guide
when installing for both GRCM 7.8 and AACG 8.2.

Additionally within this chapter, if there is an existing GRCI 1.0 installation and it needs
to be upgraded to GRCI 2.0.1, then the user should refer to the upgrade section, and
follow the instructions.

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for
both GRCM 7.8 and AACG 8.2

Installing Oracle AACG Scripts

Please refer to Chapter 3, which describes the necessary steps for the installation of
AACG 8.2 as a source application.

Installing Oracle GRCM Scripts

Please refer to Chapter 2, which describes the necessary steps for the installation of
GRCM 7.8 as a source application.

Installing ODI Code

Please refer to Chapter 3, which describes the necessary steps for the installation of ODI
Code in GRCI.
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Installing OBIEE Reports

Please refer to Chapter 2, which describes the necessary steps for the installation of
OBIEE Reports.

Multi-Language Setup for OBIEE

Please refer to Chapter 2, to view the source language files required to support multiple
languages in OBIEE

Installing Bl Publisher Reports

Please refer to Chapter 2, for instructions on installing Oracle BI Publisher 10.1.3.3.3 and
data source configuration.

Security Integration with GRCM 7.8

Please refer to Chapter 2, which provides optional details and requirements on the
integration of the security components for both GRCM 7.8 and GRCI 2.0.1

Security Integration with AACG 8.2

Please refer to Chapter 3, which provides optional details and requirements on the
integration of the security components for both AACG 8.2 and GRCI 2.0.1

Upgrading GRCI 1.0 to GRCI 2.0.1

Overview of GRCI 1.0 Data Load

This section applies to users who are upgrading from GRCI 1.0 to GRCI 2.0.1 The source
of GRCI 1.0 is solely GRCM, and the data is loaded in a 'truncate-load' fashion. This
means that during every load cycle, data in the GRCI tables are truncated and reloaded
from the source application (GRCM). However, if a user wishes to drop, recreate the
tables, and reload them from the source application, they are able to pass a value of 1 to
the vForceCreate parameter, which would then drop all the objects, recreate them and
then reload them.

Upgrading GRCI 1.0 to GRCI 2.0.1

In order to upgrade from GRCI 1.0 to GRCI 2.0.1, users can follow the approach of
recreating the entire schema and reloading it from the source, by using the
vForceCreate as explained.

The parameter's value is set in the file Execute_Create.sql to 1, and when it is set to 1, all
the GRCI objects are recreated and reloaded.
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After setting this variable, refer to Chapter 2 if GRCM 7.8 is the only source application;
or, refer to the beginning of this chapter if both GRCM 7.8 and AACG 8.2 are the
sources.

The sections on installing Oracle Scripts contains detailed instructions on the
installation and configuration of the model, ETL and Reports-Dashboards components
of GRCI 2.0.1

Please read the note section in "Creating the Target Physical Model" in Chapter 2 for
further information about the upgrade of GRCD_TIME_D, GRCD_TIME_TL and
GRCD_USERS.
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ETL Execution

This appendix covers the following topics:
¢ Execution Sequence
¢ ETL Execution

e Execute a Package

Execution Sequence
Order of Execution for the ETL:
The following packages are placed into a single package (GRI_MASTER_PKG).
1. GRI_DIMENSIONS_PKG

2. GRI_BRIDGE_TABLES_PKG
3. GRI_FACTS_PKG

The order for execution of the Dimensions is as follows:

1. GRLINSTANCE_PKG

2.  GRI_GENERIC_DIM_PKG

3. GRCD_USER_MAIN_PKG

4. GRI_POLICY_PKG

5. GRI_ENTITLEMENT_PKG

6. GRI_ACCESS_POINT_PKG

7. GRI_APPS_USER_PKG
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8. GRI_D_RUN_PKG
9. GRI_EXCLUSION_PKG

Steps 4-8 may be run independent of each other, but the rest should be run in numeric
order.

The bridge tables can be run independent of each other, and these are the packages
present in the GRI_BRIDGE_TABLES_PKG. They should be run after the loading of all
the dimensions.

1. GRI_D_ROLE_USER_BG_PKG

2. GRI_D_ROLE_USER_BG_PKG

3. GRI_POLICY_DETAIL_BG_PKG

4. GRI_D_ENTLMNT_GENERIC_DIM_BG_PKG
5. GRI_D_ENTITLEMENT_AP_BG_PKG

The GRI_FACTS_PKG contains the following packages for loading the conflicts and
conflict paths and they should be loaded in the following order and only after the
loading of the dimensions and bridge tables.

1. GRI_F_CONFLICTS_T_PKG
2. GRI_D_POLICY_PREV_RUN_BG_PKG
3. GRI_F_CONFLICT_PATH_T_PKG

4. GRI_F_CONFLICT PATH_T_PKG_2

ETL Execution

In the ODI Designer module, (N) GRI > SOD Mart > Packages; the user can then locate
the following master package: GRI_MASTER_PKG.

The dimension and bridge table related interfaces and packages are found by
navigating in the ODI Designer module to (N) GRI > SOD Mart.

The fact table and related interfaces and packages are found by navigating in the ODI
Designer module to (N) GRI > SOD Mart > Facts.

There are three ETL Execution options:

Option 1:
1. Execute GRI_MASTER_PKG Package.
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2. This action triggers all the packages required to load the entire star schema.

Option 2:

Important: Execute the packages in the following order.

1. GRI_DIMENSIONS_PKG - this package will load all the dimension tables.
2. GRI_BRIDGE_TABLES_PKG - this package will load all the bridge tables.
3. GRI_FACTS_PKG - this package will load all the fact tables.

Option 3:

Run individual table level packages, in the same order as in Option 2.

Execute a Package

In order to execute a package, navigate to the ODI Designer and locate the required
package to execute

Right click on that package, and then click Execute as shown below:
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In the Execution window, select the context that was created as part of the ODI Code
installation.

Note: Please refer to Chapter 3 "Installing ODI Code"

Click OK. This starts a session for the executed package.
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The status of a session and its corresponding steps and tasks can be checked in, in the
ODI Operator module.

In case of a higher-level package, such as one encapsulating multiple child packages,
the status for each child package session can also be monitored.
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Verify that the package has run successfully. The result of each task execution can be
viewed in the Execution tab of Session Task window.

Verity the number of rows processed as part of each task in the session.

Note: Please refer to the Oracle Data Integrator User's Guide for more
detail on using the ODI Designer and ODI Operator modules.
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Architecture

This appendix covers the following topics:
¢ Data Flow Diagram

¢ Detailed Data Flow Diagram
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Data Flow Diagram
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Detailed Data Flow Diagram
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Logical and Physical Models

This appendix covers the following topics:

GRCI - AACG 8.2 Logical Model
GRCI - AACG 8.2 Physical Model
GRCI - GRCM 7.8 Logical Model
GRCI - GRCM 7.8 Physical Model

GRCI - AACG 8.2 Logical Model

Conflicts

Conflict

Grain: Run, Policy, Global User

Conflict Generation Flag
Conflict Status
Latest Policy Run Flag

ﬁ" S0D Policy

Approved Conflict Count
Monitor Conflict Count
Pending Conflict Count
Prevented Conflict Count
Rejected Conflict Count
Total Conflict Count
Number of Days Outstanding
S0D Policy Count
Run Count
Global User Count

Time Series{YAgo, QAgo, MAgo)..

Time hierarchy:
Year -> Quarter -> Manth -> Day

Policy hierarchies:

Policy Type -> Policy Name
Policy Priority -» Policy Name
Process -> Policy Name

Risk -> Policy Name

Conflict Path

Logical and Physical Models C-1



Conflict Path

Grain: Run, Policy, Application
User, Instance, Conflict Path

Conflict Generation Flag
Conflict Path Status
Latest Palicy Run Flag

Access Point
{Priviiege)

{1

Approved Conflict Path Count
Monitor Canflict Path Count
Pending Conflict Path Count

Prevented Conflict Path Count
Rejected Conflict Path Count

Total Conflict Path Count

Access Point

Access Point
(Role)

App User Conflict Count

Number of Days Outstanding
50D Policy Count

Run Gount
{ } AssignedTo 7 Application User Caunt
Raole Count

Privilege Count
Entitlement Count
Assigned To User Count

Time hierarchy: Time Series(YAgo, QAgo, MAgo)...
Year -> Quarter -> Month -> Day

Policy hierarchies:

Policy Type -> Policy Name
Palicy Priority -> Policy Name
Process -> Policy Name

Risk -= Policy Name

Access Point hierarchy:
Access Point Type -> Access Point Name

e Conflict Comparison by Run

Conflicts Comparison by Run
Grain: Run, Palicy

Conflict Generation Flag
Latest Policy Run Flag

Approved Conflict Count
Monitor Conflict Count
Pending Conflict Count
Prevented Conflict Count
Rejected Conflict Count
Total Conflict Count
Approved Conflict Count (Previous Run)
Moniter Conflict Count (Previous Run)
Pending Conflict Count {Previous Run)
Prevented Conflict Count (Previous Run)
Rejected Conflict Count (Previous Run)
Total Conflict Count {Previous Run)

Approved Conflict Path Count
Manitor Conflict Path Count
Pending Conflict Path Count
Prevented Conflict Path Count
Rejected Conflict Path Count
Total Conflict Path Count
Approved Conflict Path Count (Previous Run)

Time hierarchy:
Year -> Quarter -> Manth -> Day

Policy hierarchies:

Policy Type -= Policy Name
Policy Priority == Policy Name
Process -> Policy Name

Risk -> Policy Name

e  Exclusions

Monitor Conflict Path Count (Previous Run)
Pending Conflict Path Count (Previous Run)
Prevented Conflict Path Count (Previous Run)
Rejected Conflict Path Count (Previous Run)
Total Conflict Path Count (Previous Run)

App User Conflict Count
App User Cenflict Count (Previous Run)
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Exclusi
{ } Entionvane )"/

(03 Eo ) 7| S|

Time hierarchy:
Year -> Quarter -> Month -> Day

Policy hierarchies:

Policy Type -> Policy Name
Policy Priority -> Policy Name
Process -> Policy Name

Risk -> Palicy Name

Access Point hierarchy:
Access Point Type -> Access Point Name

e Path Exclusions

Access Point
(Exlude)

Access Point
(From)

Policy hierarchies:

Policy Type -> Policy Name
Palicy Priority -> Policy Name
Process -> Palicy Name

Risk -> Policy Name

Access Point hierarchy:
Access Point Type -> Access Point Name

¢ Policy Detail

Exclusions/Conditions

Grain: Exclusion Type, Exclusion
Value, Policy, Instance, Start Date

Condition Start Date
Condition End Date
Condition Value Start Date
Condition Value End Date
Global Condition Flag
Global Condition Value Flag
Same Flag (Policy, Global)

Conditions Count
Policy Count
Access Point Count
Application User Count

Path Exclusions

Grain: Instance, User, Access
Point, Access Point - From, Start
Date

Condition Path Start Date
Condition Path End Date

Condition Path Status
Condition Path Action

Logical and Physical Models
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Policy Detail

Grain: Policy, Detail Type, Access
Point, Policy Effective Date

Policy Count
Entitlement Count
Access Paoint Count
Instance Count
Process Count

Risk Count

Time Series(YAgo, QAgo, MAgo)...

(7

Time hierarchy:

Year -> Quarter -> Month -> Day
Policy hierarchies:

Policy Type -> Policy Name
Policy Priority -> Policy Name
Process -> Policy Name

Risk -» Policy Name

Access Point hierarchy:
Access Paint Type -> Access Point Name

GRCI - AACG 8.2 Physical Model

e Access Point
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=] GRI_D_ACCESS_POINT_TL

ACCESS_POINT_SID : MUMBER
LANGUAGE : VARCHAR2(4)
INSTANCE_SID : NUMBER
SRC_SYS_D : VARCHAR2(S)
SOURCE_LANG | VARCHAR2(4)

ACCESS_POINT_MAME : VARCHARZ({256)
ACCESS_POINT_DESC : WARCHARZ(1024)
ACCESS_POINT_TYPE_MNAME : VARCHARZ(256]

BATCH_ID : NUMBER
CREATION_DATE : DATE
CREATED_BY : NUMBER
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY . NUMBER
LAST_UPDATE_LOGIN : NUMBER

Policy

@J GRI_D_ACCESS_POINT_WL

B.ACCESS_POINT_SID
B.ACCESS_POINT_ID

TL LANGUAGE
BINSTAMCE_SID
B.SRC_SYS_ID

TL ACCESS_POINT_MAME
TL.ACCESS_POINT_DESC
TL.ACCESS_POINT_TYPE_MAME
B.ACCESS_POINT_CODE
B.ACCESS_POINT_TYPE_CODE
B.ACCESS_POINT_START_DATE
BLACCESS_POINT_END_DATE
B EFFECTIVE_START_DATE
B.EFFECTIVE_END_DATE
B.CURRENT_IMD

BBATCH_D
B.CREATION_DATE

B .CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE_LOGIN

o1 | ACCESS_POINT_CODE : VARCHARZ(256)
ACCESS_POINT_TYPE_CODE : WVARCHAR2(258)
ACCESS_POINT_START_DATE: DATE

= GRI_D_ACCESS_POINT

ACCESS_POINT_SID : NUMBER
ACCESS_POINT_ID : NUMBER
INSTANCE_SID : NUMBER
SRC_SYS_ID: WARCHAR2(S)

ACCESS_POINT_EMND_DATE : DATE
EFFECTIVE_START_DATE : DATE
EFFECTIVE_EMD_DATE : DATE
CURREMT_IMD : VARCHAR2(1)
BATCH_ID : MUMBER
CREATION_DATE : DATE
CREATED_B : NUMBER

| 7|LAST_UPDATE_DATE: DATE

LAST_UPDATED_BY . NUMEBER
LAST_UPDATE_LOGIM : NUMBER

«UK» GRI_D_ACCESS_POINT_UK1 : ACCESS_POIN'

;I:’: TL{GRI D ACCESS POINT TL})

Logical and Physical Models
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] GRI_D_POLICY_TL

POLICY_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)

SRC_SYS_ID: VARCHAR2(S)
SOURCE_LANG : VARCHAR2(4)
POLICY_NANE : VARCHAR2(256)
POLICY_DESC : ARCHAR2(1024)
POLICY_COMMENTS : VVARCHAR2(1024)
POLICY_EXPRESSION : VARCHARZ2(1024)
POLICY_STATUS_DESC : VARCHAR2(1024)
POLICY_TYPE_DESC : VARCHAR2(1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_COGIN: NUMBER(15, 0)

Uk GRI_D_POLICY _TL_U1 : POLICY_SID, L,
<Fis GRI_D_POLICY _TL _FK1 : POLICY_SID

f] GRILD _POLICY VL

GDP POLICY_SID
GDPPOLICY_ID =
GDP POLICY_VERSION_ID

GDPTL LANGUAGE

GDP.SRC_SYS_D

GDPTL SOURCE_LANG

GDPTL POLICY _NAWE

GDPTL POLICY_DESC
GDPTL.POLICY_COMMENTS

GDPTL POLICY_EXPRESSION

GDPTL POLICY_STATUS_DESC

GDPTL POLICY _TYPE_DESC

GDP POLICY _PRIORITY = GDP(GRI D POLICY:

GDP POLICY_EFFECTIVE_DATE b
GDP POLICY _STATUS_CODE
GDP POLICY _TYPE_CODE

GDP POLICY _OWNER_SID

GDP POLICY _MODIFIED_BY_SID
GDP EFFECTIVE_START_DATE
GDP EFFECTIVE_END_DATE
GDP CURRENT_IND

GDP BATCH_ID

GDP CREATION_DATE
GDP.CREATED_BY
GDPLAST_UPDATE DATE
GDPLAST_UPDATED_BY

GDP LAST_UPDATE_LOGIN

e Entitlement

GOPTL(GRI D POLICY TL

=] GRI_D_POLICY

POLICY _SID : NUMBER(15, 0)
POLICY_ID : NUMBER(15, 0)

POLICY _VERSION_ID : NUMBER(15, 0)
SRC_SYS_ID : VARCHAR2(S)

POLICY _PRIORITY : NUMBER(15, 0)

POLICY _EFFECTIVE_DATE : DATE

POLICY _STATUS_CODE : VARCHAR2(256)
POLICY _TYPE_CODE : VARCHAR2(256)
POLICY_OWNER_SID : NUMBER(15, 0)
POLICY _MODIFIED_BY_SID : NUMBER(15, 0)
EFFECTIVE_START_DATE : DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

BATCH_D : NUMBER(15, 0)

[E  GRLD_POLICY_DETAL_BG

POLICY_SID : NUMBER(15, 0}
DETAIL_SID : NUMBER(15, 0}
DETAIL_TYPE : VARCHAR2(50)
SRC_SVS_ID: VARCHAR2(S)

BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)
UK GRI_D_POLICY_DETAIL_BG_U1 : PO
&Fis GRILD_POLICY_DETAIL_FKT : POLIC!

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0) 1
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUWBER(15, 0)
LAST_UPDATE_LOGIN : NUWBER(15, 0)

&K GRI_D_POLICY LN - POLICY_SID

[ GRID_POLICY_GENERIC_PI_BG

POLICY_SID : NUMBER(15, 0)
GENERIC_DIM_V/ALUE_SID : NUMBER(15, 0)
SRC_SYS_ID : YARCHAR2(S)

BATCH_ID : NUMBER{15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

«<UI» GRI_D_POLICY_GENERIC_DIM__U1 : POLIC
<FKs GRI_D_POLICY_GENERIC_DIM_FK1 : POLI

I B GRLD_POLICY_TC_VL

| FOLICY_SID
| TOTAL_POLICY_CNT

v}
| N | |poucv_versionn
LANGUAGE
SRC_SYS_ID
SOURCE_LANG
POLICY_NAME
POLICY_DESC
POLICY_COMMENTS
POLIC’ {PRESSION
POLICY_STATUS_DESC
POLICY_TYPE_DESC
POLICY_PRIORITY
POLICY_EFFECTIVE_DATE

FE  GRID POLICY VL

C-6 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



] GRI_D_ENTITLEMENT VL !

GDE ENTITLEMENT _SID
GDE ENTITLEMENT _ID

GDE ENTITLEMENT _VERSION_ID

GDETL LANGUAGE
GDE SRC_SYS_ID
GDETL SOURCE_LANG

[  GRLD_ENTITLEMENT_TL

ENTITLEMENT_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)

SRC_SYS_D : VARCHAR2(S)
SOURCE_CANG : VARCHAR2(4) -
ENTITLEMENT_NAME : Y ARCHAR2(256)
ENTITLEMENT DESC : VARCHARZ2(1024)
ENTITLEMENT_STATUS_DESC : VARCHAR
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_B' : NUMBER(15, 0
LAST_UPDATE_LOGIN : NUMBER(15, 0)

UKz GRI_D_ENTITLEMEMT_TL_UI1 : ENTITI

£

GDETL ENTITLEMENT _NAME

GDETL ENTITLEMENT_DESC

GDETL ENTITLEMENT _STATUS_DESC
GDE EMTITLEMENT _EFFECTIVE_DATE
GDE EMTITLEMENT _STATUS_CODE
GDE EMTITLEMENT _MODIFIED_BY_SID
GDE EMTITLEMENT _CVWNER_SID

GDE EFFECTIVE_START_DATE
GDE EFFECTIVE_END_DATE

GDE CURRENT_ND
GDEBATCH_D
GDE.CREATION_DATE
GDE CREATED_BY

GDE LAST_UPDATE_DATE
GDE LAST_UPDATED_BY
GDE LAST_UPDATE_L OGIM

Generic Dimension

GDE(GRI D ENTITLEMENT) ).

B GRI_D_EMTITLEMENT

ENTITLEMENT_SID : NUMBER(15, 0)
ENTITLEMENT_ID : NUMBER(15, 0)
ENTITLEMENT_VERSION_ID - NUMBER(15,
SRC_SYS_D T VARCHAR2(S)
ENTITLEMENT_EFFECTIVE_DATE : DATE
ENTITLEMENT_STATUS_CODE : VARCHAF
ENTITLEMENT_MODIFIED_BY _SID ; NUMBE
ENTITLEMENT_OWNNER_SID : NUMBER(15, | 4
EFFECTIVE_START_DATE: DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

BATCH_D : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_B'Y : NUMBER(15, 0
LAST_UPDATE DATE: DATE
LAST_UPDATED_B' : NUMBER(15, 0)
LAST_UPDATE_LOGIN - NUMBER(15, 0)

«UkK> GRI_D_ENTITLEMENT_UZ2 | ENTITLEM 1

3

=5 GDETL{GRI D ENTITLEMENT TL}

Logical and Physical Models

[ GRI_D_ENTITLEMENT_AP_BG

ENTITLEMENT_SID : NUMBER(15, 0)
ACCESS_POINT_SID : NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)
BATCH_ID”. NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE

" LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<tz GRI_D_ENTITLEMENT_AP_BG_UT : E

[  GRI_D_ENTLMNT_GENERIC_DIM_BG

ENTITLEMENT_SID : NUMBER(15, 0)
GENERIC_DIM_VALUE_SID : NUMBER(15, 0)
SRC_SYS_ID: VARCHARZ(S)

BATCH_D - NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : MUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

&Kz GRI_D_ENTLMNT_GENERIC_DIM_L1 : ENTITLE
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[  GRID_GENERIC_DIM_TL

GENERIC_DIM_SID : NUMBER(15, 0)

LANGUAGE : VARCHAR2(4)
SRC_SYS_ID - VARCHAR2(5)
SOURCE_LANG : VARCHAR2{d)

|_NAE : VARCHAR2(256)
GENERIC_DIM_DESC : VARCHAR2(1024)
GENERIC_DIM_STATUS_DESC: VARCHAR
BATCH_ID - NUMBER(15, 0)
CREATICN_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE

GENERIC_DI

LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<LK GRI_D_GENERIC_DIM_TL_U1

f) GRID_GENERIC_DIM_VL

B.GENERIC_DIM_SID
B.GENERIC_DIM_ID

TL LANGUAGE

8.SRE_SYS_D

TL SOURCE_LANG
B.GENERIC_DIM_TYPE_CODE
TL GENERIC_DIM_NAME

TL GENERIC_DIM_DESC

B GENERIC_PIM_STATUS_CODE
TL GENERIC_DIN_STATUS_DESC
B.NSTANCE_SID

B EFFECTIVE_START_DATE
B.EFFECTIVE_END_DATE
B.CURRENT_IND

BBATCH D

B CREATION_DATE
B.CREATED_BY
B.LAST_UFDATE_DATE
B.LAST_UPDATED_BY
B.LAST_UPDATE_LOGIN

e Instance

=

= GRI_D_GENERIC_DIf

GENERIC_DIM_SID : NUMBER(15, 0)
GENERIC_DIV_ID - NUMBER(15, 0)
SRC_SYS_ID : VARCHARZ(S)
GENERIC_DIM_TYPE_CODE : VARCHARX(:
GENERIC_DIM_STATUS_CODE : ¥ARCHAF
INSTANCE _SID : NUMBER(15, 0)
EFFECTIVE_START DATE: DATE
EFFECTIVE_END_DATE : DATE

CURRENT IND : VARCHAR2(1)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

¥ GRI_D_GENERIC_DIM_1 : GENERIC_

[ GRI_D_GENERIC_DIM_VAL

GENERIC_DIM_VAL_SID : NUMBER(15, 0)
GENERIC_DIM_SID | NUMBER(15, 0)
GENERIC_DIM_VAL D : NUMBER(15, 0)
SRC_S¥5_ID - VARCHARZ(S)
GENERIC_DIM_VAL_STATUS_CODE: VAR
EFFECTIVE_START DATE: DATE
EFFECTIVE END_DATE: DATE
CURRENT_IND | VARCHARZ(1)
BATCH_ID: NUMBER(15, 0)
CREATICN_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(1S, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

«UK» GRI_D_GENERIC_DIM_VAL U2 GEN
<LK GRI_D_GENERIC_DIM_VAL L1 : GEN

UK GRI_D_GENERIC_DIM_UZ : GENERIC_

GENEI
~
@ TLIGRI D GENERIC DM TL)

=
a

B(GRI D GENERIC DIM)

{3 GRLD_GENERIC_DIM_VAL VL EE
B GENERIC_DIM_AL_SID

B GENERIC_DIM_SID

B GENERIC_DIM_\/AL_ID

[  GRI_D_GENERIC_DIM_VAL_TL

GENERIC_DIM_VAL_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)

SRC_SYS_ID : VARCHAR2(S)
SOURCE_LANG : ARCHARI(4)
GENERIC_DIM_VVAL_NAE : VARCHAR2(256)
GENERIC_DIM_VAL_STATUS_DESC : VARCH

[a1 |BATCHD: NUMBER(15, 0)

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, D)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

UK» GRI_D_GENERIC_DIM_VAL TL U1 : GE|
Fi GRI_D_GENERIC DIM_VAL TL_ Fit : €

BIGRI D GENERIC DIM VAL) |

TLLANGUAGE
BSRC_SYS_D
TL.SOURCE_LANG [ IL(GRI D GENERIC DIM VAL TL)

TL.GENERIC_DIM_VAL_NAME
B GENERIC_DIM_\/AL_STATUS_CODE
TL.GENERIC_DIM_VAL_STATUS_DESC
B EFFECTIVE_START_DATE

B EFFECTIVE_END_DATE
B.CURRENT_IND

BBATCH_D

B CREATION_DATE

B CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE LOGIN

Type s Businsss Process

{9  GRLD_GENERIC_DIM_VAL BP_VL
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=] GRI_D_INSTANCE_TL

INSTANCE_SID : NUMBER{15, 0)
INSTANCE_ID : MUMBER(15, 0)
LANGUAGE : VARCHARZ(4)
SRC_SYS_ID: VARCHARZ(S)
SOURCE_LANG | VARCHAR2(4)
INSTAMNCE_MAME : VARCHAR2({1024)
INSTAMCE_DESC : VARCHARZ2(1024)
INSTAMNCE_LOCATION : ARCHAR2({256)
INSTAMNCE_SCHEMA_MNAME : VARCHARZ(
INSTAMNCE_STATUS_DESC : VARCHARZ(1
PLATFORM_TYPE : VARCHARZ(256)
PLATFORM_DESC : VARCHARZ{1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : MUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
|LAST_UPDATE_LOGIN : NUMBER{15, 0)

UKz GRI_D_INSTANCE_TL_U1 : INSTANC

g GRID_INSTANCE_VL

BINSTAMCE_SID
BINSTAMCE_ID
TL LANGUAGE
TLSOURCE_LAMG
B.SRC_SYS_ID
BINSTAMCE_CODE
TL INSTANCE_NAME
TLINSTAMNCE_DESC
TLINSTANCE_LOCATION
TLINSTANCE_SCHEMA_MAME
| TLINSTAMNCE_STATUS_DESC
TLPLATFORM_TYPE
TL PLATFORM_DESC
BINSTAMCE_HOST_MAME
BINSTANCE_USER_MNAME
BINSTAMCE_PASSWORD
BINSTAMCE_PORT
BINSTAMCE_URL
BIMSTAMCE_DRINER
BINSTAMCE_STATUS
B PLATFORM_CODE
B PLATFORM_VERSION
BINSTAMCE_SYNC_DATE
B EFFECTIVE_START_DATE
B EFFECTIVE_END_DATE
B.CURRENT _IND
BEATCH_ID
B.CREATION_DATE
B.CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE_LOGIN

=

] GRI_D_INSTANCE

INSTANCE_SID : NUMBER(15, 0
INSTANCE_ID : NUMBER(15, 0)
SRC_SYS_ID: VARCHARZ(S)
INSTANCE_CODE : WARCHARZ(256)
INSTANCE_HOST_MAME : VARCHAR2(25¢
INSTANCE_USER_MAME : VARCHARZ(25¢
INSTANCE_PASSWORD : VARCHAR2(256
INSTANCE_PORT : NUMBER(15, 0)
INSTANCE_URL : VARCHAR2(258)
INSTANCE_DRIVER : VARCHAR2(256)
INSTANCE_STATUS : VARCHARZ(256)
PLATFORM_CODE : VARCHARZ(256)
PLATFORM_VERSION : VARCHAR2(256)
INSTANCE_SYNC_DATE : DATE
EFFECTIVE_START_DATE : DATE
EFFECTIVE_EMD_DATE : DATE
CURRENT_IMD : VARCHARZ(S)

BATCH_ID : NUMBER(S, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER{15, 0)
LAST_UPDATE_LOGIN : MUMBER(15, 0)

UKz GRI_D_INSTAMCE_UZ | INSTANCE_IC
UKz GRI_D_INSTAMCE_UIM | INSTANCE_S

;Hl=_ TLIGRl D INSTANCE TL)

j|:_= BIGRI D INSTANCE]
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e Run

(] GRI_D_RUM

RUN_SID : NUMBER(15, 0)
SRC_SYS_ID : VARCHAR2(50)

RUN_ID : NUMBER(15, 0}

RUN_DATE_SID : NUMBER{15, 0)
TOTAL_CONFLICTS_CNT : NUMBER(15, 0)
TOTAL_CONFLICT_PATH_CNT : MUMBER(15, 0)
RUN_END_DATE : DATE
EFFECTIVE_START_DATE : DATE
EFFECTIVE_END_DATE : DATE

CURRENT_IND : VARCHARZ(1)

BATCH_ID : NUMBER(15, 0)

CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATE_LOGIN : NUMBER(15, 0)
LAST_UPDATED_BY : NUMBER(15, 0}

«UKz GRI_D_RUN_UT ; RUN_SID
UKz GRI_D_RUN_UZ : RUN_ID, SRC_SYS_D

B GRI_D_RUN_LATEST_FLAG_V i

RRUN_SID

SRC_SYS_ID

RIN_ID

RUN_DATE_SID E_T B(GRI D RUN)

TOTAL_CONFLICTS_CNT
TOTAL_CONFLICT_PATH_CNT
RUN_END_DATE

EFFECTIVE_START_DATE
EFFECTIVE_END_DATE

CURRENT_IND

BATCH_D

CREATION_DATE

CREATED_BY

LAST_UPDATE_DATE

LAST_UPDATE_LOGIM

LAST_UPDATED_BY
LATEST_RUM_FLAG(CASE VWHEN R.RUN_SID

e User
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£ ORI_D_APPS_USER_VL

B APPS_USER_SID
B GLOBAL_USER_SID

B GLOBAL_USER_NAME
B RELATED_USER ID

TL L ANGUAGE

L SOURCE_LANG
B.SRC_SYS_ID
BINSTANCE_SID

B IDENTIFYING _VALUES
TL DISPLAT_NANE
TLUSER_NAME
TLFIRST_NAME
TLLAST_NAME
TLUSER DESC

B USER_START_DATE
B.USER_END_DATE

B EMPLOYEE_ID

B APPS_USER_STATUS

[F  GRLD_APPS_USER_TL
APPS_USER_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)
SRC_SYS_ID : VARCHAR2(50)
INSTANCE_SID : NUMBER(15, 0}
SOURCE_LANG : VARCHARZ(4)
DISPLAY_NANE : VARCHAR2(256)
USER_NANE : VARCHAR2(256)
FIRST_NAWIE : \VARCHAR2(256)
LAST_NANE : VARCHAR2(256)
USER_DESC : VARCHAR2(1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_OGIN : NUMBER(1S, D)

U GRI_D_APPS_USER_TL_U1 : APPS

[ BIGHI D APPS USER)

TL.APPS_USER_STATUS_DESC
B EFFECTIVE_START_DATE

B.EFFECTIVE_END_DATE
B.CURRENT_IND

B.LAST_UPDATED_BY

Time

[ GRID_APPS_USER_ALL VL

9 ILGRI D APPS USER TL)

[] GRI_D_APPS_USER

APPS_USER_SID'* NUMBER(15, 0)
GLOBAL_USER_NAME : VARCHAR2(256)
RELATED_USER_ID : VARCHAR2(256)
SRC_SYS_ID : VARCHAR2(S0)
INSTANCE_SID : NUMBER(15, 0)
IDENTIF'YING_\/ALLES : ARCHAR2{256)
USER_START_DATE : DATE
USER_END_DATE : DATE

EMPLOYEE D : NUVBER(15, 0)
APPS_USER_STATUS | VARCHAR2(256)
EFFECTIVE_START DATE: DATE
EFFECTIVE_END_DATE: DATE
CURRENT_IND : VARCHARZ(1)
BATCH ID : NUMBER(15, 0)
CREATICN_DATE : DATE

CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

Ul GRI_D_APPS_USER_U1 : RELATED_USER |
APPS_USER_UK1 : APPS_USER _SI.

«UK» GRS

] GRI_D_GBL_USER
GLOBAL _USER_SID : NUMBER(15, 0)

GLOBAL_USER_NAN
SRC_SY5_ID: VARCHAI
BATEH_ID: NUMBER(15,

R2(50)
. 0)

CREATION_DATE : DATE
CREATED_BY : NUWBER(15, 0)

<> GRI_D_GBL_USER U1

LAST_UPDATE DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN: NUMBER(15, 0)

E: VARCHAR2(256)

GLOBAL Lt

«<UK» GRI_D_GBL_USER U2 : GLOBAL U

A

[ GRCD_USERS

GRCD_USER_SID : NUMBER(15, 0)
USER_ID : NUMBER(15, 0)

C_SVS_ID: VARCHAR2(S)
USERNAME : NVARCHAR2(765)
GROUPNAME : NVARCHAR2(1500)
DISPLAYNANE : NVARCHAR2(1500)
PASSINORD : NVARCHAR(765)
LOGLEVEL : NUMBER(1, 0)
USER_EMAIL_ID_{ : VARCHAR2(240)
USER_EMAIL ID_2: \VARCHAR2(240)
MOBILE_PHONE : ARCHAR2(80)
USER_STATUS : VARCHAR2(50)
BATCH_D : NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE DATE : DATE

«UK» GRCD_USERS_UK1 : GRCD_USER S

f] ORCD_USERS_VL
B.GRCD_USER_SID

B.USER_ID i
TLLANGUAGE b
B.SRC_SYS_ID

L SOURCE_LANG
TLUSER_NAME_DESC
TLFRST_NAME
TLLAST_NAME
TLUSER_STATUS_DESC
TLUSER_ADDR

B.USERNANE
B.GROUPNANE

B.DISPLAYNANE =
B PASSWORD ™

B.LOGLEVEL

Superset of Applcation
and Global Users.

B USER_EMAIL_ID_1
B USER_EMAIL_ID_2

B MOBILE_PHONE
B.USER_STATUS
B.BATCHD

Logical and Physical Models

1) GRCD_USERS_TL

GRCD_USER_SID : NUMBER(15, 0)
LANGUAGE | VARCHAR3(4)
SRC_SYS_ID: VARCHAR2(5)

LAST_NAME : ¥ARCHAR2(256)
USER_STATUS_DESC: VARCHAR2(1024)
USER_ADDR : YARCHAR2(1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN: VARCHAR2(15)

BIGRED USERS

TLIGRCD USERS TLY
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] GRCD_TIME_TL

TIME_KEY : NUMBER(30, 0)
LANGUAGE : YARCHAR2(10)
SOURCE_LANG : VARCHAR2({10)
LOCALE: VARCHAR2{10)
DAY_MAME : NV ARCHAR2(30)
LAST_DAY_IN_MTH_ND : N\VARCHAR2(3)
MTH_NAME : NVARCHAR2(S0)
QTR_MAME : NVARCHAR2({50)
HOLIDAY _IND : NV ARCHAR2(30)
VWKDAY_IND : N\ ARCHARZ(30)
DAY_ABBREY : NVARCHAR2(30)
MTH_ABBREY : MVARCHAR2({30)

£ GRCD_TIME_VL

BASE TIME_KEY
TL LANGUAGE
TL.SOURCE_LANG
TL.LOCALE

BASE CREATE_DT
BASE.TIME_DT
TL.DAY_NAME
BASEDAY_NER
BASELAST_UPDATE_DT
TL.LAST_DAY _IN_MTH_IND
TL.MTH_MAME

BASE MTH_NER
TL.QTR_MAME

BASE QTR_MER
BASE.YR_MTH
BASE.YR_MBR
BASEWHK_END_DT
BASEWHK_START_DT
BASE WHK_NBR
BASEDAY_NBR_OVERALL
BASEDAY_OF_WK
TLHOLIDAY_IND
TLAWKDAY_ND
TL.DAY_ABBREV

BASE MTH_NBR_OVERALL
TL.MTH_ABBREV
BASE.YR_QTR
BASEWHK_NBR_OVERALL
BASE QTR_NBR_OVERALL

AG Role

C-12 Oracle Fusion Governance, Risk and Compliance Intelligence Impleme

] GRCD_TIME_D

TIME_KE'Y : NUMBER(30, 0)
CREATE_DT : DATE

TIME_DT : DATE

DAY_NAME : NV ARCHAR2(90)
DAY_NBR : NUMBER
LAST_UPDATE_DT: DATE
LAST_DAY_IN_MTH_IND : NV ARCHAR2(3'
MTH_MAME - Ny ARCHAR2(90)
MTH_NER : NUMBER

QTR_MAME : NVARCHAR2(90)
GTR_MBR : NUMBER

YR_MTH : NUMBER

YR_MBR : NUMBER

WK_END_DT : DATE
WK_START_DT : DATE

WK _NER : NUMBER
DAY_NBR_DVERALL : NUMBER
DAY_OF WK : NUMBER
HOLIDAY_IND : NVARCHAR2(3)
WKDAY _IND : NVARCHAR2(3)
DAY_ABBREY : NVARCHAR2(30)
MTH_MBR_OVERALL : NUMBER
MTH_ABBREY : NV ARCHAR2(0)
YR_QTR : NUMBER
WK_NBR_OVERALL : NUMBER
GTR_MBR_OVERALL : NUMBER

" | «UKs GRCD_TIME_D_UK1 ; TIME_KEY

ntation Guide



= GRI_D_ROLE_TL = GRI_D_ROLE ] GR|_D_ROLE_USER_BEG

ROLE_SID : NUMBER(15, 0) ROLE_SID : NUMBER(15, 0) ROLE_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4) ROLE_ID : NUMBER(15, 0) GRCD_USER_SID : NUMBER(15, 0)
SRC_SYS_ID : VARCHAR2(S0) SRC_SYS_ID : VARCHAR2(50) SRC_SYS_ID : VARCHAR2(50)
SOURCE_LANG : VARCHAR2(4) EFFECTIVE_DATE : DATE ROLE_USER_STATUS_SID : NUMBER(15, (
ROLE_NAME : VARCHAR2(258) ROLE_STATUS_CODE : VARCHAR2(256) EFFECTIVE_START_DATE: DATE
ROLE_DESCRIPTION : \VARCHAR2(1024) , |EFFECTIVE_START_DATE: DATE EFFECTIVE_END_DATE : DATE
ROLE_STATUS_DESC : VARCHAR2{1024)_ ' |EFFECTIVE_END_DATE: DATE " | CURRENT_IND : VARCHAR2(1)
BATCH_ID : NUMBER(15, 0) k CURRENT_IND : VARCHAR2(1) I “|BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE BATCH_ID : NUMBER(15, 0) CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0) CREATION_DATE : DATE CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE I~ CREATED_BY : NUMBER(15, 0) LAST_UPDATE_DATE : DATE
LAST_UPDATED_B'Y : NUMBER(15, 0) ! LAST_UPDATE_DATE : DATE LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER{15, 0) : LAST_UPDATED_B' : NUMBER(15, 0) LAST_UPDATE_LOGIN : NUMBER(15, 0)

| LAST_UPDATE_LOGIN : NUMBER(15, 0)

«UK» GRI_D_ROLE_U1 : ROLE_SID
«Uk» ORI D_ROLE_U2 - ROLE_D, SRC_S" «UK» GR|_D_ROLE_USER_BG_U1 : ROLE_
i - - Fis GRI_D_ROLE_USER_BG_GRI_D__FK

«UK» GRI_D_ROLE_TL_U1 : ROLE_SID, L&

B2 GRI_D_ROLE_VL

BROLE_SID ]
BROLE_ID i
TL LANGUAGE i | BIGRI D ROLE)
BSRC_SYS_ID !

TL SOURCE_LANG

TL ROLE_MAME |
TL ROLE_DESCRIPTION

TL ROLE_STATUS_DESC

B EFFECTIVE_DATE

B ROLE_STATUS_CODE

B EFFECTIVE_START_DATE
B EFFECTIVE_END_DATE

B .CURRENT_IND
BBATCH_ID
B.CREATION_DATE
B.CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE_LOGIN

;ll’_= TLIGRI D ROLE TL)

Conflicts Star

Logical and Physical Models C-13



{2 GRIF_CONFLICTS_A1_V

RUN_SID

RUN_DATE_SID

POLICY _SID
SUM(APPROVED_CONFLICT_CNT)
SUM{MOMITOR_CONFLICT_CNT)
SUM(PENDING__CONFLICT_CHT)
SUM{PREVENTED_CONFLICT_CNT)
SUM(REJECTED_CONFLICT_CNT)
SUM{TOTAL_CONFLICT_CNT)
CONFLICT_GEN_FLAG

E GRI F CONFLICTS T

 PYRMIETNERL (=205 o Sl |

. BB GRI_F_CONFLICTS_T
~ RUN_SID : NUMBER{15, 0) " BE GRLDRUN
RUM_DATE_SID : NUMBER(15, 0)
GLOBAL_USER_SID : NUMBER(15, 0)
POLICY_5ID : NOMBER(15, 0)
COMFLICT_STATUS_SID : NUMBER(15, 0)
APPROVED_CONFLICT_CNT - NUMBER(15, 0)
MONITOR_CONFLICT_CNT : NUMBER({15, 0)
= | PENDING__CONFLICT CNT - NUMBER(15, 0)
|PREVENTED_CONFLICT_CHT : HUMBER(15, 0) -
REJECTED_CONFLICT_CHT : NUMBER(15, 0)
TOTAL_CONFLICT_CNT : NUMBER(15, 0)
NUM_DAYS_OUTSTANDING : NUMBER(15, 0)
CONFLICT_GEN_FLAG : NUMBER{15, 0)
SRC_SYS_ID: VARCHAR2(S)
BATCH_ID : MUMBER(15, 0)
CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
[E oRLA_LOOKUR LAST_UPDATE_DATE : DATE [E cR_D_POLICY
LAST_UPDATED_BY : NUMBER(15, 0)
S ETT—— LAST_UPDATE_LOGIN : NUMBER{15, 0)

[E ©RL_D_GEL_USER

«UK» GRI_F_CONFLICTS_T_U1 : RUN_SID, GLOBAL

" | Latest Policy Run Fla,
[ GRCD_TIME_D i o

£ GRI_F_CONFLICTS_T_V

e  Conflict Path Star
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§8]  ORLF_CONFLICT_PATH_A1_V

RUN_SID
RUN_DATE_SID
POLICY_SID

|INSTANCE_SID

SUM{APPROVED_CONF_PATH_CNT)

SUMMONITOR _CONF_PATH_CNT)
SUM(PENDING_CONF_PATH_CNT)

SUM(PREVENTED_CONF_PATH_CNT)

SUN(REJECTED_CONF_PATH_CNT)
SUM(TOTAL_CONF_PATH_CNT)
|CONFLICT_GEN_FLAG

[ GRID_APPS_USER

[T

[ GRI_D_ACCESS_POINT

[ GRCD_USERS B4

alias of Access Point

[E GRI_D_ACCESS_POINT_ROLE

[ GRLA_LOOKUP

Ef GRI F CONFLICT PATH T

A
H_]

GRI_F_CONFLICT_PATI

RUN_SID : NUMBER(15, 0)
RUN_DATE _SID : NUMBER(15, 0)
USER_SID  NUMBER(15, 0)

POLICY _SID : NUMBER(15, 0)
CONFLICT_PATH_ID : NUMBER(15, 0)
ROLE_SID - NUMBER(15, 0)
PRIVILEGE_SID : NUMBER(15, 0)
INSTANCE _SID : NUMBER(15, 0)
ENTITLEMENT_SID : NUMBER
ASSIGNED_TO_SID : NUMBER(15, 0
STATUS_DATE_SID : NUMBER(15, 0)

CONFLICT_PATH_STATUS_SID : NUMBER(15, 0)
APPROVED_CONF_PATH_CNT : NUMBER(15, 0)
MONITOR_CONF_PATH_CNT : NUMBER(1S, 0)
PENDING_CONF _PATH_CNT : NUMBER(15, 0)
PREVENTED_CONF _PATH_CNT : NUMEER(15, 0)
REJECTED_CONF_PATH_CNT : NUMBER(15, 0)
TOTAL_CONF_PATH_CNT : NUMBER(15, 0)
NUM_DAYS_OUTSTANDING : NUMBER(15, 0)

CONFLICT_GEN_FLAG : NUMBER(15, 0)
SRC_SYS_D : VARCHAR2(S)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_B'Y : NUMBER(15, 0)
LAST_UFDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

| <> GRI_F_CONFLICT_PATH_T_UA : RUN_SID, USI,_

Conflict Path Status

Policy Detail Star

1 |[@ GRID_POLICY retnnTs i

[E] GRED_TME_D

[ GRI_D_RUN

{3 ORIF_CONFLICT PATH_T_V

[l GRI_D_ENTITLEMENT

Logical and Physical Models

Latest Policy Run Flag
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[ p(GRI D POLICY DETAIL BG) jl.=_ BviGRI D POLICY WL}

GRI_D_POLICY_DETAIL_V

POLICY_SID(p POLICY_SID)
TIME _KE'Y (dl. TIME_KE')
ACCESS_POMT_SID(CASE VWHEN p DE|
= anl )
ENTTLEVENT SHERSE VHENSLCTA [ 2p(ORI D ACCESS PONT F  e(GRI D ENTITLEMENT AP BG)
DETAIL_TYPE{p.DETAIL_T'PE)
ENTITLEMENT_ACCESS_POINT _SID(NVL
ALL_ACCESS_POINT_SD(CASE WHEN
INSTANCE_SID(ap INSTANCE_SID)

[ d(GRCD TIME D)

£3] GRID_POLICY_INSTANCE FLAG_V [ GRID POLICY DETAL V

POLICY_SID
INSTANCE_COUNT{COUNT(INSTANCE_SID))

e Exclusions Star
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f GRI_D_EXCLUSION_V

Global Same Flag

= N ¥ "
=] GRI_D_EXCLUSION

| EXCLUSION_TYPE_SID : NUMBER(15, 0)
INSTANCE_SID : NUMBER(15, 0)
|POLICY _SID : NUMBER(15, 0)

GRID_GENERICDIM | " |SRC_SVS.ID: VARCHARZ(S) [ GRLA_LOOKUP
1 | SAME_FLAG_SID : NUMBER(15, 0)
|START_DATE : DATE Same Flag
1 1 |END_DATE : DATE

BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE
|CREATED B : NUMBER(15, 0)
LAST_LPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

&Kz GRI_D_EXCLUSION_U1 : EXCLUSION

[E GRLD_POLICY

[ GRI_D_GENERIC_DIM_VAL B GRI_D_EXCLUSION_DETAIL

+ |EXCLUSION_TYPE_SID : NUMBER(15, 0)
{INSTANCE_SID : NUMBER(15, 0)
|POLICY _SID : NUMBER(15, 0)
EXCLUSION_VALUE_SID : NUMBER(15, 0)
|SRC_SYS_ID : VARCHAR2(S)
START_DATE : DATE
END_DATE : DATE 1
BATCH_ID : NUMBER(15, 0}

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0) |
LAST_UPDATE_DATE : DATE
e A Lo LAST_LPDATED_BY : NUMBER(15, 0)
S ) LAST_UPDATE_LOGIN : NUMBER(15, 0)

1] GRI_D_INSTANCE

| EXCLUSION_TYPE_SID = -99 | <Uk» GRI_D_EXCLUSION_DETAIL_U1 : EX)

fd] CRI_D_EXCLUSION_DETAIL_V

[ GRI_D_ACCESS_POINT

EXCLUSION_TYPE_SID = -999

Exclusion can be User, Access Point
or Generic dimension value

e Path Exclusions Star

Logical and Physical Models C-17



GRI_D_ACCESS_POINT

[ GRI_D_ACCESS_POINT_FROM

(!

GRI_D_PATH_EXCLUSION
INSTANCE_SID : NUMBER(15, )
ACCESS_POINT_SID : NUMBER(15, 0)

| FROM_USER _SID : NUMBER(15, 0)

| FROM_ACCESS_POINT_SID : NUMBER(15, 0)
| SRC_SYS_ID : VARCHARZ(S)

| EXCLUSION_ACTION_SID : NUMBER{1S, 0) f
| EXCLUSION_STATUS_SID : NUMBER(15, 0)

| START_DATE : DATE

|END_DATE : DATE

| BATCH_ID : NUMBER(15, 0)

| CREATION_DATE : DATE

CREATED_BY : NUMBER(1S, 0)
|LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(1S, 0)

GRI_A_LOOKUP

Exclusion Action

alias of Access Point

GRI_D_APPS_USER [

GRCI - GRCM 7.8 Logical Model

e Assessments

Assessment hierarchy:
Assessment type -> Assessment
Title

Process hierarchy:
Process Type -> Process Title

Control hierarchy:
Control Class -> Control Title

e  Control Tests

GRILA_LOOKUP_EXCLUSION_STATUS

| Exclusion Status (alias of

| sUKz GRI_D_PATH_EXCLUSION_U1 : INSTAN
GRI_A_LOOKUPY)

[ GRI_D_INSTANCE

Assessments

Grain: Assessment, Period, Process, Conlrol,
Risk, Design Result, Operating Result

Time Series(YAgo, QAgo, MAga)..

Due Date
Completion Date
Current Assessment Flag
Design Result Date
Operating Result Date

Assessment Total Count
Certified Count

Design Effectiveness
Design Complete Count
Design Failed Count
Design Passed Gount
Total Design Count
Design Passed %
Design Failed %
Design Complete %

Operating Effectiveness
Operating Complete Count
Operating Failed Count
Operating Passed Count
Total Operating Count
Operating Passed %
Operating Failed %
Operating Complete %

Time hierarchy:
Year -> Quarter -> Month -> Day

QOrganization, Account, Cycle, &

Fourth Map hierarchies:
Level 1 -» Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level
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Process hierarchy:
Process Type -> Process Title

Control hierarchy:
Control Class -> Control Title

Issues

Issue hierarchy:
Issue Severity -> Issue Title

Process hierarchy:
Process Type - Pracess Title

Control hierarchy:
Control Class -> Control Title

Controls

Control Tests

Grain: Test, Test Pariod, Process, Control,

Result

Test Create Date
Test Result Date
Test Result
Current Flag

Total Test Count
Open Test Count
Closed Test Count

Failed Test Count
Validate Test Count
Active Test Count
Prepare Test Count
Completed Test Count

Open Test %
Closed Test %
Failed Test %
Validate Test %
Active Test %
Prepare Test %
Completed Test %

Total Control Count
Passed Control Count
Failed Control Count
Failed Control %
Passed Control %
Coverage

Time Series(YAgo, QAgo, MAgo)...

Issues

Grain: Process, Control, Risk, Assertion,
Issue

Issue Date
Due Date
Issue Severity
Issue Status
Assessment 1D
Test ID

Assessment Issue Count
Audit Test Issue Count
Process Test Issue Count

Control Issue Count
Process Issue Count
Risk lssue Count
Assertion Issue Count

Deficiency Count
Documentation Count
Material Weakness Count
Significant Deficiency Count
Total Issue Count

Time Series(YAgo, QAgo, MAga)...

Time hierarchy:
Year -> Quarter -> Month > Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1-> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level

{ } Issue Date

} Due Date

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level
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Issue hierarchy:
Issue Severity -> Issue Title

Process hierarchy:
Process Type -> Pracess Title

Control hierarchy:
Control Class -» Control Title

Risks

Issue hierarchy:
Issue Severity -> Issue Title

Process hierarchy:
Process Type -> Pracess Title

Control hierarchy:
Control Class -> Control Title

Action Items

Contrals

Grain: Process, Control

Monitoring Control Count
Key Contral Count
Secondary Control Count
Subordinate Contral Count

Preventive Cantrol Count
Detective Control Count
Caorreclive Control Count

Auto Monitoring Control Count
Manual Control Count
Automated Centrol Count

Multiple Control Count
Daily Control Count
Weekly Control Count
Biweekly Cantrol Count
Meonthly Control Count
Quarterly Contral Count
Annual Control Count
Other Frequency Control Count

% count of above metrics...

Time Series(YAgo, QAgo, MAga)...

Risks

Grain: Process, Risk, Control

Risk Rating
Risk Significance
Risk Likelihood
Risk Type

Time Series(YAgo, QAgo, MAga)...
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Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level

{ ;‘;1’; Create

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level



Action ltems

Action Item

Action Item Create Date
Action ltem Related Document

Action ltem Count
Action Item Process Count
Action Item Risk Count
Action Item Control Count
Action Item Assertion Count

Time Series(YAgo, QAgo, MAgo). .

Grain: Process, Control, Risk, Assertion,

Process hierarchy:
Process Type -= Praocess Title

Control hierarchy:
Control Class -» Control Title

Assertions

Assertions

Grain: Pracess, Assertion

Assertion Create Date
Assertion Count

Time Series(YAgo, QAgo, MAgo)...

Process hierarchy:
Process Type -» Pracess Title

Control hierarchy:
Control Class -> Control Title

Test Instructions

{ Action lte
Create Dal

Time hierarchy:
Year -> Quarter -> Month -> Day

Qrganization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level

{ Assertion
Create Date

Time hierarchy:
Year -> Quarter -> Month -> Day

QOrganization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level

Logical and Physical Models C-21



Test Instructions

Grain: Process, Contral, Test Instruction
Test Instruction Create Date

Test Instruction Count
Test Instruction Contral Count

Time Series(YAgo, QAgo, MAga)...

Process hierarchy:
Process Type - Process Title

Control hierarchy:
Control Class -> Control Title

e Test Plans

Test Plans

Grain: Process, Control, Test Plan

Test Plan Count
Test Plan Control Count

Process hierarchy:
Process Type -> Process Title

Control hierarchy:
Control Class -> Control Title

GRCI - GRCM 7.8 Physical Model

e Account
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{ Tast Instruction
Create Date

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Lavel

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level



= GRCD_ACCOUNT D

ACCOUNT_LVLY - NUMBER = CROCESACOOLNTIMAL
ACCOUNT_LYVL2 : NUMBER PROCESSID : NUMBER
ACCOUNT_LYVL3 : NUMBER .| ACCOUNTMAPID : NUMBER

ACCOUNT_LYL4 : NUMBER

ACCOUNT_LYVLS : NUMBER 1
LEAF_ACCOUNT_ID : NUMBER
ACCOUNTPATH : NVARCHARZ(1024)
PARENTID : NUMBER

MAPID : HUMBER

| «UK» GRCD_ACCOUNT _D_UK1 - LEAF AL

1

i GRCD_ACCOUNT_TL

ACCOUNT_ID : NUMBER

| LANGUAGE : NVARCHARZ(10)

| SOURCE_LANG : NYARCHARZ({10)
LOCALE : NVARCHARZ{10)
DESCRIPTION : MY ARCHARZ(240)

Cycle

Logical and Physical Models
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= GRCD_CYCLE D ] PROCESSFINANCIALMAP

CYCLE_LWLY : NUMBER(10, 0) PROCESSID : NUMBER(10, 0)
CYCLE_LWLZ : NUMBER(10, O) FINANCIALMAPID - NUMBER(10, O)
CYCLE_LWL3 : NUMBER(10, 0

CYCLE_LWL4 : NUMBER(10, 0

CYCLE_LWLS : NUMBER(10, ) 1

LEAF_CYCLE_ID : NUMBER{10, 0)

CYCLEPATH : NWARCHAR2(1024)

PARENTID : NUMBER{10, 0)

MAPID : NUMBER(10, 0)

| «UKs GRCD_CYCLE_D_UK1 : LEAF_CYeL|

| GRCD_CYCLE_TL

CYCLE_ID : NUMBER(10, O)
LANGUAGE : MYVARCHARZ(10)
SOURCE_LANG : NVARCHARZ(10)
LOCALE : NWVARCHARZ(10)
DESCRIPTION : NV ARCHARZ(240)

e Fourth Map
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B GRCD_FMAP_D |  PROCESSFOURTHMAP

FMAP_LWL1 : NUMBER(10, 0) PROCESSID : NUMBER
FMAP_LWL2 : NUMBER(10, 0) FOURTHMAPID : NUMBER
FMAP_LWL3 : MUMBER(10, 0)

FMAP_LWLA : NUMBER(10, 0)

FMAP_LWLS : NUMBER(10, 0) "

LEAF_FMAP_ID ; NUMBER(10, 0) 1 '

FMAPPATH : NVARCHAR2(1024)

PARENTID : NUMBER(10, O)

MAPID : NUMBER(10, 0)

[ ez GRCD_FMAP_D_UK1 : LEAF_FMAP_|

B GRCD_FMAP_TL

FrAP_ID - MUMBER

LAMGUAGE : NWVARCHARZ2(10)
SOURCE_LANG : NWARCHARZ(10)
LOCALE : NWARCHARZ(10)
DESCRIPTION : NV ARCHARZ(240)

¢ Organization

Logical and Physical Models C-25



] GRCD_ORGANIZATION D 5] PROCESSORGANIZATIONMAP

ORGAMZATION_LVLT : NUMBER(10, O} PROCESSID : NUMBER(10, O}
ORGAMZATION_LVLZ : NUMBER(10, O} ORGANZATIONMAPID : MUMBER(10, 0)
ORGAMZATION_LWLS : NUMBER(10, O}
ORGAMIZATION_LVL4 : NUMBER(10, O}
ORGAMZATION_LVLS : NUMBER(10,0) |
LEAF_ORGANIZATION_ID : NUMBER(10, 07 1
ORGAMIZATIONPATH: NVARCHARZ(1024]
PAREMTID : MUMBER(10, 0}

[elKs GRCD_ORGAMZATION D_UK1 : LES

=

[i] GRCD_ORGANIZATION_TL

ORGANIZATION_ID : NUMBER{10, 0)
LANGUAGE : NVARCHAR2(10)
SOURCE_LANG : NYARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(240)

e  Process

C-26 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



= PROCESS

1D : NUMBER(10, 0}

DID : NUMBER(10, 03

DDOCNAME : NV ARCHAR2(30)

TITLE : MYVARCHAR2(255)

REVISION : NUMBER(10, 0)

STATE : NVARCHARZ(30)

PROCESSCIWNER : NV ARCHARZ(100)
PROCESSCVWNERUSERMAME : NYVARCHAR2(10(0
TESTOWNER : NWARCHAR2(100)
TESTOWNERUSERNAME : NVARCHARZ{100)
DEPARTMENTAPPROVER : NVARCHARZ{100)
DEPARTMENT APPROVERUSERMAME : NV ARCH)
PROJECTAPPROVER : NV ARCHARZ(100)

PROJECTAPPROYVERUSERMNAME : NVARCHARZ(|

FINANCEAPPROVER : NVARCHARZ(100)
FINANCEAPPROVERUSERMAME : MYV ARCHARZ("
MAREVIEWER : NV ARCHARZ(100)
MAREVIEWERUSERNAME : N'VARCHARZ{100)
MAEXECUTIVEREVIEWER : NVARCHAR2{100)
MAEXECUTIVEREYIEWERUSERMAME : NV ARCH!
COSOCOMPONENT : NYVARCHARZ(30)
COSOCATEGORY : NVARCHAR2(30)
XSYSTEMTYPE : NVARCHAR2(30)
¥SYSTEMSUBTYPE : NVARCHAR2(30)
PROCESSTYPEID : NUMBER(10, 0)
PROCESSCOMPLEXITYID : NUMBER(10, 0)
DOCLEVELID : NUMBER(10, O)

DESCRIPTION : MYARCHARZ(1024)
CREATEDATE : TIMESTAMP(E)

REVISIONDATE : TIMESTAMP(E)

XSOAICPATH : NVARCHARZ(1024)
XSOAACCTCYCLE : NVARCHARZ(1024)
XSOAFINSTMTCAP : NVARCHAR2(1024)
HSOAMAPADATA : NVARCHARZ(1024)

| PHs PI_PROCESS : ID

£ GRCD_PROCESS_V

a CREATEDATE

a DDOCNAME F
a DEPARTMEMTAPPROVER

a DEPARTMENTAPPROVERUSERI
a DESCRIPTION

abiD

cLOCALE

a DOCLEVELID

DocLevel(e. DESCRIPTION)

a FINANCEAPPROVER

a FINANCEAPPROVERUSERNAME
alD =
aMAEXECUTIVEREVIEWER

a MAEXECUTIVEREVIEWERUSERI

a MAREVIEWER

a MAREVIEWWERLUSERMAME

a PROCESSCOMPLEXITYID
ProcessComplexity(c DESCRIPTIC

a PROCESSOWNER

a PROCESSOWMERUSERMAME
aPROCESSTYPEID

ProcessType(d. DESCRIPTION)
aPROJECTAPPROVER

a PROJECTAPPROVERUSERMAM

a REVISION

a REVISIONDATE

asTATE

a TESTOWNER

a TESTOWNERUSERMAME

URL("=a href=""|| b.URL || 'MaviRe
aTITLE

a XSOAACCTCYCLE

a XSOAFINSTMTCAP

a XSOAICPATH

Risk

alPROCESS)

&= PROCESSTYPE_TL

PROCESSTYPE_ID : NUMBER(10, 0)
LANGUAGE : NYARCHARZ(10)
SOURCE_LANG : NVARCHAR2(10)

~ 3 LOCALE : NWYARCHAR2({10)

DESCRIPTION : MY ARCHAR2(500)

il COMPLEXITYTYPE_TL

COMPLEXITYTYPE_ID : NUMBER(10, 0)

LANGUAGE : NVARCHARZ(10)
SOURCE_LANG : NVARCHARZ(10)
LOCALE : NVARCHAR2{10)
DESCRIPTION : N ARCHAR2(500)

c{COMPLEXITYTYPE TL E.:

== ﬁ d(PROCESSTYPE TL

2

e(DOCLEVELTYPE TL

= DOCLEVELTYPE_TL
DOCLEVELTYPE_ID : NUMBER(10, 0)
LANGUAGE : NYARCHAR2(10)
SOURCE_LANG : NVARCHAR2(10)
LOCALE : NYARCHAR2(10)

_ _ | DESCRIPTION : NV ARCHAR2(500)

|[Ff] GRCD_SERVERURL

URL : VARCHARZ(100)
TYPE : VARCHARZ2(100)

b{GRCD SERVERURL)

Logical and Physical Models
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[i] RISK

[ CONTROLRISKS D~ NUVBER(10, 0}

CONTROLID : NUMBER , |DID: NUMBER(10, 0)
RISKID : NUMBER L DDOCNAME: NVARCHAR2(30)
" TITLE : NVARCHAR2(255)

REVISION : NUWBER(10, 0)
STATE : NVARCHAR2(30)
RISKSIGNIFICANCEID : NUMBER(10, 0)
RISKLIKELIHOODID : NUMEER(10, 0)
RISKCRITICALITY : NUMBER(10, 0)
5 PROCESSRISKS RISKRATING : NUMBER(10, 0)
RISKTYPEID : NUMBER(10, 0)
PROCESSID : NUMBER(10, 0)
RISKID : NUMBER(10, 0) b CREATEDATE : TIMESTAMP(E)
REVISIONDATE : TMESTAMP(5)
XSYSTEMTYPE : NVARCHAR2(30)
XSYSTEMSUBTYPE : NVARCHAR2(30)
XSOAPARENTID : NVARCHAR2(30)
XSOAPARENTSTARTREVID : NUMBER(10,
SOAPARENTENDREYID : NUMBER(10, 0)
] RISHASSERTIONS XSOARELATEDDOCREVID : NVARCHARZ(

RISHKID : NUMBER
ASSERTIONID : NUMBER «PHs PK_RISK : D

B GRCD_RISK_V

2.CREATEDATE
2 DDOCNAME

aDESCRPTION

aDp

alp

aREVISION

aREVISIONDATE

cLOCALE

2 RISKLIKELIHOODID
RiskLikeihood(c DESCRIPTION)
2RISKRATING

2 RISKSIGNIFICANCED
RiskSignificance(d DESCRIPTION)
aRISKCRITICALITY

2 RISKTYPED

RiskType(e DESCRIPTION)
aSTATE

URL(<a href=" | b.URL || ‘Nav/Red
aTiTLE

a.XSOAPARENTENDREVID

a XSOAPARENTD

a XSOAPARENTSTARTREVID
a.XSOARELATEDDOCREVID

e Control

7]  RISKPROBABILITYTYPE_TL

RISKPROBABILITYTYPE_ID : NUMBER{(10, | RISKTYPE_ID : NUMBER(10, 0)
LANGUAGE : NVARCHARZ(10)
SOURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(500)

DESCRIPTION : NYVARCHAR2(1024) -,

[ a(RISK)

L

B S(RISKTYPE TL)

[=] RISKTYPE_TL

LANGUAGE : NVARCHARI(10)

SOURCE_LANG : NVARCHARZ2(10)
~ ~ -|LOCALE: NVARCHAR2(10)

DESCRIPTION : NVARCHAR2(500)

[0  RISKEXPOSURETYPE_TL

RISKEXPOSURETYPE_ID : NUMBER(10, 0)
LANGUAGE : NV ARCHAR2({10)
SOURCE_LANG : NVARCHAR2(10)
"""" LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(500)

[ GRCD_SERVERURL

URL : VARCHAR2(100)
el TYPE: VARCHARZ2(100) | Np——

5] CIRISKPROBABLITYTYPE TL)

PS5  bIGRCD SERVERURL) =

~—----3 dRISKEXPOSURETYPE TL)
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] GRCD_SCOPED_CONTROLS

SCOPEPLANID : NUMBER(10, 0)
CONTROLID : NUMBER(10, 0)
PLAND : NUMBER(10, 0)
DDOCHANE : NVARCHAR2(30)
DID: NUMBER(10, 0)

[=] CONTROL

1D - NUVBER(10, 0)
DID - NUMBER(10, D)
DDOCNAME : NVARCHAR2(30)
TITLE : NVARCHAR2(255)
REVISION : NUMBER(10, 0)

] CONTROLTYPE_TL

CONTROLTYPE _ID : NUMBER(10, 0)
LANGUAGE : NYARCHAR2(10)
SOURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(500)

[ CONTROLMETHODTYPE_TL

CONTROLMETHODTYPE_ID : NUMBER(10,
LANGUAGE : NVARCHAR2(10)
SGURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(S00)

[ COMPLEXTYTYPETL

COMPLEXITYTYPE_ID : NUMBER(10, 0)
LANGUAGE : NYARCHAR2(10)
SOURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(500)

INSCOPE : VARCHAR2(30) v
DATELPDATED : DATE

STATE | NVARCHAR2(30)
COSOCOMPONENT : NVARCHAR2(30)
COSOCATEGORY : NYARCHAR2(30)
PICs PK_GRCD_SCOPED_CONTROLS : € KEYCONTROL : NVARCHAR2(30) x w x
CONTROLCLASS : NVARCHAR2(30) !
CONTROLSUBCLASS : NVARCHAR2(30) |
CONTROLTYPEID : NUMBER(10, 0) i
CONTROLMETHODID : NUMBER(30, 0) I
AUDITTYPE : NVARCHAR2(30) !
CONTROLFREQUENCY : NV ARCHAR2(30) i

[l GRCD_SERVERURL !
TARGETSAMPLESIZE : NVARCHAR2(30) |

] MATURITYTYPE_TL !
| URL : VARCHAR2(100)

MATURITYTYPE_ID : NUMBER(10,0)

] CONTROLRISKS MATURITYASISID : NUMEER(30, 0) LANGUAGE : NVARCHAR2(10) TYPE: VARCHAR2(100)
CONTROLID MBI 1 | MATURITYTARGETID : NUMBER(30, 0) SOURCE_LANG : NVARCHAR2(10)
RISKED < NMBER | COMPLEXITYID : NUMBER(30, 0} LOCALE NVARCHAR2(10)

DESCRIPTION : NVARCHAR2(1024)
CREATEDATE : TMESTANP(S)
REVISIONDATE : TIMESTAMP(8)
RELEASEDATE : TMESTAMP(8)
¥SYSTEMTYPE : NVARCHAR2(30)
XSYSTEMSUBTYPE : NVARCHAR2(30)
XSOAPARENTID : N\VVARCHAR2(30)
XSOAPARENTSTARTREVID : NUMBER(10, 0)
¥SOAPARENTENDREVD : NUMBER(10, 0)
¥SOARELATEDDOCREVID : NVARCHAR2(100) 1
¥SOARELATEDCONTROLDOCREVID : NVARCHA 1
¥SOACONTROLOBJECTIVE : NVARCHAR2(100),

DESCRIPTICN : NVARCHAR2(500)

SR |

<PK PI_CONTROL : ID

2 COMPLEXITYID

Complexity Type(c DESCRPTION)

a.CONTROLCLASS

2.CONTROLFREQUENCY

2.CONTROLMETHODID

ContralMethodType(c. DESCRPTION

2.CONTROLSUBCLASS

a.CONTROLTYPED

ControlType(e.DESCRIPTION) f8  aMATURTVIYPE 1Ly

2.COSOCATEGORY

2.COSOCOHPORENT

a/CREATEDATE

aDDOCHAVE

aDESCRRTION

oD

)

alEYCONTROL

AMATURITYASISD

MaturityBsisType(f DESCRIPTION)

MATURITYTARGETID

MaturityTargelType(g DESCRPTION

aREVISION

aREVISICHDATE

2 RELEASEDATE

aSTATE

aTARGETSANPLESIZE

URL(<a href=" | b.URL | ‘NaviReq

ammie

*SOACortrolObjective(REPLACE(E

CompletenessOBFIaGICASE WHE

AccuracyOFISQICASE VIHENIN

ValdtyObFlag(CASE WHEN IIST

TinelnessObFlag(CASE WHEN I
curtyObFlag(CASE WHEN INS

2 XSOAPARENTENDREVID

2 XSOAPARENTID

2 XSOAPARENTSTARTREVID

2 XSOARELATEDCONTROLDOCRE

aXSOARELATEDDOCREVID

x |
{3 GRCD_CONTROL V : L ! : ! !
8 AUDITTYPE | | |
cLOCALE 9 stcontRoL) T e(CONTROLTYPE TL) ] [ d(CONTROLMETHODTYPE TL)

5 C(COMPLEXITYTYPE L)

HIMATURITYTYPE TLY = 51 biBRCD SERVERURL)

e  Control Test
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[ GRCD_CONTROL_TEST D [F] GRCD_SERVERURL

ID - NUMBER{10, 0) URL : WVARCHAR2(100)
TEST_ID : NUMBER(10, 0} TYPE : WVARCHARZ2(100) k- ___ )
D_ID: NUMBER(10, D) |
D_DOC_NAME : NV ARCHARZ(30) | |
D_DOC_TYPE : NWARCHAR2(30)
CONTROL _TEST_TYPE : NVARCHAR2(10)
CREATE_DATE : TMESTAMP(E)
CURRENT _\WF_USER : N\ ARCHAR2(100)
CURRENT _\WF_USER_NAME : NV ARCHAR|
PROCESS_ID : NUMBER(10, D)
REVISION_ID : NUMBER(10, 0)
REVISION_DATE : TIMESTAMP(E)

STATE | NVARCHAR2({30)

STATUS : NVARCHARZ(20)

TEST_PERIOD : NWARCHARZ(30) | R S e SN P PO N Y L RO : |
TITLE : NVARCHAR2(255) | |
DESCRIPTION : N'ARCHAR2(1024) ! !
CONTROLTYPE : NvARCHAR2(30) 1 |
TEST_OVWNER : NV ARCHAR2(100)
TEST_OVWNER_USER_NAME : NV ARCHAR|

TEST_TYPE : NVARCHAR2(30) £ GRCD_CONTROL_TEST_V .
TEMPLATE_CONTROL_DOC_IDS : NVARCH ! !
COMTROL_DOC_IDS : NVARCHAR2(1024)| alb i
SOURCE_ID : VARCHAR2(10) a.;EISDT_ID |
3 al ]

CRESTION DRI THESTAMRLE) 2DDOC_NANME FS  a(GRCD CONTROL TEST D) |
CREATED_BY : VARCHAR2(50) DEUGGEN,) w i
LAST_UPDATE_DATE : TIMESTAMP(E) aD_DOc.TYPE i
LAST_UPDATED_BY : VARCHAR2(50) a CONTROL_TEST_T'PE |
LAST_UPDATE_LOGIN : VARCHAR2{50) a.CREATE_DATE !

a CURRENT WF_USER L
«PHs PK_CONTROLTESTD : ID a CURRENT _WF_USER_NAME f

aPROCESS_D |

a REVISION_D L

a REVISION_DATE

a.STATE

Serare S b(GRCD SERVERURL)

a.TEST_PERIOD

a.TITLE

a DESCRIPTION

a CONTROLTYPE

a.TEST_OWNER
a.TEST_OWNER_USER _NAME
a.TEST_TYPE

a. TEMPLATE_CONTROL_DOC_IDS
a.CONTROL_DOC_IDS
a.SOURCE_ID

a.CREATION_DATE
a.CREATED_BY

a LAST_UPDATE_DATE

a LAST_UPDATED_BY

a LAST_UPDATE_LOGIN

URL{'=a href="" || b URL || '"Mav/Redirect i

e Assessment
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(53] ASSESSMENT

D : NUMBER(10, 0)
DID : NUMBER

DDOCHAME : NV ARCHAR2(30)

DSTATUS : NV ARCHAR2(20)

CURREMTWFUSER : NVARCHAR2(100)
CURREMTWFUSERNAME : NV ARCHARZ(100)

TITLE : NVARCHAR2(255)

REVISION : NUMBER(10, 0)

STATE: NYARCHAR2(30)

PERCENTCOMPLETE : NVARCHAR2{30)

TESTPERICD : NVARCHAR2(30)

PROCESSCWNER : NVARCHAR2(100)
PROCESSCWMERUSERNAME : NV ARCHAR2(100)
REVIEWER : NVARCHAR2(100)

REVIEWERUSERNAME : NWARCHARZ(100)
EXECUTIVEREVIEWER : NV ARCHAR2(100)
EXECUTIVEREVIEWERUSERNAME : N ARCHAR2(100)
PROCESSCOWNERCERTQUESTION : N ARCHAR2(1024)
PROCESSCVWNERCERTANSWWER : NVARCHAR2(30)
PROCESSCWNERCOMMENTS : NVARCHAR2(1024)
REVIEAERCERTIFICATIONQUESTION : NYARCHAR2(1024)
REVIEAERCERTIFICATIONANSWER : NYVARCHARZ(30)
REVIEAERCOMMENTS : NVARCHAR2(1024)
EXECUTIVEREVIEWERCERTQUESTION : NYARCHAR2(1024)
EXECUTIVEREVIEWERCERTANSWER : NVARCHAR2(30)
EXECUTIVEREVIEWERCOMMENTS : NVARCHAR2(1024)
DUEDATE : TMESTAMP(E)

SURVEYCOMPLETE : NVARCHAR2(30)

DESCRIPTION : N\ ARCHAR2{1024)

CREATEDATE : TIMESTAMP(E)

REVISIONDATE : TMESTAMP(E)

¥SOARELATEDDOCID : NV ARCHAR2(100)
OARELATEDDOCSTARTREVID : NVARCHARZ2(30)
OARELATEDDOCENDREYID : NVARCHARZ2(30)
¥SOAMAREGCONTROLDOCREYIDS : NV ARCHARZ2(1024)
¥SOAMACPTCONTROLDOCREVIDS : NYARCHAR2(1024)
¥SOAMARISKDOCREVIDS : NYARCHAR2(1024)
¥SOAMATYPE : NVARCHAR2(100)

«PHz PK_ASSESSMENT : ID

Issue

[l GRCD_SERVERURL

URL : WARCHAR2(100)
TYPE: VARCHAR2(100)

=] GRCD_ASSESSMENT_V

|aCREATEDATE

a.DDOCHAME

a.DESCRIPTION

aDD

a DUEDATE

a EXECUTIVEREVIEWER

a EXECUTIVEREVIEWERUSERNAME

a EXECUTIVEREVIEWERCERTANSWER
a EXECUTIVEREVIEWERCERTQUESTION
a EXECUTIVEREYIEWERCOMMENTS
alD

a.PERCENTCOMPLETE
aPROCESSCVWNER

a PROCESSCVWNERUSERNAME

a PROCESSCWMERCERTANSWER

a PROCESSOWNERCERTQUESTION

a PROCESSOWNERCOMMENTS
aREVIEVER

a REVIBWERUSERNAME

a REVIBWVERCERTIFICATIONANSIWER
aREVIEWERCERTIFICATIONQUESTION
aREVIEAVERCOMMENTS

aREVISION

aREVISIONDATE

a STATE

a SURVEYCOMPLETE

a TESTPERICD

URL('<a href="| bURL || 'NaviRedirect aspx?
aTITLE

a.CURREMTWFUSER
a.CURRENTWFUSERMAME

aDSTATUS
a.XSOAMAOPTCOMTROLDOCREYIDS
a.XSOAMAREQCONTROLDOCREVIDS
a XSOAMARISKDOCREVIDS
xsoamatype(REPLACE(XSOAMATYPE, 1, 1))
OperationalTypeAssessmentFlag{CASE WHE

DesignTypeAssessmentFlag{CASE WHEN IN

SurveyTypeAssessmertFlag(CASE WHEN I
a.XSOARELATEDDOCENDREVID
a.XSOARELATEDDOCID
a.XSOARELATEDDOCSTARTREVID

[ a(ASSESSMENT

3|.=_ B(GRCD SERVERURL

Logical and Physical Models
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[&E] ISSUE [] ISSUESEVERITYTYPE_TL ISSUETYPE_TL

D : NUMBER ISSUESEVERITYTYPE_ID : NUMBER(10, 0 ISSUETYPE_ID : NUMBER(10, 0)
DID : NUMBER LANGUAGE : NVARCHAR2(10) LANGUAGE : NV ARCHAR2{10}
DDOCNAME : NVARCHAR2(30) SOURCE_LANG : NVARCHAR2(10) SOURCE_LANG : NVARCHAR2(10)
TITLE : NVARCHAR2(255) LOCALE : NVARCHAR2(10) LOCALE : NVARCHAR2(10)
REWVISION : NUMBER DESCRIPTION : NVARCHAR2(500) DESCRIPTION : NV ARCHARZ(500)

STATE : NVARCHAR2(30)
SEVERITYID : NUMEER(10, 0)
ISSUETYPEID : NUMBER(10, 0)
RECQUIRESREMEDIATICN : Ny ARCHAR2(30) x x

ORIGINATOR : NVARCHAR2(100) i i E GRCD_SERVERURL
ISSUECRIGINATORUSERNAME : NYARCHARZ| i i =

EXPECTEDCOMPLETIONDATE : TIMESTAMP(S] | | URL : VARCHAR2(100)
PLANDESCRIPTION | NVARCHAR2(100) /€ — — — — = — = = == = — = = = = = = — = — — — | TYPE: VARCHAR2(100)
DESCRIPTION : NVARCHAR2(1024) I I
CREATEDATE : TIMESTAMP(E) i
REVISIONDATE : TIMESTAMP(E) |

¥SOARELATEDDOCID : NVARCHAR2(100) s
¥SOARELATEDDOCSTARTREVID : NUMBER(1 ! ! |
¥SOARELATEDDOCENDREVID : NUMBER(10, i 1 i |
¥SOAADDLRELATEDDOCID : NYARCHAR2(3! I | I !
¥SOAADDLRELATEDDOCSTARTREVID : NUM ! l ! f
¥SOAADDLRELATEDDOCENDREVID : NUMBE ; + ; T
XSOAROOTID | NVARCHAR2(30) 2 GRCD_SSUE_V 1 i
aPIs PK_ISSUE . D il | - : !
aDESCRIPTION i
2D | aissue [ CUSSUETYPE L) |
aEXPECTEDCOMPLETIONDATE | !
alD | ;
dLOCALE L |
aISSUETYPED 5 I
IssueType(c DESCRIPTION) |
a.ORIGINATOR i !
aISSUEORIGINATORUSERNANE i |
2 PLANDESCRIPTION i i
5 REQLIRESREMEDIATION |
aREVISION !
aREVISIONDATE ;
2 SEVERITYID ! [ BICROD SERVERURL)
IssueSeverity(d DESCRIPTION) - - -|fF QOSSUESEVERYTYPE TL)

| b URL | 'Nav/Redirect

a.XSOAADDLRELATEDDOCENDREVID
aXSOAADDLRELATEDDOCID
a.XSOAADDLRELATEDDOCSTARTREY
a.XSOARELATEDDOCENDREVID

a ¥SOARELATEDDOCID

a XSOARELATEDDOCSTARTREVID

e Time
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& GRCD_TIME_D

TIME_KEY : NUMBER(30, 0
CREATE_DT : DATE

TIME_DT : DATE

DAY_NAME : NV ARCHAR2(30)
DAY _NER : HUMBER
LAST_UPDATE_DT : DATE
LAST_DAY _IN_MTH_IND : NvARCHAR2(1'
MTH_NAME : Ny ARCHAR2(30)
MTH_NBR : NUMBER

QTR_NAME : N\ ARCHAR2(30)
QTR_NBR : NUMBER

YR_MTH : NUMBER

¥R_MBR ; MUMBER

WK_END_DT : DATE
VWK_START_DT : DATE

WK_NBR : NUMBER
DAY_NER_OVERALL : NUMBER
DAY _OF WK : NUMBER
HOLIDAY_IND : NVARCHAR2(1)
VWKDAY _IND : MVARCHAR2(1)
DAY_ABBREY : NV ARCHAR2(30)
MTH_NBR_OVERALL : NUMBER
MTH_ABBREY : NV ARCHAR2(30)
YR_QTR ; MUMBER
WHK_NBR_OVERALL : NUMBER
QTR_NBR_OVERALL : NUMBER

| «UK» GRCD_TIME_D_UK1 : TIME_KEY

«UKz GRCD_TIME_D_UKZ : TIME_DT

iz GRCD_PERIOD_D

PERIOD _NAME : NYARCHARZ(50)
PERIOD_DISPLAY | NVARCHARZ(S0)
START_DATE : TIMESTAMPYG)
EMND_DATE : TIMESTAMP(E)

| aUkce GRCD_PERIOD_D_UK1 : PERIOD _NA

Action Item

| GRCD_TIME_TL

TIME_KE : NUMBER(30, 0)
LANGUAGE : VARCHAR2(10)
SOURCE_LANG : VARCHAR2(10)
LOCALE . VARCHAR2(10)

DAY _NAME : NVARCHAR2(30)

LAST_DAY_IN_MTH_IND : NY ARCHAR2(11

TTH_NAME : NV ARCHARZ2(:30)
" QTR_NAME : MY ARCHARZ(30)

K HOLIDAY _ND - NWVARCHAR2(10)

WKDAY _IND : NVARCHAR2(10)

DAY _ABBREY : MYVARCHARZ{30)

WMTH_ABEREY : N ARCHARZ2{30)

| SR

«FK» GRCD_TIME_TL_GRCD_TIME_D_FK1

=20 GRCD_TIME_VL

BASE TIME_KEY =
TL LANGUAGE

TL SOURCE_LANG

TL LOCALE
BASE.CREATE_DT

BASE TIME_DT

TL DAY _NAME

BASE DAY _NBR
BASELAST_UPDATE_DT
TLLAST_DAY _IN_MTH_IND
TL MTH_NAME

BASE MTH_NBR =
TL QTR_NAME
BASE.QTR_MNER
BASE.YR_MTH
BASE.YR_NBR

BASE WK_END_DT

BASE WK_START_DT
BASE WHK_MBR

BASE DAY _NBR_OVERALL
BASE DAY _OF WK

TL HOLIDAY _IND
TLMKDAY_IND

TL DAY_ABBREY

BASE MTH_NER_OVERALL
TL MTH_ABBREY
BASE.YR_GTR

BASE WK_NBR_OVERALL
BASE.QTR_NBR_OVERALL

Logical and Physical Models
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] ACTIONITEM [Ff] GRCD_SERVERURL

ID - NUMBER URL : WVARCHARZ2(100)
DD : NUMBER TYPE : WARCHARZ(100)
DDOCMAME : NVARCHAR2(30)

TITLE : MWARCHARZ(255)

REWISION : NUMBER

STATE : MVARCHAR2(30) *

ASSIGNEDTO : NWVARCHARZ2(100)
ASSIGNEDTOUSERMAME : NWVARCHAR2(100) & - — — — — — — — — — — — — — b — — —
DESCRIFTION : NV ARCHARZ(1024) !
CREATEDATE : TIMESTAMP(E) !

) |
«PKz PK_ACTIOMTEM : ID |

fa3)  GRCD_ACTIONITEM_Y |
alb |
a.DID |
a.DDOCMNAME
a.TITLE
| H

a REVISION E‘= alACTIOMNITEM)
a.STATE |

a. ASSIGNEDTO i

a ASSIGNEDTOUSERMAME
a DESCRIPTION

a.CREATEDATE

a REVISIONDATE

a DUEDATE [ h(GRCD SERVERURL)
a DDOCAUTHOR e

a DRELEASEDATE
a LASTMODIFIEDBY
a.¥SOARELATEDDOCID
a.¥SOARELATEDDOCSTARTREVID
a.¥SOARELATEDDOCENDREYID
a.450AADDLRELATEDDOCID
a.¥S0AADDLRELATEDDOCSTARTRE
a.¥S0AADDLRELATEDDOCENDREVIL
URL("<a href=" || b.URL || 'Nav/Redire

e Assertion
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5] ASSERTION = RISKASSERTIONS [F] GRCD_SERVERURL

D : NUMBER RISKID : NUMBER URL : YARCHAR2(100)
DID : NUMBER = | ASSERTIONID : NUMBER TYPE : WARCHAR2(100)
DDOCNAME : NVARCHAR2(30) T

TITLE : NVARCHAR2(255)

REVISION : NUMBER(10, 0)

STATE : NVARCHAR2(30) L
DESCRIPTION : NyARCHAR2(1024)
CREATEDATE : TIMESTAMP(E) |
REVISIONDATE : TMESTAMP(E) I
FSYSTEMTYPE | NvARCHAR2(30) | e e e !
¥SYSTEMSUBTYPE : N\ARCHAR2(30)

¥SOAPARENTID : NV ARCHAR2(30)

¥SOAPARENTSTARTREVID : NUMBER(10,

«PKz PK_ASSERTION ;. ID | :

[l GRCD_ASSERTION_W

|a.CREATEDATE
a.DDOCNAME
a.TITLE
|aDiD
alb
|a.REVISION
|a.REVISIONDATE
|a.DESCRIPTION
a.XSYSTEMTYPE
3. XSYSTEMSUBTYPE
|2 XSOAPARENTID
|a.XS0APARENTSTARTREVID
a. XS0OAPARENTENDREVID
a.STATE
URL('=a href=""|| b.URL || 'Mav/Redirec

?:: h(GRCD SERVERLUEL)

e E alASSERTIOM)

e Test Instruction
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[  GRCD_TEST_INSTRUCTION_D [ CONTROLTESTNSTRUCTION [  TESTINSTRUCTIONTYPE_TL [  CONTROLMETHODTYPE_TL

D : NUMBER(10, 0) PROCESSID : NUMBER(10, 0) TESTINSTRUCTIONTYPE 1D : NUMEER(10, CONTROLMETHODTYPE ID : NUMBER(10,

DID : NUMBER(10, 0) CONTROLID : NUMBER(10, 0) LANGUAGE : NVARCHAR2(10) LANGUAGE : NVARCHAR2(10)

DDOCNAME : N'VARCHAR2(30) * | TESTINSTRUCTIONID : NUMBER(10, 0) SOURCE_LANG : NVARCHAR2(10) 'SOURCE_LANG : NWARCHAR2(10)

DSTATUS : NVARCHAR2(20) 3 CREATEDATE : TMESTAMP(G) LOCALE : NVARCHAR2(10) LOCALE : NVARCHAR2(10)

TITLE : NVARCHAR2(255) DESCRIPTION : NV ARCHAR2(500) DESCRIPTION : NVARCHAR2(500)

REVISION : NUMBER(10, 0) «PKs PK_CONTROLTESTNSTRUCTION : PF

STATE : NVARCHAR2{30,

TESTISTRUCTIONTYPEID : NUMBER(10, 0)

TESTISTRUCTIONAPPROACHD : NUMBER(1( * * [ GRCD SERVERLAL
DESCRIPTION : NYARCHAR2(1024) i -
COMVENTS : NVARCHAR2(1024) | \ AL VARGHARZ(TI0)
INSTRUCTIONS : NVARCHAR2(255) i i TYPE : VARCHAR2(100)

SUCCESSDESCRIPTION : NVARCHAR2(255)

CREATEDATE : TIMESTAMP(5)

REVISIONDATE : TIMESTAMP() ;

SOURCE 1D : VARCHAR2(10) | !

CREATION_DATE : TMESTAMP(6) i !

CREATED_BY : VARCHAR2(50) i

LAST_UPDATE_DATE : TIMESTAMP(S)

LAST_UPDATED_B : VARCHARZ(50)

LAST_UPDATE_[OGIN | VARCHAR2(50) &) GRCD_TEST_NSTRUCTION -
[z

S(GRCD TEST INSTRUCTION D)
<PK> PIi_GRCD_TEST_INSTRUCTION D : D 4. ‘;D
a
bLOCALE
2DDOCNAME
aDSTATUS I
aTITLE I
aREVISION | [ (CONTROLMETHODTYPE TL)
aSTATE i
aTESTINSTRUCTIONTYPED
TestinstructionType(b DESCRIPTION) |
. TESTINSTRUCTIONAPPROACHID |
TestinstructionApproach(c DESCRIPTION) i
2DESCRIPTION
o COMMENTS [F  bUESTNSTRUCTIONTYPE TL) !
alNSTRUCTIONS I
2 SUCCESSDESCRIPTION |
a.CREATEDATE
aREVISIONDATE
URL{"<a href=" | d URL || 'NavRedirect asy
2.SOURCE_D
2. CREATION_DATE
aCREATED_BY
aLAST_UPDATE_DATE
2l AST_UPDATED_BY
aLAST_UPDATE_LOGIN

d(GRCD SERVERURL

kil

e TestPlan
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i GRCD_TESTPLAN_D

D : NUMBER(10, 0)

DID : NUMBER(10, 0)

DDOCNAME : NVARCHAR2(255)

TITLE : NVARCHAR2(255)

STATE | NVARCHAR2(255)
TESTPLANGWNER : N\VARCHAR2(100)
TESTPLANCWNERUSERNAME : N\ ARCHA
TESTER : NVARCHAR2(100)
TESTERUSERNAME : NVARCHAR2(100)
DESCRIPTION : NVARCHAR2(255)

SOURCE_ID : WARCHAR2(10) |3

CREATION_DATE : TIMESTAMP(E)
CREATED_BY : % ARCHAR2(50)
LAST_UPDATE_DATE : TIMESTAMP{E)
LAST_UPDATED_BY : WARCHARZ(SD)
LAST_UPDATE_LOGIN  VARCHARZ(50)

«PHs PH_GRCD_TESTPLAN_D : ID

e Assessments Star

[f PROCESSCONTROLTESTPLAN

PROCESSID : NUMBER(10, O)
CONTROLID : NUMBER{10, 0)

_ |TESTPLANID : NUMBER(10, 0)

<P PK_PROCESSCONTROLTESTRLAN ;

@] GRCD_TESTPLAN_V

alD
0D

a.DDOCNANE

aTITLE

a.STATE

. TESTPLANOWNER

. TESTPLANOWNERUSERNAME

a.TESTER

a TESTERUSERNAME

2. DESCRIPTION

URL('<a href=""|| b URL || '"Nav/Re =
2.S0URCE_ID o
a CREATION_DATE

a.CREATED_BY

aLAST_UPDATE_DATE
aLAST_UPDATED_BY
aLAST_UPDATE_LOGIN

[ GRCD_SERVERURL

URL : YARCHAR2(100)
TYPE : WARCHAR2(100)

—— el

F b{GRCD SERVERURL)

a(GRCD TESTPLAN D

Logical and Physical Models
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[FF] GRCD_TIME_D

[E GRCD_TIME_D_COMPLETE_DT

alias of Time

[E] GRCD_PERIOD_D

[ ASSESSMENT

e Control Tests Star

i) GRCD_ASSESSMENT_F

PERIOD_MAME : MY ARCHARZ(30)
PROCESS_ID : NUMBER
PROCESS_DDOCMAME : NVARCHARZ(30)
RISK_ID : NUMBER

RISK_DDOCMAME : NV ARCHARZ(30)
CONTROL_ID : NUMBER
CONTROL_DDOCMAME : NVARCHARZ(30)
ASSESSMENT_ID : NUMBER
ASSESSMENT_TYPE : NV ARCHARZ(100)
DESIGM_RESULT_ID : NUMBER
DESIGM_EFFECTIVEMESS : NV ARCHARZ(30)
DESIGM_RESULT_DATE : TIMESTAMP(E)

| OPERATING_RESULT_ID : NUMBER

OPERATING _EFFECTIVENESS : NV ARCHARZ{30)
OPERATING _RESULT_DATE : TIMESTAMP(E)
CURRENT_ASSESSMENT_FLAG : NV ARCHARZ(T)
ENTITY _MAME : NV ARCHARZ{30)
ASSESSMENT_TOTAL_CNT : NUMBER
COMPLETION_DATE : DATE

DUE_DATE : DATE

| TIME_ID : MUMBER
| CERTIFIED _CMT : NUMBER

MOT_CERTIFIED_CHNT : NUMBER
TOTAL_DESIGM_CHNT : NUMBER
DESIGM_PASSED_CMT : NUMBER
DESIGM_FAILED_CHNT : NUMBER
DESIGM_COMPLETE_CNT : NUMBER

| TOTAL_OPERATING _CMT : NUMBER

OPERATING _PASSED_CNT : NUMBER
OPERATING _FAILED_CMT : NUMBER
OPERATING _COMPLETE_CMT : NUMBER
SOURCE_ID : WARCHARZ{10)
CREATION_DATE : TIMESTAMP(E)
CREATED_BY : VARCHARZ(S0)
LAST_UPDATE_DATE : TIMESTAMP(E)
LAST_UPDATED_BY : WVARCHARZ{50)
LAST_UPDATE_LOGIM : "V ARCHARZ(S0)

1

0.1
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[E5 GRCD_TME_D

0.1

[ GRCD_PERIOD_D

[@ GRCD_CONTROL_TEST D

Issues Star

0.

[55i] GRCD_CONTROL_TEST_F

TIME_ID - NUMBER

PROCESS_ID : NUMBER

COMNTROL_ID : NUMBER
COMTROL_TEST_TYPE : NVARCHAR2(10)
TEST_ID : NUMBER

CREATE_DATE: DATE

| STATE : NV ARCHARZ(30)

RESULT_ID : NHUMBER
TEST_PERIOD : NV ARCHARZ{30)
TEST_RESULT : NV ARCHAR2(30)
RESULT_DATE : TIMESTAMP(E)

| CURRENT_FLAG : WVARCHARZ{10)

TOTAL_TEST_CNT : NUMBER
QPEM_TEST_CNT : NUMBER

| CLOSED_TEST_CNT : NUMBER

FAILED_TEST_CNT : NUMBER
COMPLETED_TEST_CNT . NUMBER

|ACTIVE_TESTS_CNT : NUMBER

PREPARE_TESTS_CNT : NUMBER
TEST_COMPLETE_CNT : NUMBER
WALIDATE_TESTS_CNT : NUMBER
TOTAL_CONTROL_CNT : NUMBER
PASSED_CONTROL_CMT : NUMBER
FAILED_CONTROL_CNT : NUMBER
CANCELED_CONTROL_CNT : NUMBER
SOURCE_ID : WARCHARZ(10)

| CREATION_DATE : TMESTAMP(E)

CREATED_BY : VARCHARZ(S0)
LAST_UPDATE_DATE : TIMESTAMP(E)
LAST_UPDATED_BY : VARCHARZ{S0)
LAST_UPDATE_LOGIN : WVARCHARZ{50)

0.1
[EF PROCESS

0.1
[ CONTROL
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[E] GRCD_TIME_D

[ GRCD_TIME_D_ISSUE_DT

[ ©GRCD_PERIOD_D |alias of Time |

0.1

] GRCD_ISSUE_F

TIME_ID : NUMBER(10, 0)
ISSUE_ID : NUMBER(10, 0)

PROCESS_ID : NUMBER(10, 0)

RISK_ID : NUMBER(10, 0)

CONTROL_ID : NUMBER(10, 0)
ASSERTION_ID : NUMBER{10, 0)
ASSESSMENT_ID - NUMBER(10, 0)
TEST_ID : NUMBER(10, 0)

ENTITY _TYPE : NUMBER(10, 0)
PROCESS_FLAG : NUMBER(10, 0)
EVALUATION_FLAG : NUMBER(10, 0)
CONTROL_EVAL_FLAG : NUMBER(10, 0)
ASSESSMENT_FLAG : NUMBER(10, 0)
PROCESS _ISSUE_FLAG : NUMBER(10, 0) B

0.1
[ PROCESS

0.1
] CONTROL

| RISK_ISSUE_FLAG : NUMBER(10, D)
| CONTROL _ISSUE_FLAG : NUMBER(10, 0)

ASSERTION_ISSUE_FLAG : NUMBER(10, 0)
ISSUE_OWWHER : NV ARCHAR2(30)

|ISSUE_SEVERITY : NUMBER(10, 0)
|ISSUE_STATUS : NVARCHAR2(30)

[ I1ssuE

[] ASSESSMENT

[E] GRCD_CONTROL_TEST D

¢  Controls Star

ISSUE_DATE : DATE

DUE_DATE : DATE

PERIOD_MAME : NV ARCHARZ(30)
SIGMIFICANT_DEFICIENCY _FLAG : NUMBER(10, (] ~
DEFICIEMCY _FLAG : NUMBER(10, 0)

0.1 ] Risk

|MATERIAL _WEAKNESS_FLAG : NUMBER(10, 0)

DOCUMENTATION_FLAG : NUMBER(10, 0)
EXPECTEDCOMPLETIONDATE : TIMESTAMP(6)
CLOSED_SSUE_CNT : NUMBER(10, 0)
OPEN_ISSUE_CNT : NUMBER(10, 0)

| ISSIUE_CNT : NUMBER{10, 0)

SOURCE_ID : VARCHARZ{10)
CREATION_DATE : TMESTAMP(E) =
CREATED_BY : “ARCHARZ(50)

0.1
/] ASSERTION

|LAST_UPDATE_DATE : TIMESTAMP(E)

LAST_UPDATED_BY : VARCHAR2(S0)
LAST_UPDATE_LOGIM : W ARCHARZ(S0)
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[ GRCD_TIME_D

o
|

m GRCD_CONTROL_FY

a PROCESSID

a.CONTROLID

createDate(TO_TIMESTAMP{(TRUNC{
ctrl_c_menitoring_cnt{CASE TO_CHA
ctrl_c_key_cnt{CASE TO_CHAR(L.C(
ctrl_c_secondary_crt{CASE TO_CHZ
ctrl_c_subordinate_crt{CASE TO_CH
ctrl_t_preventive_cnt(CASE h.CONTR
ctrl_t_detective_ert(CASE b.CONTRC
ctrl_t_corrective_crt(CASE b.CONTR
ctrl_m_manual_cnt{(CASE b.CONTROI
ctrl_m_automated_cnt{CASE b CONT
ctrl_m_autolMonitoring_crt(CASE b.Cr
ctrl_m_ControlAutomation_crit{ CASE
ctrl_f_multiple_cnt{CASE TO_CHAR(E
ctrl_f_daily_crt{CASE TO_CHAR(L.C
ctrl_f_weekly_cnt{CASE TO_CHAR(E
ctrl_f_hiweekly_crt(CASE TO_CHAR
ctrl_f_monthly_crt{CASE TO_CHAR(
ctrl_f_guartetly_cnt{CASE TO_CHAR
ctrl_f_annually_cnt(CASE TO_CHAR(
ctrl_f_other_crt{CASE TO_CHAR(L.C

Risks Star

EEJ GRCD_PROCESS_W

a(PROCESSCONTROLS)

[ CONTROL

e e . -

;I::_ b{CONTROL)
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[ CONTROL

|
|
)
|

B GRCD_RISK_FY

a PROCESSID
a RISKID

Controlld{CASE  WHEN b COMTRO

c RISKRATING
d.LOCALE

riskSignificance(e DESCRIPTION)

¢ RISKSIGNIFICANCEID

rigkLikelihood{d DESCRIPTION)

¢ RISKLIKELHOCDID
riskType(f DESCRIPTION)
¢ RISKTYPED

CreateDate(TO_TIMESTAMP{(TRUN

processCnt(1)
riskCnt(1)

e Action Items Star

[ GRCD_TIME D

=

1

-

=

alPROCESSRISKS)

cRISK)

d(RISKPROBABILITYTYPE TL)

[ PROCESS

5]

b{CONTROLRISKS)

fIRISKTYPE TL)

e(RISKEXPOSURETYPE TL)
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[ PROCESS [] CONTROL [ RisK [F5] ASSERTION [] ACTIONITEM [F5] GRCD_TIME_D

Eﬁj GRCD_ACTIONITEM_F

Actiontemld(TO_MUMBER(a ID))

processid{TO_NUMBER(pa PROCESSI

Al_Related_Process{TO_NUMBER{(N\

Al_Relatec_Control(TQ_NUMBER((NVL

Al_Related_Risk(TO_MUMBER{{NVL{A =] AIP{ACTIOMTEMREL ATEDPROCESS 23] AIAACTIONITEMREL ATEDASSERTION
Al_Related_Assertion(TO_NUMBER((  |* B |
CreateDate(a CREATEDATE)

DueDate(a DUEDATE)

x x x £ x x
| | | | | |
| | | | | |
| L L L L |
| ' |
| |
: E pa(PROCESSACTIONITEMS 3||=_ A(ACTIONITEM :
|
|
|
|

] AR(ACTIONITEMREL ATEDRISK

B AICACTIONITEMRELATEDCONTROL! o

Assertions Star
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[ff PROCESS I ASSERTION GRCD_TIME_D

Fu3
I
|
I
I
|
|
I
I
I
|
I
I

ﬁ ACASSERTION]

1
ﬁj GRCD_ASSERTION_FY

pa PROCESSID
pa ASSERTIOMID

CREATEDATETO_TIMESTAMP({TRL
E palPROCESSASSERTIONS]

e Test Instructions Star

[E PROCESS . [l CONTROLTESTINSTRUCTION 1 GRCD_TEST_INSTRUCTION_D

1 PROCESSID : NUMBER(10, Oy
CONTROLID : NUMBER(10, O)
TESTINSTRUCTIONID : NUMBER(10, 0)

|CREATEDATE : DATE

|aPls PK_CONTROLTESTINSTRUCTION : PF

[ CONTROL GRCD_TIME_D

e Test Plan Star
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PROCESSCONTROLTESTPLAN
PROCESSID : NUMBER(10, 0)

el 1 | CONTROLID : NUMBER(10, 0)
| TESTPLANID : NUMBER{10, O)

"

1 GRCD_TESTPLAN_D
| «PI(s PK_PROCESSCONTROLTESTPLAN : | ©

CONTROL

Logical and Physical Models C-45






D

Lineage for GRCM 7.8

This appendix covers the following topics:

Lineage Information for Tables and Scripts

GRCI2.0.1 - GRCM 7.8 Data Lineage CONSTANTS Table
GRCI 2.0.1 - GRCM 7.8 Data Lineage DIMENSIONS Table
GRCI 2.0.1 - GRCM 7.8 Data Lineage FACTS Table

Lineage Information for Tables and Scripts

This section provides the source (GRCM) to target (GRCI) lineage information on
various objects such as Constants, Dimensions and Facts and the scripts used to load
them. The first table illustrates lineage of Constants used in GRCI, followed by lineage
of dimensions and facts. As indicated by the file name column in all the three tables, the
load of constants, dimensions and facts is accomplished using sql scripts.

GRCI 2.0.1 - GRCM 7.8 Data Lineage CONSTANTS Table

The following table provides lineage information on constants, such as type values, that
are loaded from GRCM into GRCL

Lineage for GRCM 7.8 D-1



GRCM - Source Constant GRCI - Target File Name Load Procedure
Table Name Values Table Name
N/A 1-"Low' COMPLEXITY  Constants_Load_ LOADCOMPLEX
TYPE pkg.sql ITYTYPE
2 - 'Med-Low'
3 - 'Medium'
4 - 'Med-High'
5 - 'High'
GRC_RESOURC N/A COMPLEXITY  Constants_Load_ LOADCOMPLEX
E_STRINGS_TL TYPE_TL pkg.sql ITYTYPETL
ComplexityType
N/A 1 - 'Manual’ CONTROLME Constants_ Load. LOADCONTROL
THODTYPE pkg.sql METHODTYPE
2 - 'Automated’
3 - 'Monitoring'
GRC_RESOURC N/A CONTROLME Constants_Load_ LOADCONTROL
E_STRINGS_TL THODTYPE_T pkg.sql METHODTYPET
L L
ControlMethodT
ype
N/A 1- Preventive' CONTROLTYP Constants_Load_ LOADCONTROL
E kg.sql TYPE
2 - 'Detective’ X84
3 - 'Corrective'
GRC_RESOURC N/A CONTROLTYP Constants_Load_ LOADCONTROL
E_STRINGS_TL E_TL pkg.sql TYPETL
ControlType
N/A 1-"Low' DOCLEVELTY Constants_Load_ LOADDOCLEVE
PE kg.sql LTYPE
2 - 'Med-Low' P854
3 - 'Medium'
4 - 'Med-High'
5 - 'High'
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GRCM - Source Constant GRCI - Target  File Name Load Procedure
Table Name Values Table Name
GRC_RESOURC N/A DOCLEVELTY Constants_Load_. LOADDOCLEVE
E_STRINGS_TL PE_TL pkg.sql LTYPETL
DocLevelType
N/A http://localhost/ =~ GRCD_SERVE  Constants_Load_ LOADSERVERU
OracleGRCMana RURL pkg.sql RL
ger'
'http://localhost/
analytics/saw.dll
?Dashboard'
N/A 0 - 'Material ISSUESEVERIT Constants_Load_ LOADISSUESEV
Weakness' YTYPE pkg.sql ERITYTYPE
1 - 'Significant
Deficiency'
2 - 'Deficiency’
3.
'Documentation
Only'
GRC_RESOURC N/A ISSUESEVERIT Constants_Load_ LOADISSUESEV
E_STRINGS_TL YTYPE_TL pkg.sql ERITYTYPETL
IssueSeverity Ty
pe
N/A 0 - 'Process' ISSUETYPE Constants_Load_ LOADISSUETYP
keg.sql E
1 - 'Evaluation’ PXE-59
2 - 'Control
Evaluation'
3 - 'Assessment’
GRC_RESOURC N/A ISSUETYPE_TL Constants_Load_ LOADISSUETYP
E_STRINGS_TL pkg.sql ETL

IssueType
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GRCM - Source Constant GRCI - Target File Name Load Procedure
Table Name Values Table Name
N/A 1 - 'Unreliable' MATURITYTY Constants_Load_ LOADMATURIT
PE kg.sgl YTYPE

2 - 'Informal’ P84

3-

'Standardized'

4 - 'Monitored'

5 - 'Optimized'
GRC_RESOURC N/A MATURITYTY Constants_Load_ LOADMATURIT
E_STRINGS_TL PE_TL pkg.sql YTYPETL
MaturityType
N/A 1 - Process' PROCESSTYPE Constants_Load_ LOADPROCESST

kg.sql YPE

2 - 'Policy’ Pee=q
GRC_RESOURC N/A PROCESSTYPE Constants_Load_ LOADPROCESST
E_STRINGS_TL _TL pkg.sql YPETL
ProcessType
N/A 1-'Low' RISKEXPOSUR Constants_Load_ LOADRISKEXPO

ETYPE pkg.sql SURETYPE

2 - 'Med-Low'

3 - 'Medium'

4 - 'Med-High'

5 - 'High'
GRC_RESOURC N/A RISKEXPOSUR Constants_Load_ LOADRISKEXPO
E_STRINGS_TL ETYPE_TL pkg.sql SURETYPETL

RiskExposureTy
pe
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GRCM - Source Constant GRCI - Target  File Name Load Procedure
Table Name Values Table Name
N/A 1 - 'Negligible' RISKPROBABI  Constants_Load_ LOADRISKPROB
LITYTYPE pkg.sql ABILITYTYPE
2-'Low
3 - 'Medium
4 - 'High
5 - 'Extreme’
GRC_RESOURC N/A RISKPROBABI  Constants_Load_ LOADRISKPROB
E_STRINGS_TL LITYTYPE_TL  pkg.sql ABILITYTYPETL
RiskProbability T
ype
N/A 1 - 'Financial RISKTYPE Constants_Load_ LOADRISKTYPE
Fraud' pkg.sql
2 - 'Theft of
Assets'
3 - 'Theft of
Services'
4 - Regulatory
Compliance'
5 - 'Breach of
Security'
GRC_RESOURC N/A RISKTYPE_TL  Constants_Load_ LOADRISKTYPE
E_STRINGS_TL pkg.sql TL
RiskType
N/A 1'Inquiry’ TESTINSTRUC Constants_Load_ LOADTESTINST
TIONTYPE pkg.sql RUCTIONTYPE
2'Observation'

3'Examination’

4
'Reperformance’
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GRCM - Source
Table Name

Constant
Values

GRCI - Target
Table Name

File Name

Load Procedure

GRC_RESOURC N/A

E_STRINGS_TL
TestInstructionT

ype

TESTINSTRUC Constants_Load_

TIONTYPE_TL pkg.sql

LOADTESTINST
RUCTIONTYPET
L

GRCI 2.0.1 - GRCM 7.8 Data Lineage DIMENSIONS Table

The following table illustrates lineage ofDimensionsused in GRCI. It contains the
GRCM source table name that loads the GRCI dimensions, the sql scripts file name, and
the file that contains the load procedure.

GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name
1. Process ACCOUNTMAP Dims_Load_pkg.sql =~ LOADACCOUNTM
AP
2. GRCD_ACCOU
NT_D
vwDocumentHistory =~ ASSERTION Dims_Load_pkg.sql LOADASSERTION
vwDocumentHistory =~ ASSESSMENT Dims_Load_pkg.sql LOADASSESSMENT
vwDocumentHistory ~ AUDITTEST Dims_Load_pkg.sql =~ LOADAUDITTEST
1. AuditTest AUDITTESTCONTR  Dims_Load_pkg.sql LOADAUDITTESTC
OLS ONTROLS

2. Control
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GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name
1. ywDocumentHis CONTROL Dims_Load_pkg.sql LOADCONTROL
tory
2 ControlType
3. ControlMethodT
ype
4. MaturityType
5. ComplexityType
1. Control CONTROLRISKS Dims_Load_pkg.sql LOADCONTROLRIS
KS
2 Risk
1. Process FINANCIALMAP Dims_Load_pkg.sql LOADFINANCIALM
AP
2. GRCD_CYCLE_
D
Process FOURTHMAP Dims_Load_pkg.sql LOADFOURTHMAP
1. GRC_MAP_NO  GRCD_ACCOUNT_ Dims_Load_pkg.sql LOADACCOUNTD
DES D
2. GRC_MAPS
1. GRC_MAP_NO  GRCD_ACCOUNT_T Dims_Load_pkg.sql LOADACCOUNTTL
DES_TL L
2. GRC_MAPS
Control GRCD_CONTROL_H Dims_Load_pkg.sql LOADCONTROLHIE
IERARCHY_B RARCHYB
1. ProcessTest GRCD_CONTROL_T Dims_Load_pkg.sql LOADCONTROLTES
EST_D TD

2. AuditTest
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GRCM - Source
Table Name

GRCI - Target Table
Name

File Name

Load Procedure

1. GRC_MAPS

2. GRC_MAP_NO
DES

1. GRC_MAPS

2. GRC_MAP_NO
DES_TL

1. GRC_MAPS

2. GRC_MAP_NO
DES

1. GRC_MAPS

2. GRC_MAP_NO
DES_TL

1. GRC_MAPS

2. GRC_MAP_NO
DES

1. GRC_MAPS

2. GRC_MAP_NO
DES_TL

GRC_FISCAL_PERIO
DS

UserSecurity Attribute
s

GRCD_CYCLE_D

GRCD_CYCLE_TL

GRCD_FMAP_D

GRCD_FMAP_TL

GRCD_ORGANIZAT
ION_D

GRCD_ORGANIZAT
ION_TL

GRCD_PERIOD_D

GRCD_TIME_D

GRCD_USER_ROLE

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

LOADCYCLED

LOADCYCLETL

LOADFMAPD

LOADFMAPTL

LOADORGANIZATI
OND

LOADORGANIZATI
ONTL

LOADTIMED

LOAD_GRCD_TIME
D

LOADUSERROLE
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GRCM - Source
Table Name

GRCI - Target Table
Name

File Name

Load Procedure

UserSecurityAttribute
s

vwDocumentHis
tory

IssueType

Process

2. GRCD_ORGANI
ZATION_D

1. VwDocumentHis
tory

ProcessType
ComplexityType

DocLevelType

Process

Accountmap

Assessment

Process

1. Control

2. Process

FinancialMap

Process

GRCD_USERS

ISSUE

ORGANIZATIONM
AP

PROCESS

PROCESSACCOUNT
MAP

PROCESSASSESSME
NTS

PROCESSCONTROL
S

PROCESSFINANCIA
LMAP

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

LOADUSERS

LOADISSUE

LOADORGANIZATI
ONMAP

LOADPROCESS

LOADPROCESSACC
OUNTMAP

LOADPROCESSASSE
SSMENTS

LOADPROCESSCON
TROLS

LOADPROCESSFIN
ANCIALMAP
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GRCM - Source
Table Name

GRCI - Target Table
Name

File Name

Load Procedure

1. FourthMap

Process

OrganizationMa

p

Process

1. Risk

Process

vwDocumentHis
tory

Process

vwDocumentHis
tory

RiskExposureTy
pe

3. RiskProbability T
ype

RiskType

1. GRC_SCOPED_
CONTROLS

Control

3. GRCD_SCOPE_P
LANS

GRC_SCOPE_PLANS

PROCESSFOURTHM
AP

PROCESSORGANIZ

ATIONMAP

PROCESSRISKS

PROCESSTEST

RISK

GRCD_SCOPED_CO
NTROLS

GRCD_SCOPE_PLA
NS

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

Dims_Load_pkg.sql

LOADPROCESSFOU
RTHMAP

LOADPROCESSORG

ANIZATIONMAP

LOADPROCESSRISK

S

LOADPROCESSTEST

LOADRISK

LOADSCOPEDCON
TROLS

LOADSCOPEPLANS
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GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name
1. ywDocumentHis ACTIONITEM Dims_Load_pkg.sql LOADACTIONITEM
tory
2. DocumentHistor
y

1. Actionltem ACTIONITEMRELA  Dims_Load_pkg.sql LOADACTIONITEM
TEDASSERTION RELATEDASSERTIO

2. Assertion N

1. Actionltem ACTIONITEMRELA  Dims_Load_pkg.sql LOADACTIONITEM
TEDCONTROL RELATEDCONTROL

2. Control

1. Actionltem ACTIONITEMRELA  Dims_Load_pkg.sql =~ LOADACTIONITEM
TEDPROCESS RELATEDPROCESS

2. Process

1. Actionltem ACTIONITEMRELA  Dims_Load_pkg.sql LOADACTIONITEM
TEDRISK RELATEDRISK

Z Risk

1. Actionltem PROCESSACTIONIT  Dims_Load_pkg.sql LOADPROCESSACTI
EMS ONITEMS

2. Process

1. Assertion PROCESSASSERTIO  Dims_Load_pkg.sql LOADPROCESSASSE
NS RTIONS

2. Process

1. Assertion RISKASSERTIONS Dims_Load_pkg.sql LOADRISKASSERTI

ONS
2 Risk
vwDocumentHistory =~ GRCD_TESTPLAN_  Dims_Load_pkg.sql LOADTESTPLAN

D
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GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name

1. ywDocumentHis PROCESSCONTROL Dims_Load_pkg.sql LOADPROCESSCON
tory TESTPLAN TROLTESTPLAN

2. GRCD_TESTPLA
N_D

3. Control

4. Process

1. ywDocumentHis GRCD_TEST_INSTR  Dims_Load_pkg.sql LOADTESTINSTRUC
tory UCTION_D TION

2. TestInstructionT
ype

3. ControlMethodT
ype

1. ywDocumentHis CONTROLTESTINST Dims_Load_pkg.sql LOADCONTROLTES
tory RUCTION TINSTRUCTION

2. GRCD_TEST_IN
STRUCTION_D

Control

Process

Note:The view 'vwDocumentHistory' uses the tables DocMeta, Revisions, and

Documents as sources.

GRCI 2.0.1 - GRCM 7.8 Data Lineage FACTS Table

The following table illustrates lineage of Factsused in GRCL It contains the GRCM
source table name that loads the GRCI facts, the sql scripts file name, and the file that
contains the load procedure..
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GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name

1. ControlDesi gnRe ASSESSMENTCONT  Facts_Load_pkg.sql LOADASSESSCONT
sult ROLDESIGNRESULT ROLDESIGNRESULT

S S

2. Assessment

1. ControlOperatin ~ ASSESSMENTCONT  Facts_Load_pkg.sql LOADASSESSMENT
gResult ROLOPRESULTS CONTROLOPRESUL

TS

2. Assessment

1. ProcessDesi gnRe ASSESSMENTPROC  Facts_Load_pkg.sql LOADASSESSPROCE
sult ESSDESIGNRESULTS SSDESIGNRESULTS

2, Assessment

1. ProcessOperating ASSESSMENTPROC  Facts_Load_pkg.sql LOADASSESSMENT
Result ESSOPRESULTS PROCESSOPRESULT

S

2. Assessment

1. RiskDesignResul ~ASSESSMENTRISKD  Facts_Load_pkg.sql LOADASSESSRISKD
t ESIGNRESULTS ESIGNRESULTS

2. Assessment

1. RiskOperatingRe =~ ASSESSMENTRISKO  Facts_Load_pkg.sql LOADASSESSMENT
sult PERATINGRESULTS RISKOPRESULTS

2. Assessment

1. vwDocumentHis AUDITTESTRESULT Facts_Load_pkg.sql LOADAUDITTESTR
tory ESULT

2. Control

1. AuditTestResult ~AUDITTESTRESULT Facts_Load_pkg.sql LOADAUDITTESTR

S ESULTS

2. AuditTest
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GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name

1. ywDocumentHis CONTROLDESIGNR Facts_Load_pkg.sql LOADCONTROLDE
tory ESULT SIGNRESULT

2. Control

1. ywDocumentHis CONTROLOPERATI Facts_Load_pkg.sql LOADCONTROLOP
tory NGRESULT ERATINGRESULT

2 Control
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GRCM - Source
Table Name

GRCI - Target Table
Name

File Name Load Procedure

1.

10.

1.

12.

13.

14,

15.

PROCESS

PROCESSCONT
ROLS

CONTROL
ASSESSMENT
ASSESSMENTC
ONTROLDESIG

NRESULTS

CONTROLDESI
GNRESULT

AssessmentContr
olOpResults

CONTROLOPER
ATINGRESULT

ProcessRisks

AssessmentRisk
DesignResults

RiskDesignResul
t

ASSESSMENTRI
SKOPERATING
RESULTS

RISKOPERATIN
GRESULT

PROCESSASSES
SMENTS

ASSESSMENTPR
OCESSDESIGNR
ESULTS

GRCD_ASSESSMEN
TF

Facts_Load_pkg.sql LOADASSESSMENT
F
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GRCM - Source GRCI - Target Table File Name Load Procedure
Table Name Name
16.  PROCESSDESIG
NRESULT
17. AssessmentProce
ssOpResults
18. PROCESSOPER
ATINGRESULT
1. AuditTest GRCD_AUDIT_TEST Facts_Load_pkg.sql LOADAUDITTESTR
_RESULT_F ESULTF
2. AuditTestResults
3. AuditTestResult
4 AuditTestContro
Is
3. Control
6. ProcessControls
7. Process
1. GRCD_PROCES GRCD_CONTROL_T Facts_Load_pkg.sql LOADCONTROLTES
S_TEST_RESULT EST_F TF

F

ProcessTest

GRCD_AUDIT_T
EST_RESULT_F

AuditTest
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GRCM - Source

GRCI - Target Table

File Name Load Procedure

Table Name Name
1 Issue GRCD_ISSUE_F Facts_Load_pkg.sql LOADISSUEF
2. Risk
3. Control
4 Process
5. ProcessControls
6. Assertion
7. GRCD_CONTRO
L_TEST D
8. Assessment
9. GRCD_PERIOD_
D
1. Process GRCD_PROCESS_TE  Facts_Load_pkg.sql LOADPROCESSTEST
ST _RESULT_F RESULTF
2. ProcessTest
3. ProcessTestResul
t
4. ProcessTestResul
ts
5. Control
6. ProcessControls
1. VwDocumentHis PROCESSDESIGNRE Facts_Load_pkg.sql LOADPROCESSDESI
tory SULT GNRESULT
2, Process
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GRCM - Source

GRCI - Target Table

File Name

Load Procedure

Table Name Name

1. VwDocumentHis PROCESSOPERATIN Facts_Load_pkg.sql LOADPROCESSOPE
tory GRESULT RATINGRESULT

2. Process

1. VwDocumentHis PROCESSTESTRESU Facts_Load_pkg.sql LOADPROCESSTEST
tory LT RESULT

2. Control

1. ProcessTestResul PROCESSTESTRESU Facts_Load_pkg.sql LOADPROCESSTEST
t LTS RESULTS

2. ProcessTest

1. VwDocumentHis RISKDESIGNRESUL Facts_Load_pkg.sql LOADRISKDESIGNR
tory T ESULT

2. Risk

1. VwDocumentHis RISKOPERATINGRE Facts_Load_pkg.sql LOADRISKOPERATI
tory SULT NGRESULT

2. Risk
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E

Lineage for AACG 8.2

This appendix covers the following topics:
e GRCI20.1-AACG 8.2, Data Lineage DIMENSIONS Table
e GRCI20.1-AACG 8.2, Data Lineage FACTS Table

GRCI 2.0.1 - AACG 8.2, Data Lineage DIMENSIONS Table

The following table contains the GRCI staging table name that loads the GRCI
dimensions, and the package that loads the target GRCI dimension table.

It is important to note that all these packages are invoked from GRI_MASTER_PKG
Common Table Values
The following parameters have common values for all rows in this table.

* Master Package: GRI_MASTER_PKG

Error Table Dimension/B Create Package Sub-Packag Interface
Name ridge Table Procedure(s) Name e Name Name
Package
GRI_DIMEN GRI_INSTAN GRI_D_INST GRI_D_INST
SIONS_PKG CE_PKG ANCE_PKG  ANCE_INTR
GRI_DIMEN GRI_INSTAN GRI_D_INST GRI_D_INST
SIONS_PKG CE_PKG ANCE_TL_P ANCE_TL_I
KG NTR
GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
SIONS_PKG C_DIM_PKG ERIC_DIM_P ERIC_DIM_I
KG NTR
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Error Table Dimension/B Create Package Sub-Packag Interface
Name ridge Table Procedure(s) Name e Name Name
Package
GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
SIONS_PKG C_DIM_PKG ERIC_DIM_T ERIC_DIM_T
L_PKG L_INTR
GRI_E_GENE GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
RIC_DIM_V  SIONS_PKG C_DIM_PKG ERIC_DIM_V ERIC_DIM_V
AL AL_PKG AL_INTR
GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
SIONS_PKG C_DIM_PKG ERIC_DIM_V ERIC_DIM_V
AL_TL_PKG AL_TL_INTR
GRI_DIMEN CREATEACC GRCD_USER GRCD_USER GRCD_USER
SIONS_PKG OUNTMAP _MAIN_PKG _PKG _INTR
GRI_DIMEN GRCD_USER GRCD_USER GRCD_USER
SIONS_PKG _MAIN_PKG _TL_PKG _TL_INTR
GR_E_POLIC GRI_DIMEN GRI_POLICY GRI_D_POLI GRI_D_POLI
Y SIONS_PKG _PKG CY_PKG CY_INTR
GRI_DIMEN GRI_POLICY GRI_D_POLI GRI_D_POLI
SIONS_PKG _PKG CY_TL_PKG CY_TL_INTR
GRI_E_ENTI = GRI_DIMEN GRI_ENTITL GRI_D_ENTI GRI_D_ENTI
TLEMENT SIONS_PKG EMENT_PKG TLEMENT_P TLEMENT I
KG NTR
GRI_DIMEN CREATEASS GRI_ENTITL GRI_D_ENTI GRI_D_ENTI
SIONS_PKG  ERTION EMENT_PKG TLEMENT_T TLEMENT_T
L_PKG L_INTR
GRI_DIMEN CREATEASS GRI_ACCESS GRI_D_ACC GRI_D_ACC
SIONS_PKG  ESSMENT _POINT_PK  ESS_POINT_ ESS_POINT_I
G PKG NTR
GRI_DIMEN CREATEAU GRI_ACCESS GRI_D_ACC GRI_D_ACC
SIONS_PKG  DITTEST _POINT_PK  ESS_POINT_ ESS_POINT_
G TL_PKG TL_INTR
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Error Table Dimension/B Create Package Sub-Packag Interface
Name ridge Table Procedure(s) Name e Name Name
Package
GRI_DIMEN CREATEAU GRI_APPS_ U GRI_D_APPS GRI_D_APPS
SIONS_PKG  DITTESTCO  SER_PKG _USER_PKG _USER_INTR
NTROLS
GRI_DIMEN CREATECO GRI_APPS_U GRI_D_APPS GRI_D_APPS
SIONS_PKG  NTROL SER_PKG _USER_TL_P _USER_TL_I
KG NTR
GRI_DIMEN CREATECO GRI_ROLE_P GRI_D_ROLE GRI_D_ROLE
SIONS_PKG NTROLRISK KG _PKG _INTR
S
GRI_DIMEN CREATEFIN GRI_ROLE_ P GRI_D_ROLE GRI_D_ROLE
SIONS_PKG ANCIALMA KG _TL_PKG _TL_INTR
P
GRI_DIMEN CREATEFOU GRI_D_RUN GRI_D_RUN GRI_D_RUN
SIONS_PKG RTHMAP _PKG _PKG _INTR
GRI_E_EXCL GRI_DIMEN CREATEACC GRI_EXCLUS GRI_D_EXCL GRI_D_EXCL
USION SIONS_PKG  OUNTD ION_PKG USION_PKG  USION_INTR
GRI_E_EXCL GRI_DIMEN CREATEACC GRI_EXCLUS GRI_D_EXCL GRI_D_EXCL
USION_DET SIONS_PKG OUNTTL ION_PKG USION_DET USION_DET
AIL AIL_PKG AIL_INTR
GRI_E_PATH GRI_DIMEN CREATECO GRI_EXCLUS GRI_D_PAT GRI_D_PAT
_EXCLUSIO SIONS_PKG NTROLHIER ION_PKG H_EXCLUSI  H_EXCLUSI
N ARCHYB ON_PKG ON_INTR
GRI_BRIDGE CREATECO GRI_D_ROLE GRI_D_ROLE GRI_D_ROLE
_TABLES_PK NTROLTEST _USER BG_P _USER_BG_P _USER_BG_I
G D KG KG NTR
GRI_BRIDGE CREATECYC GRI_D_POLI GRI_D_POLI GRI_D_POLI
_TABLES_PK LED CY_GENERI CY_GENERI CY_GENERI
G C_DIM_BG_ C_DIM_BG_ C_DIM_BG_I
PKG PKG NTR
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Error Table Dimension/B Create Package Sub-Packag Interface

Name ridge Table Procedure(s) Name e Name Name
Package
GRI_BRIDGE CREATECYC GRI_D_POLI GRI_D_POLI GRI_D_POLI
_TABLES_PK LETL CY_DETAIL_ CY_DETAIL_ CY_DETAIL_
G BG_PKG BG_PKG BG_INTR
GRI_BRIDGE CREATEFM  GRI_D_ENTL GRI_D_ENTL GRI_D_ENTL
_TABLES_PK APD MNT_GENE MNT_GENE MNT_GENE
G RIC_DIM_BG RIC_DIM_BG RIC_DIM_BG

_PKG _PKG _INTR

GRI_BRIDGE CREATEFM  GRI_D_ENTI GRI_D_ENTI GRI_D_ENTI
_TABLES_PK APTL TLEMENT_A TLEMENT_A TLEMENT_A
G P_BG_PKG P_BG_PKG P_BG_INTR

GRCI 2.0.1 - AACG 8.2, Data Lineage FACTS Table

The following table contains the GRCI staging table name that loads the GRCI fact
tables, and the package that loads the target GRCI fact table.

NOTE:It is important to note that all these packages are invoked from the fact package
GRI_FACTS_PKG, which in turn is invoked from GRI_MASTER_PKG.

Common Table Values

The following parameters have common values for all rows in this table.

¢ Load Type:ODI
* Master Package:GRI_MASTER_PKG

e Fact PackageGRI_FACTS_PKG
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SINO.

Source
Table
Name(s)

Target Table
Name

Error Table
Name

Package
Name

Interface
Name

GRI_S_CONF
LICTS

GRI_D_RUN

GRI_D_POLI
CYy

GRI_D_GBL_
USER

GRI_A_LOO
Kup
GRI_F_CONF
LICTS_T
GRI_D_POLI
CY
GRI_S_CONF
LICT_PATH
GRI_D_RUN

GRI_D_POLI
CY

GRI_D_APPS
_USER

GRI_D_ACC
ESS_POINT

GRI_D_ENTI
TLEMENT

GRCD_USER
S

GRI_A_LOO
Kuop

GRI_F_CONF
LICTS_T

GRI_D_POLI
CY_PREV_R
UN_BG

GRI_F_CONF
LICT_PATH_
T

GRI_E_CON
FLICTS_T

GRI_E_CON

FLICT_PATH

T

GRI_F_CONF
LICTS_T_PK
G

GRI_D_POLI
CY_PREV_R
UN_BG_PKG

GRI_F_CONF
LICT_PATH_
T_PKG

GRI_F_CONF
LICTS_T_INT
R

GRI_D_POLI
CY_PREV_R
UN_BG_INT
R

GRI_F_CONF
LICT_PATH_
T_INTR
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SI NO. Source Target Table Error Table Package Interface
Table Name Name Name Name
Name(s)

4 GRI_S_CONF GRI_F_CONF GRI_E_CON GRI_F_CONF GRI_F_CONF
LICT_PATH LICT_PATH_ FLICT_PATH LICT_PATH_ LICT_PATH_

_T T_PKG_2 T_INTR_2
GRI_D_RUN

GRI_D_POLI
CYy

GRI_D_POLI
CY_INSTAN
CE_V

E-6 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



F

Uploading dIf files to the Database using
Transx

This appendix covers the following topics:

* Uploading dlf files to the Database using transx

Uploading dIf files to the Database using transx

To load dlf into the database the xdk kit is required which can be downloaded from the
following location:

http://www.oracle.com/technology/tech/xml/xdk/software/prod/winsoft_java.htm

The XDK kit has to be installed on the database server machine, or on a machine having
database related files, since the file xdb_g.jar is available in the database server's
RDBMS folder.

Installing the XDK kit after the download completes:

1. Install unzip or WinZip executable
2. Download the Oracle XDK for Java in .zip format
3. Unzip into a directory (Ex: C:\[your directory]>unzip xdk_java.zip)

4. The result should be the following files and directories:

/bin - xdk executables and utilities

/lib - directory for libraries

/xdk - top xdk directory

/xdk/demo - directory for demo files
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e /xdk/doc - directory for documentation
e /xdk/admin - directory for dband config files
e /xdk/*html. - doc navigation files

e /xdk/license.html - copy of license agreement

Make sure that the JAVA_HOME and ORACLE_HOME environment variables are set
appropriately.

Open the "env.bat" file located in the installed directory (Ex: C:\[your
directory]\xdk\bin). Open the file (env.bat) for editing in any text editor and update
the file location of "xdb_g.jar" file from "%INSTALL_ROOT%\lib\xdb_g.jar"to
"%ORACLE_HOME%\RDBMS\jlib\ xdb_g.jar".

Save the env.bat file after making the changes.
Open a new command prompt session.

Navigate to c:\xdk\bin directory and run the "env.bat" file as shown below,

Command Prompt

C=rod xdksbin
C:wxdkshin>env_bat
¢z socd ks bin >

Have the required dlf files to be loaded available on your local drive.
Execute the following command:

transx "jdbc:oracle:thin:@10.176.150.103:1521:0rcl55" gril gril
c\xmls\from_aru\GRI_20_ACG_Scripts\Seed_Translation_Data\GRCD_TIME_TRAN
SLATION_da.dlf

P -« Command Prompt

in:@A.176.158.18 1

re 155" gril gei
ed_Translation_Data® TIHE_TRANSLATION_da

This method can be followed to upload one file at a time to the database server specified
by the connection parameters"jdbc:oracle:thin:@10.176.150.103:1521:0rcl55" gril gril.

Important: The above command performs the operation against the
database on server = 10.176.150.103, port = 1521 and SID = orcl55, using
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the database credentials gri/gri )

If all the dlf files in the folder need to be updated then the wildcard characters can be
used as shown below;

transx "jdbc:oracle:thin:@10.176.150.103:1521:0rcl55" gril gril
c\xmls\from_aru\GRI_20_ACG_Scripts\Seed_Translation_Data\*.dIf .

The above command results in all the dlIf files available in the Seed_Translation_data
folder to be loaded into the database.

Login to the database server and check for the rows uploaded.
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